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Abstract:

This deliverable specifies various tasks for the Text Structuring Module for the final prototype. The coverage
of the Text Structuring Module (developed in WP5.2) is extended both in depth and in breadth. For the full
instructions in procedural style, the deliverable specifies additional stylistic variations, and more elaborate
mechanisms for introducing and realising discourse relations. Furthermore, other new genres are introduced:
summaries, basic step instructions, function descriptions, overviews, and tables of content. In order to
generate these different genres, the user will not be required to provide new content descriptions (i.e., A-
boxes): the main point is that text plans for all these different genres can be derived from the already existing
A-boxes specifying procedural-style instructions. The generation of such "meta-texts" like overviews and
function descriptions from multiple existing content specifications constitutes a rather novel effort in the field
of NLG. The only other work with a comparable aim we are aware of is the generation of summaries from
multiple input documents discussed in (Radev and McKeown 1998).

More information on AGILE is available on the project web page and from the project
coordinators:

URL: http://www.itri.brighton.ac.uk/projects/agile
email: agile-coord @itri.bton.ac.uk
telephone: +44-1273-642900
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1. Introduction

1.1 Aims

The aim of the AGILE work package on text structuring (WP 5) is to develop a Text
Structuring Module that is capable of planning texts of the form and style as found in the
project domain, namely CADCAM software manuals. In the previous stages (WP 5.1 and
WP5.2) we started by carrying out corpus studies. These corpus studies aimed at
identifying the core aspects of text structure in instructions for procedural tasks ranging in
complexity from simple (TEXS1) to elaborate (TEXS2). The core aspects we identified
concerned:

* the rudimentary building blocks from which a structure for a text could be build (a text
plan);

» the different ways in which content could be realised as clauses (sentence planning);
and,

» the variations in styles that could be used to realise a text (bridging the gap between
strategic generation and tactical generation).

Based on the specifications arising from corpus studies, a Text Structuring Module
(TSM) has been developed. The current TSM is capable of generating text plans, together
with the appropriate sentence plans, that cover the required variations in style and
complexity as illustrated by the target texts given in (TEXS2), modulo phenomena not
covered (or not coverable) by the grammars. The architecture of the TSM has been
described in (TEXM1) and (for its current form) in (TEXM?2).

So far, we have been considering full instructions in procedural style that describe how a
single task can be achieved. An example of such a procedural task could be the construction
of a particular CADCAM object like a "multiline". In this deliverable we extend our scope
on text structuring in the following ways:

* Variations in the style in which elements of a text plan for a procedural text can be
realised: for example, different styles of titles, running text versus lists enumerating
steps, and the use of more complex tense and aspect.

* Variation in the complexity of the realisation of discourse relations and discourse
markers. We will consider more types of discourse aggregation and syntactic
aggregation (see below for more details). Furthermore, we will and introduce temporal
discourse markers (like "after ... now ...").

* Variations in the fypes of texts that can be generated from a single content specification
(A-box): for example, besides the procedural texts considered so far, non-procedural
texts like overviews and descriptions. These different types of texts can be found in
software manuals, in addition to the procedural text that usually makes up the body of a
software manual.

Stylistic variation in the generation of elements of the text plan requires the proper
imposition of realisation constraints on sentential generation, obtained through inclusion of
these constraints in sentence plans.

Abstractly put, aggregation addresses the issue of combining two or more structures into
a single linguistic structure which contributes to sentence structuring and construction
(Reape & Mellish, 1999). In our case, aggregation deals with the combination of linguistic
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structures that realise the content expressed by PROCEDURES, as identified by the TASKs
at the leaves of a text plan. We consider two different types of aggregation here, following
the discussion by Reape and Mellish (1999). First of all, we extend the mechanisms for
discourse aggregation, which is oriented at supporting rhetorical structure. In our case this
means that we form a combined linguistic structure in which the rhetorical relation between
the two components is made explicit (e.g. as can be expressed by "in order to").
Furthermore, we introduce more elaborate mechanisms for grouping of conceptually related
content. This kind of grouping can be expressed syntactically through coordination or
disjunction.

Finally, the generation of different genres concerns text planning proper, since each
different type of text will require the generation of a text plan that is appropriate for that
genre.

1.2 Overview

The discussion in the deliverable is structured as follows. Because the work in WP5.3 is
based on the results of WP 5.2, we begin in section 1.3 by briefly discussing the current
TSM. In that discussion we will primarily focus on how we can reuse, build forth on, the
resources developed so far.

In Chapter 2 we discuss the texts to be covered in the final prototype. First of all, we
distinguish a number of text types to be generated (Section 2.1), and then we discuss
aspects of stylistic variation we are taking into account for the final prototype (Section 2.2).
Finally, we sketch the correlations between them (Section 2.3). The subsequent chapters are
concerned with detailed descriptions of individual text types, the stylistic variations
available within the text type, and the formal specifications of the text structuring involved
in generating texts of the respective types. Chapter 3 presents those aspects of full
procedural instructions that were not fully covered in the intermediate prototype: in Section
3.1 we discuss aggregation, and in Section 3.2 we discuss the generation of explicit
discourse markers. Chapter 4 concerns goal-oriented and step-oriented abbreviated
procedural instructions. Chapter 5 concerns function-oriented descriptive texts, Chapter 0
concerns full and abstract overviews and Chapter 7 concerns tables of contents.

In addition to the main discussion there are two appendices. The first appendix describes
the inquiries that are available in the current TSM. These inquiries form the basis for our
formal specification, since these inquiries provide the necessary basic functionality for
inspecting and accessing content in an A-box. The second appendix gives a set of target
texts for the final prototype, against which we will be able to assess the further
development of the TSM.

1.3 The Text Structuring Module

The AGILE Text Structuring Module (TSM, implemented for the intermediate prototype
and described in TEXM?2) consists of two parts.

One part concerns text planning, and essentially consists of a network of systems
(region) implemented in KPML. A text plan is built by traversing the region, in a manner
that is analogous to the way sentential structures are generated. While traversing the region,
the structure of the A-box is examined and, depending on how content is configured and
what content is present, a text plan is constructed.

The second part regards sentence planning. It is convenient to think of the text plan as a
hierarchical structure, with individually identified pieces of content at the leaves of that text
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plan structure. The sentence planner creates SPLs (Sentence Planning Language
expressions) for these pieces of content, where an SPL may either realise just one leaf
(leading mostly to a single-clause sentence) or aggregate several leaves, depending on the
way these leaves are related in the text plan.

The text planner being a region implemented in KPML, its basic ingredients are systems,
choosers, inquiries, and inquiry-implementations. The systems concentrate on inserting, or
extending, the components of the text plan. For the instructional texts in procedural style,
generated by the intermediate prototype, these basic components are the TASK-TITLE,
TASKSs, and INSTRUCTIONSs. The TASK-TITLE corresponds to the topmost goal of the
A-Box, a TASK corresponds to a PROCEDURE (and is identified with the PROCEDURE's
GOAL), and an INSTRUCTION corresponds to a METHOD. PROCEDURE and
METHOD are the so-called configurational concepts of the Domain Model. These concepts
are used to structure the content in the A-Box. Consequently, each TASK can have a SIDE-
EFFECT, and one or more TASK-INSTRUCTIONS. These are mapped from a
PROCEDURE's SIDE-EFFECT and METHODS, respectively. Similarly, an
INSTRUCTION can have a CONSTRAINT and/or a PRECONDITION, and must have a
non-empty list of INSTRUCTION-TASKS. These come from a METHOD's
CONSTRAINT, PRECONDITION, and SUBSTEPS respectively.

Most systems in the currently implemented region check in the A-box for either of the
following two things. Either a system checks whether a particular configurational concept
is present at the current locus of attention, and as such should be mapped to the appropriate
text plan component which should then be inserted into the text plan. Or, it checks whether
a list-structure like TASK-INSTRUCTIONS or INSTRUCTION-TASKS has a non-empty
tail, and as such should be extended. Inserting or extending a text plan component is done
by a system, which depends for its decision on a chooser. These choosers say either "yes do
insert/extend" or "no don't do anything". In order to make these decisions, the choosers rely
on inquiries, and these inquiries themselves are implemented as functions that look into the
A-box. The current TSM has a number of general-purpose inquiries as well as more
specific inquiries, all of which have been documented and can be reused in implementing
more complex inquiries to underlie new systems and their choosers.

Most importantly, the inquiries can be used to examine parts of the A-box to any
arbitrary level of detail. The TSM mostly queries the structure of the A-box (i.e. presence
of values in slots of configurational concepts) but at times does descend to the level of
content specified under a configurational concept. An example of this can be found in the
sentence planner and the way constraints are ‘SPLized’ (expressed in SPLs)

In other words, the current TSM can be conceived of as providing a library of functions
that can be readily used to query the A-box in order to assist in making decisions about
building a text plan. The approach we want to propose for the final Text Structuring
Specification deliverable (TEXS3) is based on the idea of reusing these functions.

1.4 Specifying the decisions for creating more complex text plans

As is hopefully clear from the previous section, and the way text structuring in general is
done in AGILE (TEXM2), the structure of a text plan is an interpretation of the way
content has been structured in the A-box that the text is to realise. Looking at the
organisation of content in the part of the A-box under consideration, a system in the text
planner's KPML region decides to extend the text plan in one way or the other.
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This approach can be readily extended to creating the more complex variations that we
envision for the final prototype. Like the text plans for the intermediate demonstrator, the
resulting, more complex text plans will have to be built by interpreting the structure of an
A-box. Fortunately, the necessary inquiry-implementations are available already in the
current TSM. The way we propose to cover the creation of more complex text plans is to
specify systems, choosers and their inquiries, in the formal way we adopted already in
earlier deliverables (e.g., for WP6.2). For the specification of the inquiries, the important
idea is that we can reuse the existing inquiries, either on their own or as building blocks for
more complex inquiries and choosers.
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2. Text types and stylistic variation in the final prototype

In the TEXS2 deliverable we discussed several variations for instructions in procedural
style. For example, we considered textual styles like personal versus impersonal, various
ways in which particular text elements like document titles could be realised, and whether
additional information like side-effects should be realised explicitly.

Similarly, for the purpose of the final prototype, we focus on software documentation.
However, as our corpus analyses revealed, different styles of conveying a given content can
be employed, and different kinds of documentation focus on different chunks of the
content, and present the content in different organisations. This means that the same content
(set of A-boxes) can serve as input to generating various types of texts.

In this chapter, we describe the range of stylistic variation we take into account in the
final prototype texts. We first introduce the text types supported in the final prototype, and
then we discuss various ways of realising given content in general. The individual text
types and the range of stylistic variation available with respect to each of them will be
discussed in detail in subsequent chapter of this deliverable, along with examples and the
necessary formal specifications.

2.1 Text types (genres)

Let us first overview the terminology we have been using in Agile. It has been introduced
in more detail in the TEXS2 deliverable. There, we followed (Hartley and Paris 1996, H&P
henceforth).

H&P propose that for the instructional texts as found in software manuals an obvious
option is to explore the communicative purpose. The communicative purpose does not need
to be constant throughout a manual, as H&P observe. They discern three different
functional sections in their corpus of Macintosh manuals:

* Tutorial: concerning excercises for new users
» Series of step-by-step instructions for the major tasks
* Ready-reference summary of the commands

The functional sections as differentiated by communicative purposes according to H&P
can be considered to constitute different genres in terms of Martin (1992). Genres are
distinguished by their communicative purposes, and they control text structure and its
realisation. According to H&P, genre is responsible for the selection of a text structure in
terms of task elements.

H&P also suggest that it is useful to distinguish between two more specific
communicative purposes in step-by-step sections, and we adopted this approach too. So,
summarizing, in TEXS2 we used the following classification of text types (genres) found in
step-by-step sections of the AutoCAD manual:

* procedure (we also refer to it as instructive), where the purpose is to enable the reader
to perform a task

* elaboration (we also refer to it as descriptive or informative), where the purpose is to
increase the reader's knowledge

We also said that the AutoCAD manual sections entitled "Further possibilities" and the
introductory parts of sections would correspond to the informative text type, while those
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pieces of the texts which we included in our WP3 corpus (see the CORP deliverable), and
were marked as Procedure would be of the procedural text type.

While the initial demonstrator and the intermediate prototype aimed to generate
procedural instructions, we now broaden the scope to other types of texts that can be found
in software documentation. For the purpose of the final prototype, we are extending the
coverage of text types (genres) in the following way:

1. Within step-by-step, we generate the following two text-types (sub-genres):
* procedural type (procedure, instructive):
(a) full instructions in procedural style (procedural instructions)

(b) abbreviated instructions in procedural style (procedural instructions):
(1) summary instructions: goal-oriented = the why without the how
(1) basic steps: step-oriented = the how without the why, also commonly
called "cheat-sheets", or informally characterised as robotic

* descriptive type (elaboration, informative):

(a) overviews of the documented tasks:

(1) full and

(11) abstract
(these are like the texts in the introductory parts of sections in the AutoCAD
manual, or like the texts found under "Further possibilities")

(b) explicit side-effects might, if one wants, be considered as pieces of elaboration
within procedural instructions (this is still in line with H&P)

2. Within ready-reference summary of commands, we generate the text-type (sub-genre)
of functional descriptions (descriptions in function-oriented style): these are like the texts
that can be found under "Related commands" in the AutoCAD manual). Given that we only
try to convey content that we can distill out of the A-boxes, we only generate a particular
kind of functional description, namely what commands do, or what selecting an interface
object does.

3. As an extra genre, not discussed by H&P, we also generate a Table of contents.

Texts of all these types are to be generated from the same input, namely from collections
of A-boxes. Let us now characterise each of the text types briefly (much more detailed
discussions are provided in Chapters 3, 4, 5, 0, 7).

Full instructions in procedural style are taken over from the intermediate prototype, and
we try to provide more variation in the content realisation (see below). Abbreviated
instructions are similar in style to the full instructions, but not all the content of the A-
boxes is realised. They are procedural texts that are essentially abbreviations of the larger
instructional texts considered in WP5.2. We consider two possible ways in which a the
content of an A-box can be presented in an abbreviated way: summaries (Goal-oriented
abbreviated instructions) focus on the higher level goals in the A-box, leaving out the
steps to accomplished ("the why without the how"), and basic steps (Steps-oriented
abbreviated instructions) focus on these steps themselves and leave out the higher level
goals ("the how without all the why's"). Summary instructions thus convey only the more
abstract parts of the content, while steps instructions convey the most concrete steps within
procedures. The examples below illustrate these text styles on the basis of the text 2 from
the intermediate prototype set of texts.
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Summary

To draw a line and arc combination polyline
First draw a line segment.

Then draw an arc segment.

Then draw another line segment.

Finally, press Return to end the polyline.

Basic steps

To draw a line and arc combination polyline

Start the PLINE command using one of these methods:
Windows: From the Polyline flyout on the Draw toolbar, choose Polyline.
DOS and UNIX: From the Draw menu, choose Polyline.

Specify the start point of the line segment.

Specify the endpoint of the line segment.

Enter a.

Select OK in the Arc mode confirmation dialog box.

Specify the endpoint of the arc.

Enter /.

Select OK in the Line mode confirmation dialog box.

Enter the distance of the line in relation to the endpoint of the arc.

Enter the angle of the line in relation to the endpoint of the arc.

Press Return.

Descriptions in function-oriented style constitute the first type of three types of non-
procedural texts we consider here. As our corpus analyses (CORP, TEXS2) revealed,

descriptions in function-oriented style are very common in original software documentation

in Czech, Russian and Bulgarian; in Czech, this text type is in fact prevalent. Descriptions
convey the A-box content in a different way than the procedural instructions. Rather then
providing step-by-step instructions, these texts tell the user what can be achieved by various

command or actions, and what are the functions of particular interface objects. We consider

two types of function descriptions, being descriptions of what Goal(s) a Method (user-
action) can accomplish and descriptions of what Goal(s) a GUI object (for example, a
command, menu item, or toolbar icon) achieves. The following examples illustrate the two

styles of descriptions.

Action-based descriptions

Selecting Add in the Element Properties dialog box adds an element.

Choosing OK in the Element Properties dialog box saves the style of the multiline element and exits
the Element Properties dialog box.

Object-based description

The Add button in the Element Properties dialog box adds an element.

The OK button in the Element Properties dialog box saves the style of the multiline element and exits
the Element Properties dialog box.

Descriptive texts might be restricted to describing the content of a single A-box, though

more interesting texts arise when a collection of A-boxes can be considered.

For overviews and TOC:s this is no longer an option - for these text styles we will have

to consider collections instead of individual A-boxes.
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Overviews of the documented tasks convey the A-box content in a way similar to the
function-oriented descriptions. They differ from them in concentrating on the user's tasks,
and the ways they can be accomplished rather than on the functionality of the interface
objects. Overviews often contain generalisations (abstractions) over the A-box contents.
They also group the content realisations into logical clusters, either by the type of task
performed by the user, or by the object(s) affected by the performed operations. Task
overviews are an integral part of every software manual. They can be found in introductory
chapters as well as in introductions to individual sections of the manual. An overview can
present the content in the same order as it appears in the A-boxes, or in another order. The
example below illustrates a simple overview.

The system enables you to create a multiline style, to specify the properties of a multiline, to draw a
line and arc combination polyline, to draw an arc by specifying three points, and to define a
boundary set in a complex drawing

Tables of contents are another necessary part of every piece of software documentation.
Overviews appear as running text - TOCs present similar information, only then in a
different layout. It is sensible to think of organising the TOC in different ways, e.g., by the
sequence of procedural instructions as given in the manual (headings), by the interface
objects (functional descriptions), or by the tasks (overviews). In this way, the TOC relates
to the content conveyed in all the previous text types, but it present only a skeleton of the
information, and it presents it in a different format. This is illustrated in the example of a
simple TOC below.

1. Creating a multiline style 3
2. Specifying the properties of a multiline 5
3. Drawing a line and arc combination polyline 7
4. Drawing an arc by specifying three points 8
5. Defining a boundary set in a complex drawing 10

The generation of instructions in procedural style (either full or abbreviated) can be
naturally performed and meaningfully demonstrated using a single A-box as the input. On
the other hand, the remaining text styles, i.e. functional descriptions, overviews and tables
of content, are more appropriately applied to larger inputs, most naturally thought of as
collections (sets, lists) of A-boxes in which various tasks are modelled. It would of course
be possible and meaningful to generate instructions in procedural style on the basis of an A-
box collection. Most straightforwardly, this would yield a sequence of single A-box
procedural texts. In order to support generation of any texts from a collection of A-boxes
rather than a singe A-box, the functionality of both the IFACE and the CADCAM region
needs to be extended. We need to load and traverse a list of A-boxes. (Chapters 6 and 7
discuss these issues in more detail.)

The generation of function descriptions, overviews and tables of content which we aim
at for the Final Prototype amounts to generating "meta-texts" on the basis of multiple input
content specifications. The only other work we are aware of which has a comparable goal is
that of Radev and McKeown (1998). They discuss a methodology for generating summaries
of news coming from multiple sources, with a focus on the domain of news on terrorism.
As Radev and McKeown point out, the approach they present is fairly unique in that, bar a



AGILE 15

few exceptions, most available summarizers are focus on the generation of a summary from
a single article (source). It appears that this holds in general for generation of "meta-texts"
like those we will generate in the Final Prototype, and our efforts can therefore be regarded
as original in the light of the state-of-the-art in NLG.

2.2 Stylistic variations

For the purpose of the intermediate prototype, we allowed for different text styles to be
used within a genre. These styles were chosen to differ in:

* lexicogrammatical features, i.e., personal vs. impersonal style

» distribution and lexical realisation of content, in particular explicitness of content, i.e.,
realisation with vs. without side-effects

The discussion of stylistic variation in the final prototype again concerns the above two
factors, but we break them apart into more details. We discuss variation in:

* lexico-grammatical features (personal vs. impersonal style)
* realisation of deontic modality

» explicitness of content realisation

* linear organisation

* aggregation

* marking of sequences

* numbered list vs. running texts

In general, the choice of a particular style of realisation may be determined by the user's
requirements, or by the complexity of the content being expressed. The variations we take
into account for the final prototype concern the following aspects:

* lexico-grammatical features pertaining to personal vs. impersonal style (Voice, Mood,
Person, Number)

* lexico-grammatical realisation of deontic modality (possibility, necessity)

» explicitness of content realisation: explicit vs. implicit side-effects, various degrees of
full vs. abbreviated content expression

* linear organisation of the content realisation, in particular whether realisation of a Goal
precedes the realisation of its accompanying Methods or the other way round

» aggregation of the realisation of content units into clause complexes, exploiting various
relations, in particular RST-Means, RST-Purpose, RST-Sequence, Conjunction and
Disjunction.

» explicit marking of sequences by discourse markers
* numbered lists vs. running texts

Stylistic variation applies within each text type (sub-genre). In each of the above
mentioned text types, the realisation of a given content may vary, so the range of possible
variation is not the same in all the text types. In the following sub-sections, we explain the
variations in general, irrespective of text type. At the end of this section we provide a table
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which correlates the stylistic variation and text type. Details of the possibilities within each
text type are discussed in Chapters 3.1, 3.2, 4, 5,0, 7.

2.2.1 Lexico-grammatical features of personal vs. impersonal style

This variation mainly concerns the choice of Voice and Mood. It is retained from the
intermediate prototype, and has been discussed in detail in TEXS2. We have so far
provided the following alternatives, common to Bulgarian, Czech and Russian:

* personal style: imperative mood, polite imperative (second person plural)
* impersonal style: indicative mood, medio-passive voice

There are additional possibilities, which we would like to cover in the final prototype.
Personal style of procedural instructions in Czech very often employs indicative mood in
active voice in first person plural:

Cz:

Abychom cdru ukoncili, stiskneme Enter.
so-that-would-1pl line end-1pl press-ind-1pl Enter

In order to end the line we press Enter.

Also second person plural is possible, and is used in some manuals:
Cz:

Abyste cdru ukoncili, stisknete Enter.
so-that-would-2pl line end-2pl press-ind-2pl Enter

In order to end the line you press Enter.

In Russian and Bulgarian, first person plural is not common to express instructions. It is
a style of mathematical texts, including the speaker as Actor of a process. If used in
instructions, it would indicate a change of style, for instance, it could be used to mark the
author's proposal as in the following example:

Ru:

Illpusedem  cmpyxmypy cioeg epaguueckozo pedakmopa.
Describe-1pl structure-acc layers-gen graphical editor-gen.
Let’s describe the structure of layers in the graphical editor.

Bu:

Ja  paszenedame  cmpykmypama HA  MYIMUTUHUAMA.
Let's consider-1pl  structure-def of multiline-def.

Let's consider the multiline structure

Similar observations concerning first person plural hold for Bulgarian. It is sometimes
found in recipes or in a lecturing style, but normally not in technical manuals.

The realisation in second person plural is possible in Russian and in Bulgarian only with
an explicit modal element, where a choice from a set of alternatives is described:

Ru:
Bw1r  mooiceme ev16pame  00un u3 creoyouux Memooos.
You can choose-inf one of following methods

You can choose one of the following methods.
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Bu:
Mooce  Oa usbepeme  eoun om  caeoHume Memoou.
Can to choose-2pl one of  following-def methods.

You can choose one of the following methods.

In impersonal style, Czech and Russian can employ infinitive constructions:

Cz:

Stisknout Enter, aby se c¢dra ukoncila.
Press-inf-1pl  Enter so-that-would-1pl refl line end-3sg

Ru:

Haoiemume  Enter, umobOvt  3a6epuiums pucosanue  TuHul.
Press-imper Enter in-order-to end drawing-acc line-gen.

Press Enter in order to end the line.

With respect to the realisation of headings in procedural texts, we have so far used only
nominalisations. Another possible variation, which we have encountered in the Microsoft
Word manuals in Czech, concerns the realisation of headings in interrogative mood. In
questions, the various choices of Voice, Person and Number present in personal vs.
impersonal style can be reflected:

Cz:

1. Jak uloZit soubor?
How save-inf file
How to save a file?

2. Jak se uloZi soubor?
How refl save-3sg file
How does a file save?

3. Jak wuloZime / uloZite soubor?
How save-ind-1pl/ save-ind-2pl file?
How do we/you save a file?

Bu:

4. Kax oa zanomuume ¢haiira?
How to save-2pl file-def?

5. Kax ce 3anomus  ¢paiin?
How refl save-3sg file?

The use of interrogative mood in headings is also possible in Bulgarian. It reflects a rather
informal style. It is not possible in Russian, except perhaps in a popular(ising) style.

For Russian, it is most appropriate to realise headings by partial nonfinite purpose-
clauses, i.e. “Ymobsr + inf” (To + inf). The motivation for preferring partial clauses is that
very often an appropriate nominalization noun lexeme for a process is lacking.

2.2.2 Lexico-grammatical realisation of deontic modality

Another aspect of possible stylistic variation in the final prototype texts concerns the
realisation of deontic modals. So far, we have not included any explicit modal elements in
the generated texts. As an alternative, the possibility or necessity of certain processes can
be made explicit. For example, a precondition can be realised with an explicit necessity
modal:
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Cz:
6. Personal style using o person plural:
Nejdrive musite  oteviit  dialogovy panel Multiline Styles
First must-2pl open-inf dialogue box Multiline Styles
First you must open the Multiline Styles dialogue box.
7. Impersonal style using reflexive passive:
Nejdrive se  musi otevrit dialogovy panel Multiline Styles
First refl must-2pl open-inf dialogue box  Multiline Styles
First the dialogue boc Multiline Styles needs to be open.
8. Style-independent realisation:
Nejdrive je nutné otevrit  dialogovy panel Multiline Styles
First is necessary open-inf dialogue box Multiline Styles
It is first necessary to open the dialogue boc Multiline Styles.
Ru:
9. Personal style:
Crauana Bt 0ondxcust omxpeime ouanoeosoe okno  Multiline Styles
First you-pl must-pl open-inf dialogue box-acc Multiline Styles
First you must open the Multiline Styles dialogue box.
Cnauana Bam HeoOX00UMO OmKpuIms Ouano2oeoe okno  Multiline Styles
First you-pl-dat necessary  open-inf dialogue box-acc Multiline Styles
First you must open the Multiline Styles dialogue box.
10. Impersonal style:
Chauana neobxo0umo OmKpeims OUANO2060€ OKHO Multiline Styles
First necessary  open-inf dialogue box-acc Multiline Styles
First the dialogue box Multiline Styles needs to be open.
Bu:
11. Personal style:
Omuauano mpsioea oa omeopume ouanoeosus — nposzopey Multiline Styles.
First must to open-2sg dialogue-def box Multiline Styles.
First you must open the dialogue box Multiline Styles.
12. Impersonal style:

Omuauano mpsbsa oa ce  omeopu  ouanoeosus nposopey Multiline Styles.
First must  to refl open-3sg dialogue-def box Multiline Styles.
First the dialogue box Multiline Styles must be opened.

While for example in French, it is possible to use something like You necessarily open the
Multiline Styles dialog box first, such realisation is not natural in any of the three Slavic
languages, and neither is it in English.

When explicit modals are used in a procedural text, the explicit modal element should
not be repeated in every instruction, but rather, it should appear only in the first sentence. It
seems natural that when a Goal is expressed, and then a list of steps, only the Goal would
be realised with an explicit modal element.

As noted above, when a list of alternative way of achieving a Goal is presented, it is
possible and natural to use an explicit possibility-modal. In 0, we repeat the Russian
example shown as 0 above, and provide the corresponding Czech and Bulgarian versions:
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13. Ru:
Bur  mooiceme 6v16pame 00un u3 credyrouux cnocoboe.
You can choose one of following methods
14. Cz:
MiiZete zvolit jeden 7z ndsledujicich  zpiisobu.
Can-ind-2pl choose-inf one-acc of following-gen methods-gen
15. Bu:
Mooce  Oa uzbepeme  edun om  caeoHume Memoou.
Can to choose-2pl one of following-def methods.

You can choose one of the following methods.

Again, personal vs. impersonal variation in style is possible.

It should be noted that in the corpora we have analysed, explicit modals were not used in
(enumerated lists of) step-by-step procedural instructions at all. We found them only in
overviews (introductions to sections), and the functionally-oriented texts (descriptions). The
following two examples illustrate the explicit expression of possibility in an overview-style
and a description-style sentence, respectively:

Overview:
16. Cz:
V' programu AutoCAD miiZete urcovat vlastnosti Car.
In program AutoCAD can-ind-2pl specify-inf properties lines-gen.
17. Bu:
B npoepamama  AutoCad mooice Oa onpedenume Xapakmepucmuku HA JUHUSL
In Program-def  AutoCad may to specify-2pl properties of line.
18. Ru:
B npoepamme AutoCAD mooicno  3a0ambo ceoticmea JIUHUIL.

In program  AutoCAD possible specify-inf properties-acc lines-gen.
In the AutoCAD program you can specify line properties..

Description:
19. Cz:
Prikaz ~ Multiline Styles umoZiuje vytvdaret — styly car.
Command Multiline Styles enables create-inf styles-acc lines-gen
20. Bu:

Komanoama Multiline Styles eu nossonsea oa cvzoademe Cmuil HA JTUHUAL.
Command-def Multiline Styles you enable-3sg to create-2pl style of line.

21. Ru:
Komanoa Multiline Styles noseonsiem cozoasams cmuiu JIUHUTE
Command Multiline Styles enables create-inf styles-acc lines-gen
The Multiline Styles command enables you to create line styles.



AGILE 20

2.2.3 Explicitness of content realisation

We have discussed the variation concerning explicit vs. implicit realisation of Side-effects
in detail in TEXS2. We shall preserve this style variation in the final prototype.

In addition, we are going to support various degrees of full vs. abbreviated content
expression. This is reflected especially in the text types of abbreviated procedural
instructions, overviews and tables of contents. In all these cases, it is possible to vary the
level at which explicit realisation stops. For a more elaborate discussion see the respective
chapters.

2.2.4 Linear organisation

The A-box has a hierarchical structure, and it also contains lists of elements at the same
level, e.g. alternative Methods within a Procedure, or sequence of Substeps within a
Method-list.

Any list we are handling is ordered. While for alternative Methods, neither their order in
the A-box nor the order in which they get realised really matters, the situation is different
with lists of Substeps. We assume that the author who builds the A-box orders the Substeps
in accordance to the order in which they need to be carried out by the user. Therefore, when
the Substeps are realised as step-by-step instructions, their order should be obeyed. If their
order is not reflected by the order in which they are realised, the temporal order should be
indicated by explicit temporal discourse markers. We think that it is most natural for
procedural texts to obey the ordering of Substeps as given in the A-boxes, and therefore we
do so in the final prototype texts.

A different case is at hand with Goals and the (list of) Substeps within the corresponding
Method(s). These are in a hierarchical relation in the A-box, and it is a matter of text
planning to decide in what order their contents should be conveyed.

The issue of alternative ordering of Goal and Method, and therefore the corresponding
Substeps, has not yet been addressed within the Agile project. There is a natural link to the
issue of aggregation (next section) here, because the issue of Goal and Method(s) ordering
only arises when the content is realised by a clause complex. When the content of the Goal
is realised in a separate sentence, than it is natural to order this sentence before the
realisation of the Method(s).

The A-box specifies the relation between a Goal and Method(s), and the corresponding
Substeps, but it is a matter of text planning to chose a realisation of this relation by an RST-
relation, 1.e. either RST-Means or RST-Purpose (discussed in the next section). The current
text planner supports one realisation only, either RST-Means, with Goal*Method, or RST-
Purpose, with Method*Goal. The choice is made in the SPLIZE module.

With respect to linear ordering, all four possibilities are allowed in general:
* RST-Means : Goal*Method(s): Specify the start point by entering endp
* RST-Purpose: Method(s)*Goal: Enter endp to specify the start point
* RST-Means: Goal*Method(s): By entering endp specify the start point
*  RST-Purpose: Method(s)*Goal: To specify the start point enter endp



AGILE 21

2.2.5 Discourse aggregation and syntactic aggregation

There are various ways in which we can combine content, as expressed by PROCEDURESs
in the A-box and identified by TASKSs in the text plan. We already pointed out that we
consider here discourse aggregation and syntactic aggregation. Given two PROCEDURESs
specifying content, and the corresponding linguistic structures that would express that
content, discourse aggregation concerns the combination of these two linguistic structures
into a single linguistic structure that makes explicit the rhetorical relation between two
individual linguistic structures, thus supporting the overall rhetorical structure of the text.

In the intermediate prototype we handled aggregation using either RST-MEANS or
RST-PURPOSE. We did not provide any flexibility with respect to enabling various kinds
of RST relations (also beyond MEANS or PURPOSE), nor could we handle syntactic
aggregation like coordinating linguistic structures that correspond to subsequent
PROCEDUREs in SUBSTEPS, or disjunction of alternative METHODs listed under a
PROCEDURE's METHODS field. In the final prototype, we would like to support stylistic
variation along these lines. One area to be covered is clause-complexity in realising a goal
and its method(s) by RST-Means or RST-Purpose, as hinted at above. Here we provide an
example using RST-Purpose.

22. Cz:
Zvolte Element Properties, abyste pridali elementy ke stylu.
Choose-imp-2pl Element Properties so-that-would-2pl add-2pl elements to style.
23. Bu:
Hsz6epeme Element Properties, 3a oa npubaeume enemeHmu KoM CIIUICL.
Choose-2pl Element Properties in-order to add-2pl  elements to style-def.
24. Ru:

Buibepume  nynxm  Element Properties,
Choose-imp-pl item-acc Element Properties,

umoov oobasums 21eMeHmsl 6 CMUIb
in-order-to add-inf  elements-acc.in style-acc.

Choose Element Properties to add elements to style.

Alternative Methods are naturally realised by Disjunction:
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25. Cz:
Zvolte Element Properties nebo stisknéte Ctrl-E.
Choose-imp-2pl Element Properties or press-imp-2pl Ctrl-E.
26. Bu:

H3z0epeme Element Properties unu namucneme Ctrl-E.
Choose-2pl Element Properties or press-2pl  Ctrl-E.

27. Ru:
Buibepume  nynxm  Element Properties unu nasicmume  Ctrl-E.
Choose-imp-pl item-acc Element Properties or  press-imp-pl Ctrl-E.

Choose Element Properties or press Ctrl-E.

There are also of various ways of grouping content within an A-box, and using
Conjunction. For example, Substeps within one Method can be conveniently conjoined:

28. Cz:
Zadejte ndzev souboru a  zvolte jeho typ.
Enter-imp-2pl name file-gen and choose-imp-2pl its type.
29. Bu:

Bveeoeme ume na aiin u  uzbepeme He2o08us Mun.
Enter-2pl name of file and choose-2pl its type.

30. Ru:
Beeoume  ums Gaiina u  evibepume e2o0 mun
Enter-imp-pl name-acc file-gen and choose-imp-pl its type.

Enter the name of the file and choose its type.

Similar aggregation options as we have exemplified for instructions in procedural style
are available for the realisation of descriptive texts and overviews. The following two
examples illustrate aggregation by Conjunction in an overview-style and a description-style
sentence, respectively:

Overview:

31. Cz:
V' programu AutoCAD miiZete urcéovat vlastnosti car
In program AutoCAD can-ind-2pl specify-inf properties lines-gen

a uklddat  je Jjako styly.
and save them as styles.
32. Bu:

B npoepamama AutoCad moowceme oa onpedenume ce0licmea HA JNUHU
In program-def AutoCad may-2pl to specify-2pl properties of line

u oa eu  3aNOMHUME KAMO CIUL.
and to them save-2pl as  style.
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33. Ru:
B npoepamme AutoCAD moodicno  3a0ambo ceoticmea JUHUE U
In program  AutoCAD possible specify-inf properties-acc lines-gen and

coXpanums  Ux 6 eude cmuie
save-inf themin  form styles-gen

In the AutoCAD program you can specify line properties and save them as styles.
Description:

34. Cz:
Prikaz ~ Multiline Styles umoZiuje vytvdaret  styly car
Command Multiline Styles enables create-inf styles-acc lines-gen

a uklddat je jako styly.
and save them as  styles.

35. Bu:
Komanoama  Multiline Styles Bu nozeonsisa oa cvzoademe cmuiose HA
Command-def Multiline Styles you enable-2pl to create-2pl styles  of

JUHUAMA U 0a 2u  3aNOMHUME Kamo CMmujioee.
line-def and to them save-2pl as  styles.

36. Ru:
Komanoa Multiline Styles noseonsiem cozoasams  cmunu JUHUH U
Command Multiline Styles enables  create-inf styles-acc lines-gen and

coxpanums ux 6 eude cmueil
save-inf  them in form styles-gen

The Multiline Styles command enables you to create line styles and save them as
styles.

Another case where aggregation can be applied in the realisation of the A-box content is
the expression of Constraints. In the intermediate prototype system, Constraints are
expressed in separate content-units, realised by a nominal group. A Constraint reflects a
situation in which a particular Method can be used to accomplish a given Goal. Therefore, a
Constraint could also be expressed either by a subordinate conditional clause modifying the
main clause realising the Goal, or by an element within the Goal-clause.

2.2.6 Explicit marking of sequences by discourse markers

As we noted above, a sequence of Substeps within the same Method in an A-box is
assumed to be ordered in accordance to the order of executing the Substeps to achieve the
given Goal. We also noted that it is natural for the generated text to obey this order when
the Substeps are realised. This is what the current text planner does, and also in the final
prototype, the A-box ordering of Substeps will be obeyed in the realised texts.

In addition, is it possible to include explicit discourse markers reflecting the sequences
of Substeps, e.g. now, then, first, second, finally, etc. (and their equivalents in Bulgarian,
Czech and Russian). This may help the reader to orient herself, especially in the cases
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where a hierarchical content is realised by a series of instructions. The explicit discourse
markers thus reflect discourse structure (see Chapter 3.2 for examples and an elaborate
discussion).

2.2.7 Numbered lists vs. running texts

Instructions in procedural style, but possibly also other text types, can express the content
either in numbered lists, or in running text. Running text is typically used for overviews.

While numbering certainly is a matter of output formatting, it is more than just that.
Issues of aggregation and explicit discourse markers are intertwined with the choice of
numbered list vs. running text realisation.

So for example, whereas in a numbered list, explicit discourse markers signalling
sequences would be redundant, such is needed to a greater extent in a running text. Running
text often also exhibits more aggregation.

2.3 Correlations between text type and stylistic variation

The following table relates text types and stylistic variations. We indicate which parameters
of style are fixed within a text type, and which stylistic variations are meaningful or useful.
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Text Type Personal vs. Explicit Explicit side- Ordering of Numbered Aggregation Explicit
impersonal modality effects Goal and list vs. discourse
style Method(s) Running text markers
Full Yes yes yes Yes yes yes yes
procedural
Goal Yes yes not appl. not appl only num. only conj. not appl.
summary
Basic steps Yes yes yes not appl. only num. conj and dis;j. yes (for
clustering)
Functional Yes yes not appl. yes only running yes yes
descriptions
Overviews Yes yes not appl. yes only running yes yes
TOC Not appl. not appl. not appl. not appl only num. not appl. not appl.

Figure 1: Correlations between text types and stylistic variations

The correlations captured in this table will be further discussed in the subsequent
chapters. They will also be reflected in the formalisations, which will provide the necessary
distinctions underlying the variety available in the content realisation.
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3. Full procedural instructions

Clauses, sentences and also larger pieces of discourse are not isolated from one another. In
a coherent discourse, there are relations between "discourse units". They go under various
names, for instance coherence relations (Hobbs 1979), discourse relations (Asher 1993),
further distinguished as subject-matter vs. presentational (RST, Mann and Thompson
1988), informational (semantic) vs. intentional (Moore and Pollack 1992).

Some of these relations (esp. the subject-matter or informational ones) reflect relations
that hold between the objects the discourse is about, or between eventualities described in
the discourse. The relations between various pieces of content as captured in an A-box can
be classified in an abstract and general way as follows:

* SEQUENCE relation(s) among SUBSTEPS within a METHOD

* ALTERNATIVE relation(s) among METHODs within a PROCEDURE (if there are more
than one)

* SUBORDINATION, or EMBEDDING of some piece of content with respect to another

e ENABLEMENT or PURPOSE relation(s) between the GOAL and the METHOD(s) within a
PROCEDURE's METHOD:s (a special case of EMBEDDING)

Due to these inherent relations between the underlying pieces of content and/or due to
the speaker's communicative GOALSs, relations between discourse units are always present.
However, sometimes they are signalled explicitly, and sometimes they are not. One can
speculate that some contexts may be sufficiently specific, so that no explicit signalling is
needed. It is also possible to find relations between pieces of content, which do not have a
straightforward corresponding realisation, and it is for this reason that they are not
explicitly signalled (Knott 1996).

On the other hand, there are linguistic means of signalling relations explicitly which can
easily and efficiently convey more than just the type of relation at hand, i.e. a causal
relation. This additional meaning gets in through presuppositions associated with certain
discourse connectives (Lagerwerf 1998, Stone and Webber 1998, Webber et al. 1999a,
Webber et al. 1999b). However interesting this topic is, also from the NLG perspective, it
appears outside the AGILE scope at the moment. We concentrate on the assertion-part of the
meaning of discourse connectives, leaving the presupposition-part aside.

Explicit signals of relations between discourse units can take various forms. In written
procedural instructions, which is what we focus on in this chapter, the following means are
available, and exploited:

* linguistic expressions going under the names of discourse markers (Schiffrin 1987),
discourse connectives (Webber, ibid), clausal connectives (Knott and Mellish 1996),
discourse cues (Grosz and Sidner 1986), cue phrases (Knott 1996), and clue phrases
(Cohen 1987)

* list numbering
* layout, i.e. mostly line-breaks between discourse units and indentation

These means naturally interplay. In the procedural instructions in our AutoCAD corpus, we
have encountered the following ways of exploiting the means of realisation with respect to
the above mentioned relations between pieces of content in the A-box:
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* SEQUENCE relation among SUBSTEPS within a METHOD is primarily reflected by the
ordering of sentences and clauses that realise the SUBSTEPS. In addition, the
realisations of the SUBSTEPS are organised into lists with a common layout. The lists
are mostly numbered. Sometimes there are explicit discourse markers.

*  ALTERNATIVE relation among METHODs within a PROCEDURE is most often
encountered with the alternative ways of performing a task depending on the used
operating system. The alternatives can be distinguished by a Constraint. In this case, a
particular layout is used in the AutoCAD manual: the Constraints are realised by
nominal groups and typeset in bold face; the groups of instructions pertaining to the
same Constraints are realised as running text. On the other hand, for METHODs not
distinguished by a Constraint, the realisations are usually aggregated by means of
Disjunction.

* EMBEDDING of some piece of content with respect to another (for instance, SUBSTEPS
of a PROCEDURE's METHODs embedded within a SUBSTEPS within a higher
PROCEDURE's METHODS), is very often not reflected in the realisation in the
AutoCAD manual. This means that SUBSTEPS are realised in a continuing numbered
list irrespective of the (presumed) underlying hierarchical structure of the task as a
whole. In our opinion, this nivelisation of the underlying hierarchical structure
decreases clarity of the instruction text.

There are a few cases in the manual where the hierarchical structure is reflected by
layout (indentation of a sub-list) and/or by explicit discourse markers (e.g., Now save
the style in IMD-Text4).

* ENAMBLEMENT or PURPOSE relation between the GOAL and a METHOD within a
PROCEDURE is in some cases reflected by aggregation by means of a clause complex
involving RST-Means or RST-Purpose. This is mostly when the METHOD is rather
simple with respect to the SUBSTEPS it requires. When the METHOD is complex, the
GOAL and the METHOD are realised by separate sentences. It is then very often the
case that the EMBEDDING is disregarded in the realisation exactly as described above.
So, the GOAL and the SUBSTEPS of the corresponding METHOD end up in one and
the same numbered list. Again, our opinion is that this nivelisation makes understanding
the instructions more difficult.

This summary shows that the interplay between the kinds of relations between pieces of
content and the means of their realisation is quite complex. We have encountered some
regularity, for instance the use of numbered lists for a SEQUENCE of SUBSTEPS, and the
use of aggregation or indentation to reflect EMBEDDING. It appears natural to use a vertical
list layout for alternative METHODs distinguished by the operating system. Also, the top-
level SUBSTEPS are naturally realised in a vertical list. These appear to be typical for the
given genre, that is, for procedural instructions.

We have also encountered cases where relations between pieces of content are
disregarded (not reflected) in the text. This may be a matter of stylistic choice within the
genre. An example of this is the neglect for hierarchical structure of the task. In our
opinion, such realisations are uncooperative towards the reader, because they obscure the
inherent structure of the task.

In this chapter, we focus on the realisations of the SEQUENCE, ALTERNATIVE and
EMBEDDING relations in procedural instructions. First in Section 3.1 we discuss aggregation
as a realisation of ALTERNATIVE and EMBEDDING relations. Then, in Section 3.2 we are
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concerned with the realisation of the SEQUENCE relation by means other than
straightforward ordering of discourse units.

3.1 Aggregation in full procedural instructions

In this section, we will discuss the explicit inclusion of discourse relations into the text
plan. We begin by outlining the approach we take in section 0. There, we begin with
explaining how the approach provides a generalisation of the way we handled discourse
relations in text structuring for the intermediate prototype. The more general character of
the approach provides a transparent way of how discourse relations are handled, for one
making it easier to be extended to a broader coverage of possible text structures, and for
another, facilitating a more direct comparison to existing theories on discourse structure.

Thereafter we discuss in section 3.1.2, two discourse relations that are naturally
prevailing in the instructional texts we are dealing with, namely conjunction as a realisation
of the SEQUENCE relation and disjunction as a realisation of the ALTERNATIVE relation.
These two relations reflect two fundamental structures in our A-boxes, namely a
METHOD’s SUBSTEPS as a sequence of steps to be taken, and a PROCEDURE’s
METHODS as alternative ways of obtaining the PROCEDURE’s GOAL.

In section 3.1.3 we discuss the introduction of (more abstract) discourse relations that
reflect EMBEDDING, into the text plan. These are RST-MEANS or RST-PURPOSE. These
discourse relations can be used to aggregate content, possibly in combination with
conjunction, giving rise to more complex sentences. An interesting stylistic variation we
consider here is the relative ordering of a discourse (RST) relation’s satellite and nucleus.
As previous corpus study already showed, the preference of one order over the other for
example can be related to the (assumed) level of expertise of the intended readership. We
describe how this can be accommodated in the approach.

Up to this point, we have been discussing relations between PROCEDURES,
METHODS, or between a single PROCEDURE and one or more METHODS. In section
3.1.4 we discuss different levels of aggregation (or, to be more precise, granularity)
including other kinds of configurational concepts as well. The example we consider is the
inclusion of a CONSTRAINT in the sentential structure, instead of regarding it as a “label”,
as 1illustrated by the following:

If you are using Windows, choose Multiline Styles from the Object Properties toolbar.
Windows: Choose Multiline Styles from the Object Properties toolbar.

3.1.1 The approach

In the TSM for the intermediate prototype (TEXM?2) we also used discourse relations, but
these were not explicitly included in the text plan. Rather, they were derived when
interpreting the text plan for the sake of sentence planning. Although a valid and
functioning approach, it seems more economic and more natural to infer discourse relations
already at the stage of constructing the text plan, and include the discourse relations
explicitly.

The reason for explicit inclusion being more economic is that the A-box content
necessary to act upon for inferring discourse relations is already available (and actively
inspected) when constructing the text plan. Explicit inclusion means simply taking that
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extra step further, rather than deferring the decision for using a particular discourse relation
to a later stage where we would then have to inspect the same content again. Furthermore,
the text plans that we obtain this way are more closely related to existing theories on
discourse structure (e.g. (Polanyi 1988), (Gardent 1994), (Webber 1998), (Lagerwerf
1999)).

Explicitly including discourse relations into the text plan should be understood in the
following way. The TSM for the intermediate prototype constructs text plans by
interpreting the structure of the A-box, as determined by the use of configurational
concepts. The interpretation was based on an almost isomorphic mapping between
configurational concepts and the constituents of a text plan, called text structure elements
(again, cf. (TEXM2)). A simple example is the text plan in Figure 2.

| v Structure Graph

SENTEHCE

TASE-TITLE#1 TASK-THSTRUCTIOHS#1
| B e B Tt L L
Document title IHNSTRUCTIOH-TASKSH?2 TASK-THSTRUCTIOHSH2
— |
TASERT INSTRUCTION-TASKSH4
! o e e o
Task TASEH#S TASK-IHSTRUCTIOHSH#S
2 |

Task INSTRUCTIOHN-TASKSHG

TASERT
ik

Task

Figure 2: Intermediate prototype text plan

Instead of having multiple nodes like TASK-INSTRUCTIONS (corresponding to a
PROCEDURE’s METHODS) and INSTRUCTION-TASKS (corresponding to a
METHOD’s SUBSTEPS), we propose here to designate most of these nodes using more
informative names indicating discourse relations.

The consequence is not just that the resulting text plan looks nicer. The decisions for
including a particular discourse relation can now be determined by systems in a KPML
region like the CADCAM-INSTRUCTIONS region (TEXM2). Therefore, extending the
coverage becomes very similar to developing lexico-grammars - we are now, in a more
concrete sense, building “text grammars”. Furthermore, when planning sentences to realise
the text plan, the sentence planner now only has to inspect the text plan to effectuate
aggregation in a sentence plan rather than infer a possible discourse relation.

3.1.2 Conjunction and disjunction

Conjunction and disjunction are relations that follow naturally from two configurational
concepts in the AGILE Domain Model. Namely, a PROCEDURE has a METHODS field
(of type METHOD-LIST) that lists the alternative ways of obtaining the PROCEDURE’s
GOAL. This usually can be translated into disjunction, particularly when we are aiming at
generating running text:
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To save a document
Select the Save command from the File menu
Click on the Save icon in the toolbar

To save a document, select the Save command from the File menu or click on the Save icon in the
toolbar.

Similarly, a METHOD that specifies one way to achieve a PROCEDURE’s GOAL, has
a SUBSTEPS field (of type PROCEDURE-LIST) that gives the PROCEDURES or “steps™
that have to be taken. In other words, the SUBSTEPS field specifies a sequence, which we
conceive of as a form of conjunction.

To save a document under a different name
1. Select the Save As command from the File menu.
2. Enter the file name in the File name box.
3. Click the OK button.

To save a document under a different name, select the Save command from the File menu, enter the
file name in the File name box, and click the OK button.

Let us first consider conjunction. Naturally we should discuss the conditions under
which TASKSs (being the text structure elements corresponding to PROCEDURES) could
indeed be considered proper to be conjoined (being eventually realised using a coordinated
structure), and when they should be kept separate. By its definition in the Domain Model, a
PROCEDURE has to specify a GOAL, and may specify a SIDE-EFFECT and/or
METHODS. In the following example, the first step has a side-effect and the second step
has alternatives:

To save a document under a different name
1. Select the Save As command from the File menu. The Save As ... dialogue box appears.
2. Provide a file name by entering the file name in the File name box or by selecting a file name
from the Directory list.
3. Click the OK button.

In this case we do not want to conjoin the steps, for this would sound very unnatural.
Instead, we should simply state them separately:

To save a document under a different name, select the Save As command from the File menu. The
Save As ... dialogue box appears. Provide a file name by entering the file name in the File name
box or by selecting a file name from the Directory list. Click the OK button.
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Figure 3: Systemic region graph focussing on TASK

Hence, we suggest here to introduce a conjunction into the text plan when we have two
TASKSs that are simplex, i.e. which do not specify side-effects nor METHODs. When we
construct the part of a text plan corresponding to a METHOD’s SUBSTEPS, then above
each step (a TASK) we have a node that is either labelled “CONJOINED-INSTRUCTION-
TASKS” to indicate conjunction or “SEPARATE-INSTRUCTION-TASKS” to signify that
the TASK under that node should not be conjoined to the preceding TASK(s)."

" INSTRUCTION-TASKS is a text structure element that corresponds to the type of structure that a
METHOD’s SUBSTEPS field contains, namely a PROCEDURE-LIST. A PROCEDURE-LIST
implements a list structure in a traditional way, by having a head that is of type PROCEDURE, and a tail
that is of type PROCEDURE-LIST. For that reason the text plan contains a whole branch of nonterminal
nodes called *-INSTRUCTION-TASKS rather than just one *-INSTRUCTION-TASKS with all its
elements (TASKs) as its immediate daughters. We make convenient use here of having several *-
INSTRUCTION-TASKS nodes (one for each TASK) to express conjoinability of individual TASKs.
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Figure 4: INSTRUCTION-TASKS-AGGREGATION system

Formally, we can specify this as follows. To begin with, we are dealing here with
TASKS and their planning as members of an INSTRUCTION-TASKS list. The systems in
the CADCAM-INSTRUCTIONS region that are responsible for that planning are given in
Figure 3.

Instead of immediately introducing an INSTRUCTION-TASKS node in the system
INSTRUCTION-TASK-COMPLEXITY we can decide to introduce only the abstract

feature More-Tasks and let that feature be an entry condition to another system
INSTRUCTION-TASKS-AGGREGATION where we decide about conjoinability.

The decision for introducing a node SEPARATE-INSTRUCTION-TASKS or
CONJOINED-INSTRUCTIONS-TASKS depends whether the TASK that we will be
introducing under this node will be simplex or not, as we discussed above.
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System:
More-tasks =2

(more—conjoined-tasks
insert CONJOINED-INSTRUCTION-TASKS
preselect CONJOINED-INSTRUCTION-TASKS TASK
orderatend CONJOINED-INSTRUCTION-TASKS

)

(more—separated-tasks

insert SEPARATE-INSTRUCTION-TASKS
preselect SEPARATE-INSTRUCTION-TASKS TASK
orderatend SEPARATE-INSTRUCTION-TASKS

Chooser:
Choose more—-conjoined-tasks if conjoinable
else choose more-separated-tasks

The chooser itself relays the question about the conjoinability of the TASK to be
inserted to an inquiry that looks in the A-box whether the PROCEDURE, to which the
TASK is to correspond, specifies a SIDE-EFFECT and/or METHODS. If the
PROCEDURE has neither a SIDE-EFFECT nor METHODS then we consider the
PROCEDURE (and the TASK) simplex:

Inquiry:
Consider root to be the PROCEDURE to be considered next
if (get—-abox-slot dm::side-effect)
or (get—-abox-slot dm::METHODs)
then return NIL ;7 not simplex
else return TRUE ;; simplex, no side-effect nor METHODs

By considering each PROCEDURE (each TASK) on its own, rather than the entire list at
once, we can obtain a heterogeneous structure in which conjunction and separation are

interleaved. In the next example, the side-effect separates the first step from the final two
steps. The latter are again conjoined:

To save a document under a different name, select the Save As command from the File menu. The

Save As ... dialogue box appears. Provide a file name by entering the file name in the File name
box and click the OK button.

We can take a similar approach for disjunction. As we pointed out above, the possibility
for disjunction arises when a PROCEDURE specifies several METHODs as members of its
METHODS’ METHOD-LIST. Each of these METHODs present an alternative way of
obtaining the PROCEDURE’s GOAL. However, like in the case of conjunction, we should
be more specific about when disjunction would indeed be natural, and when we should
keep things separated.

By its definition in the Domain Model a METHOD must have a non-empty SUBSTEPS
field, and may specify a CONSTRAINT and/or a PRECONDITION. A CONSTRAINT is
of type OPERATING-SYSTEM, Ilike “Windows” in the examples above. A
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PRECONDITION is a PROCEDURE that should be executed before the METHOD’s
SUBSTEPS can be carried out.

Again, we propose a simplicity measure. We should only insert a disjunction (realised
later as an “or”’) between METHODs if each METHOD is simplex, i.e. it does not specify a
CONSTRAINT nor a PRECONDITION. However, a simplicity measure in the case of
disjunction is a bit more complex than it was for conjunction. The uncomplicated situation
is that the entire list consists of METHODs none of which specify a CONSTRAINT or
PRECONDITION. In that case we can straightforwardly allow for disjunction.

However, the situation becomes more complicated in case no METHODs in the list
specify a PRECONDITION but all METHODs do specify a CONSTRAINT. In that case
we should keep separated METHODs that have different CONSTRAINTS, but we can put a
disjunction between METHODs that follow upon one another and which have identical
CONSTRAINTSs. For example, the simple text below could be specified using one
PROCEDURE and three METHODs. Two of these METHODs would specify alternative
ways of saving a document under a different name when using Windows, whereas the third
METHOD would specify the step needed to achieve that same GOAL under Dos.

To save a document under a different name:
Windows: Select Save As ... from the File menu or click the Save As... icon on the toolbar
Dos: Select Save As... from the File menu.

We provide the following formal specification for deciding to include disjunction into
the text plan. To begin with, what we are dealing with METHODs (and their SUBSTEPS)
that are specified as members of a METHOD-LIST. In text planning a METHOD
corresponds to an INSTRUCTION, and the METHOD-LIST being the value of the
PROCEDURE’s METHODS field corresponds to TASK-INSTRUCTIONS in a way
similar to the INSTRUCTION-TASKS construction above. The relevant systems are shown
in Figure 5.

Again, instead of immediately introducing a TASK-INSTRUCTIONS node in the
system TASK-INSTRUCTIONS-COMPLEXITY we introduce only the abstract feature
More-Instructions and let that feature be an entry condition to an other system TASK-
INSTRUCTIONS-AGGREGATION where we decide about disjoinability.

System:
More-Instructions -
(more-disjoined-instructions
insert DISJOINED-TASK-INSTRUCTIONS
preselect DISJOINED-TASK-INSTRUCTIONS INSTRUCTIONS
orderatend DISJOINED-TASK-INSTRUCTIONS
)
(more—separate—-instructions
insert SEPARATE-TASK-INSTRUCTIONS
preselect SEPARATE-TASK-INSTRUCTIONS INSTRUCTIONS
orderatend SEPARATE-TASK-INSTRUCTIONS
)
Chooser:

Choose more-disjoined-instructions if disjoinable
else choose more-separated-instructions
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Inquiry:
;; 1f we are at the beginning of a new METHOD-LIST then
;; current-constraint must be reset to nil.

Consider the root to be the METHOD to be considered next
if the entire list contains METHODS that are simplex

then
return TRUE ;; can insert disjunction
else
if (equal (get-abox-slot DM::constraint)
(current-constraint))
then return TRUE
else current-constraint = (get-abox-slot DM::constraint)
return NIL
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Figure 5: Systemic region focusing on INSTRUCTION

Because disjunction and conjunction act on different text structure elements, namely
TASK-INSTRUCTIONS  respectively INSTRUCTION-TASKS, we can obtain
conjunctions within disjunctions (since each METHOD defined SUBSTEPS that introduce
one or more *-INSTRUCTION-TASKS nodes). For example:
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To save a document:
Windows: Open the File menu and select the Save command or click the Save icon on the
toolbar.

Concluding this section, we should make some final remarks. To begin with, the
inquiries underlying our decisions whether to introduce conjunction or disjunction are
oblivious to any restrictions on the number of elements that could be combined this way. If
we want to impose such a limit, we could do so by for example using a counter keeping
track of the elements already conjoined or disjoined.

Furthermore, when planning sentences, the sentence planner should inspect the text plan
to determine whether a sentence should be planned including a coordinated structure.

Finally, because we extend the systems dealing with the complexity of lists rather than
INSTRUCTION-TYPE or TASK-TYPE, the first node in the text plan corresponding to list
structure will never indicate disjunction or conjunction.

This last point is important for the discussion in the next section. There we consider the
introduction of nodes into the text plan which indicate discourse relations like RST-
MEANS or RST-PURPOSE. The approach builds forth on our discussion above --in
particular, the first node corresponding to a METHOD-LIST (i.e., the first TASK-
INSTRUCTIONS node) will come to signify whether a discourse relation should be used
later in aggregation, and if so which relation.

3.1.3 Aggregation using discourse relations

Conjunction and disjunction hold between text structure elements that are of the same type,
namely TASKs respectively INSTRUCTIONS. The discourse relations RST-PURPOSE and
RST-MEANS are between text structure elements that are of different types. Both discourse
relations can be used, under certain restrictions, to couple a TASK to an INSTRUCTION.

3.1.3.1 Discourse relations in the text plan

In the text plan, a TASK is related to an INSTRUCTION by means of a TASK-
INSTRUCTIONS node, as shown in Figure 2 repeated here as Figure 6.
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Figure 6: TASK, TASK-INSTRUCTIONS, INSTRUCTION-TASKS
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The TASK-INSTRUCTIONS node corresponds to the METHOD-LIST that fills the
METHODS slot of the PROCEDURE to which the TASK corresponds. We will use this
node to signify explictly the discourse relation that is to hold between the TASK and an
INSTRUCTION.” We already saw in Figure 3 (repeated here as Figure 7) that the first
TASK-INSTRUCTIONS would get inserted in the TASK-TYPE system, depending on
whether the underlying PROCEDURE has a filled METHODS field or not.

| i Systemic resource graph from features
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Figure 7: Systemic region graph focusing on TASK

Instead of directly inserting a TASK-INSTRUCTIONS node in the TASK-TYPE
system, we propose to apply a similar construction here as we employed above, namely
deferring the decision for insertion of a particular type of TASK-INSTRUCTIONS node to
a different system to which the feature with-instructions acts as entry condition.

Hence, the TASK-TYPE system should first of all be altered into the following:

% More specifically, the TASK-INSTRUCTIONS node that connects TASK to its INSTRUCTION(s)
corresponds to the first METHOD in the METHOD-LIST. As we discussed in the previous section,
subsequent METHODs in that list will be placed under nodes that signify either disjunction or separation.
The very first TASK-INSTRUCTIONS node obviously does not signify any such relation.
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task: with-instructions
. Scours

without-instructions

Figure 8: Modified TASK-TYPE system

Subsequently, we specify the system TASK-INSTRUCTION-DISCOURSE-
RELATIONS where we decide whether a TASK and its INSTRUCTION(s) should be
explicitly related through a discourse relation, and if so, which relation. For each discourse
relation we want to be able to distinguish, there is a choice in the system. Each discourse
relation gets signified in the text plan by a node bearing its name, for example TI-RST-
MANNER or TI-RST-PURPOSE (with “TT” indicating aggregation of a TASK and its
INSTRUCTION(s)).

The decision to aggregate, and using what relation, depends on a number of factors: for
example, what type of full text we are going to generate (full text or using enumeration),
whether the TASK has one or more INSTRUCTIONS, what readership the text is intended
for.

For example, consider the following two text fragments. One fragment is formulated
using enumeration, the other fragment is running text.

Enumeration:
Add elements to the style.
1. Choose Element Properties. The Element Properties dialogue box appears.
2. Enter the offset of the multiline element in the Element Properties dialogue box and
select Add to add the element.

Running text:

Choose Element Properties to add elements to the style. The Element Properties dialogue box appears.
Enter the offset of the multiline element in the Element Properties dialogue box and select Add to
add the element.

In the case of running text there is no problem to aggregate the overall GOAL with the first
step to achieve that GOAL. If we would do the same in the case of enumeration, this would
look unnatural.

The system can be formally specified as follows:

System: [TASK-INSTRUCTIONS-DISCOURSE-RELATIONS]
with-instructions =

(ti-separate
insert TASK-INSTRUCTIONS
preselect TASK-INSTRUCTIONS INSTRUCTIONS
orderatend TASK-INSTRUCTIONS

)

(ti-means
insert TI-RST-MEANS
preselect TI-RST-MEANS INSTRUCTIONS
orderatend TI-RST-MEANS
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)

(ti-purpose
insert TI-RST-PURPOSE
preselect TI-RST-PURPOSE INSTRUCTIONS
orderatend TI-RST-PURPOSE

Because the discourse relations are indicated apart from (specifically, above)
conjunction and disjunction, we are able to plan an aggregation between a TASK and a
conjunction of the SUBSTEPS that the TASK’s INSTRUCTION specifies. This could for
example lead to the following running text:

To save a document, open the File menu and choose the Save command or click the Save icon in the
toolbar.

Once we arrive to sentence planning, aggregation of clauses (realising bits of content)
into more complex sentences should be done by the sentence planner inspecting the text
plan for information on what to do. Of interest in the context of this deliverable is the order
in which a discourse relation’s nucleus (TASK) and satellite (one or more
INSTRUCTIONS) should be planned to occur in a sentence. We turn to this issue in the
next section.

3.1.3.2 Relative ordering of nucleus and satellite in discourse relations

Each discourse relation, like RST-MEANS or RST-PURPOSE, has a nucleus and a
satellite. The nucleus is said to govern the satellite, with the satellite being dependent on the
nucleus in the sense as specified by the particular discourse relation involved. Intuitively,
one might say that the relation explains the way a satellite contributes to the meaning of the
overall construction.

Prototypically, in an RST-MEANS relation the nucleus precedes the satellite, whereas in
RST-PURPOSE the situation is the other way round with the satellite preceeding the
nucleus. And yet, in the case of these two relations the nucleus and satellite can
theoretically occur in any possible order with the whole construction being -in principle-
linguistically correct.

For example, consider the following texts. In the first text, the ordering
METHODAGOAL is used together with RST-Purpose, in the second text, the ordering
GOALMMETHOD:s is used together with RST-Means.

1. Choose Element Properties to add elements to the style.’

2. In the Element Properties dialog box, enter the offset of the multiline element.
3. You need to choose Add to add the element.

4. Repeat these steps to define another element.*

5. Choose OK to save the style of the multiline element and to exit the Element Properties dialog box.

1. Add elements to the style by choosing Element Properties

3 The choose action doesn’t automatically cause elements to be added. Rather, it enables elements to be added
by achieving a precondition, that of opening the Element Properties dialog box.

* Clearly, this is a ‘conditional’ or ‘optional’ GOAL. To paraphrase: If you wish to define another element,
repeat these steps. The current domain model does not allow for such a possibility.
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2. In the Element Properties dialog box, it is necessary to enter the offset of the multiline element.
3. Add the element by choosing Add.
6. Define another element by repeating these steps .’

7. Save the style of the multiline element and to exit the Element Properties dialog box by choosing
OK.

As a matter of fact, the proper ordering of nucleus and satellite in the sentence may
depend on a number of factors that can lead to overriding the prototypical order. We choose
not to represent any ordering constraints within the text plan itself, but rather, delegate this
issue to the sentence planner. When constructing sentence plans that involve aggregation
using RST-MEANS or RST-PURPOSE, the sentence planner should take into account at
least the following factors:

* Heavy versus light constituents: Grammatically, the preference is to place heavy
constituents at the end. In our case, a heavy constituent would be an INSTRUCTION
that is a conjunction of TASKS, acting as satellite.

* Consistency: Textually, there is a preference to be consist in the ordering of
nucleus/satellite across sentences, at least within one and the same textual segment.

* Readership: At least in the absence of heavy constituents, the level of expertise of the
intended readership can be used to impose a preferred order (TEXS2). A novice appears
to prefer the order INSTRUCTION (satellite) - TASK (nucleus), whereas experts seem
to favour the order TASK (nucleus) - INSTRUCTIONS (satellite).

The issue of relative ordering of GOAL and METHOD in instructional texts was
previously addressed by Delin, Hartley and Scott (1996). Within a corpus of instructions in
English and French, they undertook a contrastive analysis of expressions within the same
sentence of the semantic relations of GENERATION and ENABLEMENT. These relations
hold between pairs of actions in a task. Generation holds between two actions O and 3 if the
performance of o automatically brings about the occurrence of (3. Enablement holds
between a and [ if the execution of a brings about a set of conditions that are necessary,
but not necessarily sufficient for the subsequent performance of [3; in other words, O is a
precondition for [3.

In the expression of generation, there was a tendency in both languages to place the user
GOAL (the generated action) before the METHOD (the generating action).

In the expression of enablement, the preferred ordering of the actions in the text
respected their temporal sequence in the world—the ‘iconic’ ordering. However, there were
many occurrences of non-iconic ordering, which appeared to be chosen for one of two
reasons:

* To present to the user the purpose of performing the GOAL action, and to indicate to
the user that the goal named in the purpose expression (to DO, in order to DO) is either
optional or contrastive (cf. Van der Linden and Martin (1995)), or that it has global

scope over a range of actions to be related subsequently (cf. Thompson (1985));
or

* To prevent the user from making a mistake by performing a task prematurely (before
DOing).

> Clearly, this is a ‘conditional” or ‘optional’ GOAL. To paraphrase: If you wish to define another element,
repeat these steps. The current domain model does not allow for such a possibility.
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The authors observed in French a combination of ordering and phrasing that seemed to
be unacceptable in English, in which the enabled action was presented first as a command
and the enabling action second by means of an apres avoir phrase. They were not able to
suggest why this ordering would be acceptable in French and acknowledged that more data
was required in order to tell if its appearance reflected a general tendency. They also
acknowledged that constraints other than local and global purpose, contrast and optionality
were likely to affect ordering. Considerations of textual well-formedness such as continuity
of reference, closeness of anaphoric links, etc. also exert an influence.

The relative GOAL and METHOD ordering thus remains an open issue and a challenge
for text and sentence planning in AGILE. Given that our corpus analysis (the CORP
deliverable of AGILE WP 3) did not distinguish between enablement and generation, we do
not have the kind of data that Delin, Hartley and Scott (1996) discuss. It therefore remains
to be seen whether can perform some additional corpus analysis in order to substantiate a
more general control mechanism for the GOAL and METHOD ordering with the AGILE
system.

3.1.4 Granularity

Under the general denomination of aggregation we can also share granularity. In our case,
we can consider the integration of a METHOD’s CONSTRAINT directly into the sentence
that realises the METHOD’s SUBSTEPS, as in the following examples:

In Windows, choose Multiline style from the Object Properties toolbar.
In DOS or UNIX, choose Multiline style from the Data menu.

Using Windows, you should choose Multiline style from the Object Properties toolbar.
Using DOS or UNIX, you should choose Multiline style from the Data menu.

If you are using Windows, you should choose Multiline style from the Object Properties toolbar.
If you are using DOS or UNIX, you should choose Multiline style from the Data menu.

Here, we consider a CONSTRAINT to identify a specific context of application, and as
such can be realised as a location (as in the first pair of sentences), as an instrument (as in
the second pair of sentences), or by a conditional construction (as in the third pair of
sentences). All three realisations are consistent with the intuitions behind the
CONSTRAINT concept as it is formulated in the Domain Model.

In the text plan we can already plan the inclusion of the CONSTRAINT, like in the
examples above. We can do so by differentiating different types of CONSTRAINT-nodes
in the text plan, in a similar vein as we did above. Here, we will use SEPARATE-
CONSTRAINT, LOCATION-CONSTRAINT, MEANS-CONSTRAINT and
CONDITION-CONSTRAINT. The reason for making the differentiation already during
text planning rather than deferring to the stage of sentence planning, is that the decision for
one type over the other depends on

* the overall type of text we are planning, i.e. running text or using enumeration; and,
*  what style the text is to be generated in.

In case the text is to be realised in imperative voice using enumeration, then the only
natural choice appears to be to use SEPARATE-CONSTRAINT, which keeps the
CONSTRAINT separate from the sentence realising the METHOD’s SUBSTEPS. The
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reason being that there is no explicit mention of the hearer (ruling out “If you are using
Windows, choose ...”). Hence, in this case the text planner should insert SEPARATE-
CONSTRAINT into the text plan.

On the other hand, if we are to generate a running text, we can use LOCATION-
CONSTRAINT if the imperative voice is used, or either MEANS-CONSTRAINT or
CONDITION-CONSTRAINT, depending on the grammatical constructions available in a
given language, if active voice is used. For example, the MEANS-CONSTRAINT
realisation is not available in Czech, but is possible in Russian.

Upon encountering a constraint under one of these nodes in the text plan, the sentence
planner should act as follows:

 SEPARATE-CONSTRAINT: A separate sentence-plan should be created, realising the
CONSTRAINT. This is the way it is done already in the TSM for the intermediate
prototype. The corresponding SPL contains the following statement:
(P / object :NAME gui-windows)

*  LOCATION-CONSTRAINT becomes a Spatial-Locating Circumstance within the
clause realising the TASK. It is reflected by the following bit of SPL code:
:spatial-locating (P / object :NAME gui-windows)

* MEANS-CONSTRAINT is realised by the Range of RST-Means, where the Domain
corresponds to the TASK. The following bit of SPL code reflects this:
(RST / RST-Means Manner
:Domain ..
:Range (Range / dispositive-material-action
:lex use :ACTEE (P / object :NAME gui-windows)))
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CONDITION-CONSTRAINT is realised by the Domain of RST-Logical-Condition,
where the Range corresponds to the TASK. The following bit of SPL code reflects this:
(RST / RST-Logical-Condition
:Domain (Range / dispositive-material-action
:lex use :ACTEE (P / object :NAME gui-windows)
:Range))

3.2 Explicit discourse markers for sequencing

In this section, we focus on the realisations of the SEQUENCE relation in procedural
instructions. We are concerned with other means reflecting SEQUENCE than the
straightforward ordering of discourse units. What we are especially concerned with is the
realisation of content in lists vs. in running text and the accompanying layout decisions, the
use of explicit signals for SEQUENCE relations, and the decision whether to use numbering
vs. linguistic sequence markers. By linguistic sequence markers we mean expressions like
first, second, third, now, then, finally, lastly (and their Bulgarian, Czech and Russian
counterparts).

We first provide a discussion, which aims to substantiate the need for explicit signalling
of SEQUENCE in procedural instructions. We also discuss alternative ways of realising
relations between pieces of content, using the means distinguished above. Finally, we
provide a formalisation of the approach proposed here.

3.2.1 The need for explicit sequence markers in AGILE texts

A list of SUBSTEPS in an A-box is assumed to be ordered in accordance with the order of
executing the SUBSTEPS to achieve a given GOAL. It is natural for instructions in
procedural style to obey this order when the SUBSTEPS are realised. This is what the
current text planner does, and also in the final prototype, the A-box ordering of SUBSTEPS
will be obeyed in the realised texts.

When the order of instructions accords with the temporal order of carrying out these
instructions, there does not seem much need for explicitly indicating the sequential order.
Indeed, it is not difficult to interpret the following two short texts:

To save a document under a different name
1. Select the Save As command from the File menu.
2. Enter the file name in the File name box.
3. Click the OK button.

To save a document under a different name, select the Save command from the File menu, enter the
file name in the File name box, and click the OK button.

The first of these two texts demonstrates a numbered list realisation of step-by-step
procedural instructions. In this case, the overt numbering and layout together make the
sequencing so clear that additional linguistic sequence markers would be inappropriate, as
the following example demonstrates.
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To save a document under a different name
1. First select the Save As command from the File menu.
2. Now enter the file name in the File name box.
3. Finally, click the OK button.

On the other hand, inserting explicit sequence markers into the running-text realisation
of the same step-by-step procedural instructions shown above, is much less superfluous. In
fact, a reader can find it useful to orient herself:

To save a document under a different name, first select the Save command from the File menu. Then
enter the file name in the File name box. Finally click the OK button.

VS.

To save a document under a different name, first select the Save command from the File menu. Then
enter the file name in the File name box, and finally, click the OK button.

VS.

To save a document under a different name, first select the Save command from the File menu, then
enter the file name in the File name box, and finally click the OK button.

The running text seems more natural, and certainly is easier to process when sequences
are indicated explicitly by discourse markers. The discourse markers can be linguistic ones,
as above, or can again be numbers, resulting in "horizontal" list. Henceforth, we only
discuss the explicit marking of sequences in running texts by linguistic markers.

The more complex semi-running text below illustrates this even better. Two versions are
shown: one with numbering, the other with only linguistic sequence markers. We have used
abundant explicit sequence markers, which we underlined to make them easier to notice. If
none of the markers were present, the text would be quite unnatural and we believe also
difficult to process.

To create a multiline style

First open the Multiline Styles dialog box.
Windows Choose Multiline Style from the Object Properties toolbar or the Data menu.
DOS or UNIX Choose Multiline Style from the Data menu.

Now choose Element Properties to add elements to the style. The Element Properties dialog box
appears. First enter the offset of the multiline element in the Element Properties dialog box. Then
select Add to add the element. To define another element, repeat these steps.

Finally choose OK to save the style of the multiline element and to exit the Element Properties dialog
box.
To create a multiline style

1. Open the Multiline Styles dialog box.
Windows Choose Multiline Style from the Object Properties toolbar or the Data menu.
DOS or UNIX Choose Multiline Style from the Data menu.

2. Choose Element Properties to add elements to the style. The Element Properties dialog box_appears.
First enter the offset of the multiline element in the Element Properties dialog box. Then select
Add to add the element. To define another element, repeat these steps.

3. Choose OK to save the style of the multiline element and to exit the Element Properties dialog box.

So far it may seem that explicit marking of sequences would be appropriate for running-
text instructions, and rather superfluous for numbered-list instructions. It is indeed the case
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tasks, namely drawing a line, then drawing an adjacent arc and then drawing another line.

This structure should also be reflected in the A-box specification of the text content. Let
us consider two example A-boxes shown in Figure 9 and Figure 10, which both model a
simplified content based on IMD-Text2. The content is simpler than that in the above text,
for the sake of brevity. The A-box in Figure 9 does not involve a hierarchical task structure,
as it contains simply a list of PROCEDURESs with no METHODs.

The A-box in Figure 9, in which the hierarchical structure of the task is not reflected,
and its straightforward clause-by-clause realisation:

To draw a line and arc combination polyline

1. Start the PLINE command.

2. Specify a line segment.

4. Switch to the Arc mode.

5. Specify the endpoint of the arc.

6. Return to Line mode.

7. Enter the distance of the line from the endpoint of the arc.

8. End the line and arc combination polyline.
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Figure 9: A-box not reflecting hierarchical task structure

Now compare the A-box in Figure 10, which models the hierarchical task structure by
containing the PROCEDUREs with GOALSs corresponding to "draw a line segment" and
"draw an arc segment", and by containing METHODs for achieving these GOALs.

The A-box in Figure 10 would be straightforwardly realised clause-by-clause as follows:

To draw a line and arc combination polyline
. Draw a line segment.

. Start the PLINE command.

. Specify the start point of the line segment.

. Specify the endpoint of the line segment.

. Draw an arc segment.

. Switch to Arc mode.

. Specify the endpoint of the arc.

. Draw a line segment.

O 00 1 O W B~ W N =

. Return to Line mode.
10. Enter the distance of the line from the endpoint of the arc.
11. End the polyline.
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To draw a line and arc combination polyline
1. Draw a line segment.

First start the PLINE command using one of these METHOD:s:

Windows: From the Polyline flyout on the Draw toolbar, choose Polyline.

DOS and UNIX: From the Draw menu, choose Polyline.

Then specify the start point of the line segment and the endpoint of the line segment.
2. Draw an arc segment.

First switch to Arc mode by entering a. The Arc mode confirmation dialog box appears. Select
OK.
Then specify the endpoint of the arc.

3. Draw another line segment.

First return to Line mode by entering 1. The Line mode confirmation dialog box appears. Select
OK.
Then enter the distance and angle of the line in relation to the endpoint of the arc.

4. Press Return to end the polyline.

In this example, we have used a numbered list for the top-level GOALs, and use explicit
sequence markers for the lower-level GOALSs, along with aggregation:

Another possibility is to use explicit sequence markers for the top-level GOALSs within
the list of SUBSTEPS, and a numbered list of the lower-level SUBSTEPS (the numbering
re-sets within each sub-list). Such a version is illustrated below:

To draw a line and arc combination polyline
First draw a line segment.

1. Start the PLINE command using one of these METHODs:
Windows: From the Polyline flyout on the Draw toolbar, choose Polyline.
DOS and UNIX: From the Draw menu, choose Polyline.

2. Specify the start point of the line segment.
3. Specify the endpoint of the line segment.

Then draw an arc segment.

1. Enter a to switch to Arc mode. The Arc mode confirmation dialog box appears.
2. Select OK.
3. Specify the endpoint of the arc.

Then draw another line segment.

1. Enter 1 to return to Line mode. The Line mode confirmation dialog box appears.
2. Select OK.
3. Enter the distance and angle of the line in relation to the endpoint of the arc.

Finally, press Return to end the polyline.

It seems, for the text of this complexity, that both exemplified ways of realising the
SEQUENCES and EMBEDDINGS are sensible.

Assuming the hierarchical structure of a task is reflected in the hierarchical structure of
an A-box, it is straightforward to generate a text with the corresponding hierarchical
structure. This is in fact more straightforward than generating a text in which the
hierarchical structure is neglected. In order to achieve the latter, some parts of the A-box
content need to be skipped, i.e. not explicitly realised. On the other hand, when we want the
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hierarchical structure of the task to be reflected in accordance to the A-box, we only have to
ensure that all A-box GOALs are realised, and we have to hierarchically structure the text.

Another example, which demonstrates the usefulness of providing such explicit
hierarchical structuring in addition to explicit marking of SEQUENCES, is the following text
based on IMD-Text4:

To specify the properties of a multiline and save the style

From the Data menu, choose Multiline Style. The Multiline Style dialog box appears.
First specify the properties of the multiline.

1. Choose Multiline Properties. The Multiline Properties dialog box appears.

2. Select Display Joints to display a line at the vertices of the multiline.

3. Under Caps, select a line or an arc for the startpoint of the multiline. Then select a line or an arc for the
endpoint of the multiline. Lastly, enter an angle.

4. Under Fill, select On to display a background color.

5. Choose Color. Then select the background fill color from the Select Color dialog box.

6. Choose OK to return to the Multiline Styles dialog box. The Multiline Properties dialog box disappears.
Now save the style.

1. Under Name, enter the name of the style.

2. Under Description, enter a description.

3. Select Add to add the style to the drawing.

4. Select Save to save the style to a file.

5. Choose OK and close the dialog box.’

Here, we have used explicit sequence markers only for those top-level GOALs within the
list of SUBSTEPS, which themselves contain further SUBSTEPS. These lower-level
SUBSTEPS are again realised by numbered lists (again we re-set the numbering within
each sub-list, esp. because each sub-list is itself quite long), and we use running text within
these SUBSTEPS (cf. 1, 3, 5 and 6 under "first"). Note that we use explicit sequence
markers within the "embedded" running texts as well (cf. 3 and 5 under "first").

Before we conclude this discussion of various combinations of layout, explicit marking
of SEQUENCEs and EMBEDDING and running text vs. numbered lists, let us point out once
more that it is indeed necessary to combine these aspects. Consider the following example,
containing four versions of the same procedural instructions:

To create a multiline style, first open the Multiline Styles dialog box. If you are using Windows,
choose Multiline Style from the Object Properties toolbar or the Data menu. If you are using DOS
or UNIX, choose Multiline Style from the Data menu. Now choose Element Properties to add
elements to the style. The Element Properties dialog box_appears. First enter the offset of the
multiline element in the Element Properties dialog box. Then select Add to add the element. To
define another element, repeat these steps. Finally, choose OK to save the style of the multiline
element and to exit the Element Properties dialog box.

VS.

% The closure is an automatic consequence of choosing OK. A less ambiguous wording would be Choose OK
to close the dialog box. An unambiguous wording would be Close the dialog box by choosing OK.
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To create a multiline style

1. Open the Multiline Styles dialog box.
Windows Choose Multiline Style from the Object Properties toolbar or the Data menu.
DOS or UNIX Choose Multiline Style from the Data menu.

2. Choose Element Properties to add elements to the style.
The Element Properties dialog box_appears.

3. Enter the offset of the multiline element in the Element Properties dialog box.
4. Select Add to add the element.
5. To define another element, repeat these steps.

6. Choose OK to save the style of the multiline element and to exit the Element Properties dialog box.

VS.

To create a multiline style

First open the Multiline Styles dialog box.
Windows Choose Multiline Style from the Object Properties toolbar or the Data menu.
DOS or UNIX Choose Multiline Style from the Data menu.

Now add elements to the style.
1. Choose Element Properties. The Element Properties dialog box_appears.
2 Enter the offset of the multiline element in the Element Properties dialog box.
3 Select Add to add the element.
4. To define another element, repeat these steps.

Finally, choose OK to save the style of the multiline element and to exit the Element Properties dialog
box.

VS.

To create a multiline style

1. Open the Multiline Styles dialog box.
Windows Choose Multiline Style from the Object Properties toolbar or the Data menu.
DOS or UNIX Choose Multiline Style from the Data menu.

2. Add elements to the style. First choose Element Properties. The Element Properties dialog box
appears. Then enter the offset of the multiline element in the Element Properties dialog box.
Finally select Add to add the element. To define another element, repeat these steps.

3. Choose OK to save the style of the multiline element and to exit the Element Properties dialog box.

The first, fully running text is obviously a bad one, as it blurs everything together.

The second, fully numbered list, in our opinion, obscures the hierarchical structure of the
task. As a consequence of this, the reader does not know which steps she should repeat to
define another element. Clearly, she does not have to start from step 1. But where the
iteration begins she does not know, because no sequence of steps stands out from the rest
(we believe it is steps 2-4 that need to be repeated).

The third and fourth versions exercise, we think, a suitable combination of layout,
explicit marking of SEQUENCEs and EMBEDDING and running text vs. numbered lists.

3.2.2 Formalisation

In the preceding section, we have made a number of observations concerning layout,
explicit marking of SEQUENCEs and EMBEDDING and running text vs. numbered lists.
Following upon the discussion, we present here a specification of the functionality that is
needed in the TSM in order to handle explicit marking of SEQUENCE, ALTERNATIVE and
EMBEDDING relations in texts, which realise the related pieces in separate sentences.
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Our main conclusion was that a combination of layout, running text vs. numbered lists,
and explicit marking of relations as realisation means within a procedural text is desirable,
rather than a fixed use of one way of realising content relations. This means that the choice
of means to realise a particular piece of content depends not only on the content per se, but
also on the realisation of other pieces.

We also observed that the texts appear more natural when their structure somehow
explicitly reflects the hierarchical structure of the content (if/as captured in the A-box).
When we want the hierarchical structure of the task to be reflected in accordance to the A-
box, we have to ensure the following:

* that all A-box GOALSs are realised (this is nothing new for the TSM)

* that a suitable combination of layout, running text vs. numbered lists, and explicit
marking of relations are utilised

The formalisation splits into two branches. The first concerns Tasks realised by separate
sentences. The second concerns Task realised by clauses within a complex sentence, due to
aggregation.

3.2.2.1 Explicit sequence markers with separate tasks

When a separate task is being inserted, which happens in the system INSTRUCTION-TASKS-
AGGREGATION, it has to be decided whether to use running text or a list.

System: SEPARATE-INSTRUCTION-TASKS—-SEQUENCE:
More-Separate—-Tasks =

[Running-Tasks]
[List—-Tasks]

The choice between list and running text is to a great degree determined by the genre of
step-by-step instructions in procedural style. As we saw above, an entirely running text is
out of question. At least the top-level of instructions (i.e. the realisations of the top-level
GOALs in a PROCEDURE-Iists under METHODs of the GOAL at the root of the A-box,
see Figure 11), are thus realised as a list. As for the lower-levels, we saw above that a
numbered list of instructions throughout the whole text is bad. Therefore, some decisions
on the basis of the complexity of the content being expressed need to be made.

| i/ Model Display Window

GOAL user-action
SIDE-EFFECT user-event
METHODS method-list a2

REST method-list

ﬁﬁiiiiiiiiiiiiiiiiiiiiiiiiiﬁﬁ

Figure 11: Top-level SUBSTEPS in A-box
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We propose to realise simple content at lower-than-top levels as running text, and any
complex content as a list. Thus, if the lower-level SUBSTEPS do not include alternative
METHODs with Constraints, or further embedded complex SUBSTEPS, we realise them as
a running text. These conditions are similar to those on aggregation (cf. section 3.1). The
chooser below reflects these considerations:

Chooser: SEPARATE-INSTRUCTION-TASKS-SEQUENCE-CHOOSER:

If at the top-level in A-box,
Then choose List-Tasks
Else

If at any lower level in A-box,
and the SUBSTEPS are simplex
and have no Constraints,

Then choose Running-Tasks
Else choose List-Tasks

In addition, it is suitable to include explicit linguistic sequence markers in the lower-level
running text.

Let us now turn to the decision whether to mark a SEQUENCE relation explicitly or not.
This decision can also be made when a separate task is being inserted. Moreover, we noted
above that there is some interplay between the choice of list vs. running text and explicit
SEQUENCE marking. The top-level of instructions always uses explicit markers, for the
lower levels we make a more elaborate decision. So, we have two systems making this
decision, specified as follows:

System: SEPARATE-LIST-INSTRUCTION-TASKS—-SEQUENCE-MARKING:
More-Separate—Tasks aNp List-Tasks =

[Explicit-Marking-Tasks]
[No-Marking-Tasks]

System: SEPARATE-RUNNING-INSTRUCTION-TASKS—-SEQUENCE-MARKING:
More-Separate—-Tasks aND Running-Tasks =2

[Explicit-Marking-Tasks]
[No-Marking-Tasks]

It appears typical for the genre of step-by-step instructions in procedural style that in the
top-level instructions explicit marking of SEQUENCEs is employed. At the second level of
instructions, it seems sensible to use explicit sequence marking if there are at least two
SUBSTEPS. At any lower level of embedding, we propose to use no marking of
SEQUENCES in lists, and explicit marking of SEQUENCESs in running texts, where it again
seems sensible to use explicit sequence marking if there are at least two SUBSTEPS and.
These criteria are captured in the choosers specified below.
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Chooser: SEPARATE-LIST-INSTRUCTION-TASKS-SEQUENCE-MARKING-CHOOSER:

If at the top-level in A-box,
Then choose Explicit-Marking-Tasks

Else

If at the second-level in A-box,
Then

If there are more than 1 SUBSTEPS
Then choose Explicit-Marking-Tasks
Else choose No-Marking-Tasks

Else choose No-Marking-Tasks

Chooser: SEPARATE-RUNNING-INSTRUCTION-TASKS-SEQUENCE-MARKING-CHOOSER:

If there are more than 1 SUBSTEPS
Then choose Explicit-Marking-Tasks
Else choose No-Marking-Tasks

Note that the top-level is always realised by a list. Any further embedded level can be a list
or a running text (if it contains only simplex SUBSTEPS with no alternative METHODs
distinguished by Constraints).

As for the realisation of explicit SEQUENCE marking, we have the following
observations:

* Inrunning text, linguistic markers rather than numbering are used.

* In a list, either numbering or linguistic markers can be used. We observed that when
explicitly reflecting SEQUENCEs, it suffices to use either numbering or linguistic
markers, i.e. there is no need to use explicit linguistic markers together with numbering.

These observations lead to the following systems:

System: RUNNING-INSTRUCTION-TASKS-SEQUENCE:
Running-Tasks anp Explicit-Marking-Tasks =

[Linguistic-Markers-Tasks]

System: LIST-INSTRUCTION-TASKS—-SEQUENCE:
List-Tasks and Explicit-Marking-Tasks =

[Number—-Markers—-Tasks]
[Linguistic-Markers-Tasks]

The decision whether to use a numbered list or a list with linguistic markers involves a
certain degree of freedom in balancing out the means when combining them to realise a
more complex content. This concerns in particular the content of the top-level SUBSTEPS,
especially when there are further lower levels of SUBSTEPS.

We propose to consider it a matter of stylistic choice, whether the top-level SUBSTEPS
are realised as a numbered list or using linguistic sequence markers. If we want to make this
stylistic decision automatically, as to relieve the user of this burden, it is possible to choose
between numbering and linguistic markers for the top level depending on how many top-
level SUBSTEPS there are. If there are few (say, up to three), linguistic markers seem a
natural choice. If there are more, it appears better to use numbering.
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The realisation of the second-level SUBSTEPS can then take a complementary form, in
order to avoid repetition. So, if the top-level uses linguistic markers, the second-level can
use numbered list. If the top-level uses numbered list, the second-level can use linguistic
markers.

We said above that any further lower levels of SUBSTEPS (i.e., the third embedded
level or more) would be realised as running text, and therefore without explicit markers,
unless they themselves include alternative METHODs with Constraints, and/or further
complex SUBSTEPS. If they do include alternative METHODs with Constraints, and/or
further complex SUBSTEPS, they would be realised by a list. In this case, we do not
include any explicit SEQUENCE markers. We only use indentation (which is to be inserted by
the sentence planner).

Chooser: LIST-INSTRUCTION-TASKS-SEQUENCE-CHOOSER:
If at the top-level in A-box,

Then
If there are at most three top-level PROCEDURESs,
Then choose Linguistic—-Markers-Tasks
Else choose Number-Markers-Tasks
Else
If at the second-level in A-box,
Then
If the top-level used Linguistic-Markers-Tasks,
Then choose Number-Markers-Tasks
Else choose Linguistic-Markers-Tasks
Else

if the SUBSTEPS are simplex
and have no METHODs with Constraints

Then choose Linguistic-Markers-Tasks
Else choose Number-Markers-Tasks

Obviously, the decisions concerning layout, explicit marking of relations and running
text vs. numbered lists need to be closely coupled with the decisions concerning
aggregation. We will return to this point in the implementation phase (TEXM3).

Last but not least, we should point out that the exact realisation of the SEQUENCE marker
depends on how many-th element of a list is being marked.

For numbered lists this does not seem to be an issue for the text planner, because
numbering of list elements is to be done through HTML annotation of the output (cf.
(TEXM2) and (TEXMI1) for examples). The HTML tags are then to be interpreted by a
suitable viewer, which takes care of the list numbering.

The linguistic markers, on the other hand, need to be realised by the lexico-grammar.
The SPL thus needs to contain sufficient information to enable the grammar to realise the
linguistic marker appropriate for a given element in a sequence. We propose to use the
following linguistic markers depending on how many elements there are in a sequence:

* English:
2 elements: First, Now
3 and more elements: First, (Then)”, Finally

7 (Then)+ means one or more occurrences of 'then'.
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* Bulgarian:
2 elements: IIvpso, Ceca
3 and more elements: ITvpeo, (ITocne)*, Haxpas

¢ (Czech:
2 elements: Nejdrive, Nyni
3 and more elements: Nejdrive, (Potom) ™, Nakonec

* Russian:
2 elements: Cuauana, 3amem (Teneps is also possible, but the context of its usage is
restricted to the here-and-now interaction style)
3 and more elements: Crauana , 3amem, Hakouey

Below we show an example SPL for the sentence "Then choose the color of the element"
in Czech:

(EXAMPLE
:NAME S10-IMP-simplified
: SET-NAME Cz-D1-T1-IMP
: TARGETFORM "Potom zvolte barvu elementu."
: LOGICALFORM
(Act / DM: :CHOOSE
:CONJUNCTIVE then
:SPEECHACT Imperative
:ACTEE
(Objl / DM::COLOR
:GENERALTIZED-POSSESSION-INVERSE
(C2 / DM::style-element)
)))

The statement " : CONJUNCTIVE then" reflects the choice of the linguistic marker. It is
a reference to the following SPL-macro:

(defspl-macro :conjunctive
((then

:conjunctive-relation—-g conjunctive
:conjunctive-relation-id (?rr / rhetorical-relation)
:process—-regulated—-g processregulated
:necessity—-g nonecessity
:sequence—-q notsequence
:time-relation—-g timerelation
:time-precedence-gq precedence
:time-precede-g subsequent
:time-separation-gq separate

:small-separation—g notsmall))

It is a matter of grammar development to implement the realisations of the linguistic
markers for SEQUENCEs. The respective pieces of SPL then need to be used for each
language. They are to be inserted by the Sentence planner.
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In order for the Sentence planner to be able to insert the appropriate piece of SPL, it
needs to know which element in a SEQUENCE is being realised and how many elements the
SEQUENCE has in total (only two or more). In order to keep track of the position of an
element within a sequence, we think we need to use a counter, which will be updated when
a separate Task with an explicit linguistic marker is inserted. Moreover, since there can be
explicitly marked sequences with linguistic markers at different levels of the hierarchical
structure in a text, we need a different counter for each such level.

The piece of SPL inserted by the Sentence planner for an element with an explicit
linguistic marker will then depend on the value of the appropriate counter. As noted above,
for an element in a numbered list, the Sentence planner needs to insert a particular HTML-
annotation, but no counters are necessary, because the numbering will be realised by the
HTML viewer.

3.2.2.2 Explicit sequence markers with conjoined tasks

This is a rudimentary attempt to interleave aggregation and explicit linguistic sequence
markers. The idea is to use explicit markers when there are more than two conjoined Tasks,
and not to use explicit markers for less than two.

System: AGGREGATED-INSTRUCTION-TASKS—-SEQUENCE
More—Conjoined-Tasks =2
[Conjoined-Tasks-With—-SegM]
[Conjoined-Tasks-Without-SegM]

Chooser: AGGREGATED-INSTRUCTION-TASKS—-SEQUENCE-CHOOSER

If there are more than two SUBSTEPS,
Then choose Conjoined-Tasks-With-SegM
Else choose Conjoined-Tasks-Without-SegM

The difference between conjunction with and without explicit markers will be reflected
in the SPL as follows:

» with explicit discourse marker we use RST-Sequence
» without explicit discourse marker we use Conjunction

Example SPLs for these two cases cases of realising the same content are shown below.
The first SPL yields the Czech realisation of "Add an element and save the style", the
second SPL should yield "Add an element, then save the style and then press OK".
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(EXAMPLE
: NAME 5-add-conj
: SET-NAME CONJ
: TARGETFORM "Pridejte element a ulozte styl"
: LOGICALFORM
(cl / conjunction
:Domain
(S1 / DM: :ADD
: SPEECHACT IMPERATIVE
:ACTEE (P1 / DM::style-element))

:Range
(S2 / DM: :SAVE
:SPEECHACT IMPERATIVE
:ACTEE (P1 / DM::STYLE))
))
(EXAMPLE

: NAME 5-add-RSTseq
: SET-NAME CONJ
:TARGETFORM "Pfidejte element, potom uloZte styl a potom stiknéte OK."
: LOGICALFORM
(cl / RST-SEQUENCE
:Domain
(S1 / DM: :ADD
:SPEECHACT IMPERATIVE
:ACTEE (P1 / DM::style—-element))
:Range
(c2 / RST-SEQUENCE
:Domain
(S2 / DM: :SAVE
:SPEECHACT IMPERATIVE
:ACTEE (Pl / DM::style))
:Range
(S3 / DM::PRESS
: SPEECHACT IMPERATIVE
:ACTEE (P2 / OBJECT :NAME gui-ok)))
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4. Summaries and basic steps instructions

In this section we consider a specific genre of instructions which differs from the full
instructions in procedural style that is directed to the widest readership. We consider here
an instruction genre which communicative goal is to address a specific readership — for
example, militaries, specialists, people in emergency situations, and so on. This genre is
motivated by the pragmatic goals of instructions - for example, the more lapidary style
lacking motivating goals is preferred for maintenance manuals intended for use by the US
military (expected to function in "robot mode"). In the case of CAD/CAM instructions it
can be useful for a more experienced readership. The source of modeling this style is an A-
box that describes the content for the full instructions. Having the content for the full
procedural text presented as an A-box we can abbreviate the content in some definite
manner when mapping it to the text plan structure. We describe the process as the
functional definition for the text types of abbreviated text we consider on the basis of our
A-box representations.

In the next section we model variants of the types of abbreviated texts following the
functional definitions that are possible following investigation of the level of detail
available to us in the A-box. The reason is the constrained research area, since we have no
possibilities to consider the genres from the point of view of motivation by pragmatic goals
of instructions. So it concerns the basic idea of presenting the content with a decreasing
level of detail at each successive stage of the abbreviation process. We hope that the
resulting types of texts could have their motivation, as we try to show.

4.1 Discussion of the text type

The main difference between this genre of instructions and the full procedural instructions
is that the former cannot be expressed in descriptive style. Following the terminology of the
AGILE project we call the full procedural instructions expressed in descriptive style, that is
based on narrative discourse and is realised in indicative mood - “impersonal style”. So the
abbreviated texts of instructions - summaries and basic steps instructions as we define them
later - are always based on narrative discourse and can be realised only in the main style of
procedural instructions — imperative (imperative mood). The obvious consequence of the
general style of the text type realisation is that it does not have descriptive style inclusions
like a side-effect that can be seen as additional, elaboration type information.

So the first level of abbreviation in our case is omitting side-effects, being descriptive
inclusions in full instructional texts. The resulting text will be the briefest version of a full
instructional text. This operation is valid only if the “with side-effect” variant of the content
presentation is chosen by the user. If the user opted for “without side-effect” then this
variant will be equal to the full procedural text. For example, in AGILE we consider two
possibilities to express the content of the following sentence:

(1) Choose Color.
Select the element's color from the Select Color dialog box. [without side-effect]

(2) Choose Color.
The Select Color dialog box appears. Select the element's color. [with side-effect]

And we have thus abbreviated variant for the second one:
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Choose Color.
Select the element's color.

The next step of abbreviation is related to the PRECONDITION slot of a METHOD. In
our model it is a normal concept of the full procedural style of type PROCEDURE (user
action). From the content point of view we can look at the METHODS slot of the
PRECONDITION as an elaboration, thus only keeping its (obligatory) GOAL slot as
indispensable elements of the content. So our second level of abbreviating of our A-boxes
content is neglecting all slots of a PRECONDITION except for the GOAL, while
considering the latter as the first methods of the main PROCEDURE in its METHODS slot.
So, for example, for the following beginning fragment of the Text1, pages 47-48:

To create a multiline style

First open the Multiline Styles dialog box using one of these methods:

Windows: From the Object Properties toolbar or the Data menu, choose Multiline Styles.
DOS and UNIX: From the Data menu, choose Multiline Styles.

1. Choose Element Properties to add elements to the style....

We’ll have:

To create a multiline style

First open the Multiline Styles dialog box.
1. Choose Element Properties to add elements to the style....

At the third level of the abbreviation process, we can focus on a single element of A-
box, since only one element is realised as a USER-ACTION. This is the GOAL slot of a
PROCEDURE. There are three possibilities for it to be included into the structure: to be the
GOAL of the main PROCEDURE slot, to be the goal of a PROCEDURE as a daughter
under METHOD, and to be a goal under an intermediate METHOD. Their syntactic
realisations in the text thus differ according to their position in the A-box structure under
different configuration concepts. We have three possibilities:

*  Summary (goal-oriented) instructions: We express only higher-level Goals in the A-box
and leave out the steps that lead to their accomplishment. This corresponds to realising
the higher-level nodes in the text plan hierarchy, in order to give an “abstract”
description of the content rather of the whole text of the procedure. This will present the
topic of the instructional text. If we do this for a collection of A-boxes, we obtain the
content of a complex instructional text. This type is considered and described in Section
7 as TOC.

* We can also consider another way of abbreviating the content of an A-box, namely
through summarization (essentially, the "why's without the how's"). We try to express
only higher level nodes in the A-box hierarchy in order to give a description of the
procedure that does not get down to specific steps. However, the IMD texts the
hierarchies are rather flat, so this seems to be a less sensible variant.

* Basic (step-oriented) instructions: We can express only the most embedded steps of
methods, thus omitting higher level goals — the ‘how’ without the ‘why’. An example of
the Basic steps type of the content presentation for the text 1 is as follows:
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To create a multiline style
Open the dialog box Multiline style.

Choose Element Properties.

[In the Element properties dialog box] Enter the offset of the multiline element.
Select Add.

Choose Color.

Select the element's color [from the Select Color dialog box].
Choose Linetype.

Select the element's linetype [from the Linetype dialog box].
Repeat these steps to define another element.

Choose OK.

The following stage of abbreviation process could be the abbreviation of Location slots
presented in the example in square brackets. Although this text style may not look very
plausible for a consumer user manual, since it lacks explanatory and motivating goals, it

can be appropriate for a quick reference sheet (cheat sheet).

For Russian we have an additional style of expressing a basic steps type of text that does
not exist in Bulgarian and Czech. It is the possibility to use the infinitive to express an
imperative. For this we could consider two styles of presenting the content. The first one
employs a modal with a ‘necessity’ meaning before the first step and then other steps

without the modal:

Yr100bI €O31aTH CTHIbL MYJILTHIHHIT
Heobxoaumo OTKpBITH Auanorosoe okHo Multiline style.
Hasxats kaonky Element Properties.
[B mnamorosom okHe Element properties] BBeCTH CMEIICHHE 3JIEMEHTA MYIbTHIHHAM.
HasxaTts kHOnKy Add.
HasxkaTs kaonky Color.
BriOparts nBet 3neMeHTa [B AuanorosoM okHe Select Color].
Haskats xHOIIKY Linetype.
BeiOpats Tun tuHEHE [B AuanoroBoM okHe Linetype].
[ToBropuTh 3TH mATH, YTOOBI OIPEACIUTD CIIE OJUH IICMEHT.

Hasxats kaonky OK.

The second type of presenting the content is by enumerating the steps without any modal

element:
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Yr100b1 €O31aTH CTHIIbL MYJILTHIMHIT
1. OtkpsiTh AHatorosoe okHo Multiline style.
2. Haxats xuonky Element Properties.
3. [B amanorosom okHe Element properties] BBECTH CMEIICHHE 3IEMEHTA MY IbTHIHHHH.
4. Haxatp kHOTIKY Add.
5. Hasxatp xHonky Color.
6. BeiOpats nBer smemMenTa [B auanorosoM okue Select Color].
7. Haxatp xHOTKY Linetype.
8. BoiOpars Tun muHUM [B quanoroBoM okee Linetype].
9. IToBTOpPHUTH 3TH IIArH, YTOOBI ONPEACIHTH EHIEC OAMH 3JICMEHT.

10. HasxaTs xHOIKY OK.

There also exists a fourth possibility — to combine procedures under different
configuration situations to get a reasonable text, but it needs elaborated reasoning which
cannot be achieved currently due to a lack of sufficient ontological detail in the DM. For
example:

To create a multiline style

1. Open the Multiline Styles dialog box.

2. Add elements to the style.

3. Enter the offset of the multiline element.

4. Add the element.

5. Repeat these steps to define another element.

6. Save the style of the multiline element and exit.

To draw line and arc combination polyline
Draw the first line segment.

Switch to the Arc mode.

Draw an arc segment.

Switch to the Line mode.

Draw the second line segment.

So in the next section we consider the formalisation of the Basic steps text plan
constructing from the A-box representation for the full instructional text.

4.2 Formalisation

Following upon the issues sketched in the preceding discussion, we present here a more
detailed discussion of the functionality that is needed in the TSM in order to handle
abbreviated procedural instructions.

We model three stages of the abbreviation process:

The first stage — omitting the side-effect. The first stage can be modelled by controlling
(setting) the parameter guiding the inserting of side-effects.
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The second stage — omitting the elaboration of a PRECONDITION’s slots.
The second stage is modelled by revising the PRECONDITION system. The algorithm is as
follows: insert a precondition, do identify it with the proper GOAL, but do not preselect the
PRECONDITION as a TASK. This leads to omitting whatever there is further to the
precondition (which is of type PROCEDURE and therefore has, besides GOAL, also a
SIDE-EFFECT slot and a METHODS slot).

The third stage (Summaries). Intuitively, we are focusing on the "why's" without the
"how's". This means that we only realise the METHODS of the topmost PROCEDURE
(which corresponds to the TITLE). For the embedded TASK, we omit the METHODS that
specify how they could be obtained. This can be obtained by splitting the systems dealing
with TASK and TASK-TITLE. We split the TASK-TITLE from TASK such that only with
TASK-TITLE we will insert TASK-INSTRUCTIONS, and not with TASK. This concerns
the TASK-TYPE system. For TASK, we only identify the TASK with the GOAL. We leave
the recursion of TASK-INSTRUCTIONS and INSTRUCTION-TASKS intact.

So we get, for Summaries:
SUMMARY-TASK-TITLE - GOAL of topmost PROCEDURE
SUMMARY-TASK-INSTRUCTIONS - METHODS of topmost PROCEDURE
SUMMARY-INSTRUCTION-TASKS - A METHOD's SUBSTEPS
SUMMARY-TASK « GOAL of a PROCEDURE
SUMMARY-PRECONDITION ~ PRECONDITION of a METHOD

The current systems ought to be straightforwardly adapted on the basis of these mapping
rules for the most part by cutting things out.

The third stage (Basic steps); For the basic steps we considered the intuitive picture of
the "how's without the why's". We again have a TASK-TITLE, we again need to do the
METHOD's of the topmost procedure, but now the picture becomes a bit more intricate.
For, what should we put into the cheat sheet? It might be the case that some methods are
simplex and others are not. And we want to display only the why's without the how's.

If we encounter a METHOD that is simplex and it has a PROCEDURE that is simplex
(in the procedure-list filling the SUBSTEPS slot) then we should insert the corresponding
TASK into the text plan as a basic step. On the other hand, if the PROCEDURE is not
simplex, then we should not insert a node in the text plan corresponding this particular
PROCEDURE but only insert a node in the text plan for its METHODS list. This will
ensure then that (eventually) only the TASKSs corresponding to the how's get inserted into
the text plan, without all the why's.

Hence we could get a text plan as follows:
CHEAT-SHEET-TASK-TITLE « GOAL of topmost PROCEDURE
CHEAT-SHEET-TASK-INSTRUCTIONS «~ METHODS of PROCEDURE
CHEAT-SHEET-INSTRUCTION-TASKS ~ SUBSTEPS of a METHOD
CHEAT-SHEET-TASK « a simplex PROCEDURE

We do not need to require simplicity of the METHODs themselves - if we want to
introduce a precondition (corresponding to a METHOD's PRECONDITION) we might still
want to do that. We would have to ensure (again) that only the how's get inserted, not the
why's. So, if the PRECONDITION is a simplex PROCEDURE, then insert a CHEAT-
SHEET-TASK and identify it with the PROCEDURE's GOAL. Otherwise, only insert a
CHEAT-SHEET-TASK-INSTRUCTIONS and let the simplex PROCEDURESs somewhere
under there be realised.

We described here the general solutions and actions needed to realise the abbreviated
styles. During implementation, we intend to test the obtained texts, and it may be necessary
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to formulate some additional differences in the concepts DM classification or some
additional elements for their grouping to achieve a coherent text.
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5. Descriptive texts

5.1 Introduction

Although the main style in instruction text is procedural, our text structuring oriented
corpus analysis of instructional texts other than the CAD/CAM manual revealed that
descriptive texts are very common in software manuals and other instructional texts in
Bulgarian, Czech and Russian (cf. the TEXS2 deliverable). Also the AutoCAD manual
contains text in this style. Another example is the Word Help bubbles that use a similar
style.

Descriptive fragments do not form distinct parts (or only sometimes do so). Their
specific character is that they are not obtained directly from operations upon the procedural
description content, but present some additional information in different fragments of the
instruction text (procedural, overviews). So, in principle, they are not mirror the procedural
part in their structure, as the full instructional texts do. Rather, they are characterized not
only by a different communicative goal, but also by the type of additional information like
warnings, encyclopaedic, or additional information about constrains the system has over the
user behaviour. For example,

Peoaxmop ne nozeonum Bam cozoams cmpoxu OGonvuieil Onutbl.
(Editor  will not allow you to create lines of bigger length.)

The additional information implies additional grammar means, for example, negation as
it is shown in 0.

We must model different styles basing on the content presented in the procedurally
oriented descriptions that are represented by our Domain Model and in the A-boxes. So we
are restricted to the type of texts which we call functional descriptive texts. As a side-effect
we obtain sentences that are the result of combining a special type of information (namely,
object functions) with a descriptive style, that is in indicative mood.

5.2 Functional descriptive text type

Basing ourselves on the A-boxes we can try to model functional descriptive texts. They can
be expressed by two types of descriptions:

* "Descriptions of what Goal(s) a Method (user-action) achieves"
* "Descriptions of what Goal(s) a GUI object (...) achieves".

Let us call the first type — UA functional descriptive text - User actions-based functional
descriptive text and OF functional descriptive text — Object function-based functional
descriptive text. We first consider the UA functional descriptive text.

There are two types of semantic situations depending on the character of the user’s
action. The first one contains situations where the user triggers the button and through that
action realises the function fixed for the object by the software design. There are realised by
sentences like these:
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Selecting Add in the Element Properties dialog box adds an element.

Choosing OK in the Element Properties dialog box saves the style of the multiline element and exits
the Element Properties dialog box.

These descriptions contain the location — tool bar or dialog box pointing out where the GUI
object is located. Stylistically they are badly composed as they attribute the achievement of
some goal (adds an element) to a nominalisation of a user action (Selecting...) that by itself
lacks the conceptual relation to the function realised as the Goal. But their stylistic fitness
depends on the syntactic form of realization. Syntactic variations with a nominalised user’s
action realised as a subject highlight this undesirable semantic lacuna:

37. En: {Selecting / the selection of} Add adds an element.

38. Ru:
*Haowcamue kHonku Add oobaesnsiem snemenm.
Selection button-Gen Add adds element-Acc.
39. Bu:

Hzbupanemo na knasuwa Add oobaest enemenm.
Selection-def of button-def Add add-3sg element.

40. Cz:
* Vybrdni/vybér tlacitka Add pridadvd element.
Selecting/selection button-gen Add adds  element

Or with the permissive modal:

41. En: {Selecting/the selection of} Add {enables/permits/allows} {you/the
user/someone/@ to add an element.

42. Ru:
* Haxcamue knHonku Add nossonssiem Bam oobasume s1emenm.
Selection button-Gen Add allows you to-add  element-Acc.
43, Bu:

H30upanemo na knasuma Add {Bu nozeonsiea oa dobasume /
Selection-def of button-def Add {you permit-3sg to add-2pl/

no3eonssa Ha nompebumelist 0a 006aeu} enemenm.

permit-3sg to user-def to add-3sg} element.
44. Cz:
*Vybrani/vybér tlacitka Add {dovoluje/umoziuje} ptiddvat elementy.

Selecting/selection button-gen Add {allows /enables} add-inf elements-acc

The sentences marked by *s are not valid stylistically in inflectional Slavic languages we
consider — Czech and Russian, but seems rather valid in English and Bulgarian.

However, the syntactic variations with a user’s action realised as manner (secondary
action) or as an instrument (nominalised) hide an undesirable semantic lacuna. The
sentences thus formed became valid in Russian and Czech:
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45. En: By selecting Add, you add an element.

46. Ru:
{Haowcamuem knonku  Add, Haowcae knonky Add, } Bei 0obaensieme snemenm.
Selection-Instr button-Gen Add you add element-
Acc.
47. Bu:
{C uzbupane na, Kamo uzbepeme)} knasuma Add Bue oobaesme ejleMenm.
By selection of button-def Add you add-2pl-imperf element.
48. Cz:
Vybranim tlacCitka Add (muzete) ptidavat elementy.

Selecting-ins button-gen Add can-2pl add-imperf-inf elements

Or with the possibility modal:

49. En: By selecting Add, {you/the user/someone} {can/may} add an element.

50. Ru:
{Haorcamuem xnonku Add, Haocae knonky Add, }
Selection-Instr button-Gen Add

But mooiceme 0obasumo snemenm.

you can add element-Acc.
51. Bu:

{C uzbupane na, Kamo uzbepeme)} knasuma Add

By selection of button-def Add

{Bue mooiceme  0a oobasume/ nompebumensim modce Oa 000a6uU  enreMeHm.

{you can-2pl to add-2pl / User-def can-3sg to add-3sg} element.
52. Cz:

Vybrdanim  tlacitka Add {miiZete / lze / je mozné} priddvat elementy.

Selecting-ins button-gen Add {can-2pl/ it is possible} add-imperf-inf elements

53. En:
By selecting Add, it is possible to add an element.

54. Ru:
{Haorcamuem xnonku Add, Haocae knonky Add, } mosxcno oobaeumse snemenm.
By selecting button-Acc Add possible add element-Acc.

55. Bu:
C usoupane na knasuwa Add mooice oa oobasume enemenm.
By selection of button-def Add can to add-2pl element.

56. Cz:
Vybranim  Add {je moZné /lze} pFidat element.
Selecting-ins Add {is possible} add-inf element-acc

In the last example for Slavic the Addressee is impossible, because this frame changes the
modal meaning of possibility to the modal meaning of permission, thus becomes inadequate
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for the situation. The fourth variant for the “same” content are two variants with medio
passive possible in Slavic, but impossible in English:

57. En: *By selecting Add, an element adds.

58. Ru:
Haowcamuem xunonku Add, oobasnsiemcs snemenm.
Selecting-ins button-gen Add add-3sg-refl element
59. Bu:

C uzbupane na knasuma Add ce oOobassi — enemenm.
By selection of button-def Add refl add-3sg element.

60. Cz:
Vybrdanim  tlacitka Add se priddvaji elementy.
Selecting-ins button-gen Add refl add-3pl elements
By selecting the Add button one adds elements.

The following variant in medio passive with the modal word is possible in Czech,
Bulgarian and Russian. There are some specifics of the distribution of the actualisation
features among the sentence elements, which we do not consider here.

61. Cz:
Vybrdanim  tlacitka Add se mohou priddvat elementy.
Selecting-ins button-gen Add refl can-3pl add-inf elements
62. Ru:
Haowcamuem xnonxu Add mo2ym Oobasisimbcst s1eMeHmbl.
Selecting-ins button-gen Add can-3pl add-inf-refl elements
63. Bu:

C usbupane na krasuwa Add mooce oa ce dobassim — ejemeHmu.
By selection of button-def Add can to refl add-3pl elements.

By selecting the Add button one can add elements.

The above examples have no additional information different from the procedural text.
So rather than to be considered a functional descriptions they could be considered as a
descriptive style of the procedural instruction. It is naturally true for the variants with
modals, which can also be considered as a style for overviews (see Chapter 6),
presupposing enumeration of homogeneous objects or actions. The representations with
modals in descriptive procedural text are valid rather in the situation of alternative (to add
the element if you consider it valid, and not add, if you have made mistakes in defining it).
For the impossible procedural fragments as far as for the situation of function description
the modal element contradicts to the prescriptive character of the procedural part and fixed
object’s function in functional descriptive text and in both cases seem to be clumsy and
unnatural. It is strange to use the modal of possibility in the situation when it is the only one
possibility:
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64. En: By choosing Multiline Style {you/the user/someone} {can/may} open the
Multiline Style dialog box.

65. Ru:
{Haorcamuem xnonku Multiline Style, Haowcas xnonky Multiline Style, }
By selecting button-Acc Multiline Style

MOJICHO omkpweime ouanoeosoe okno Multiline Style.
it-1s-possible to-open dialog box Multiline Style.
66. Bu:
C  usoupane na xnasuma Multiline Style {Bue/nompeoumensam} mooice oa
By selection of button-def Multiline Style {you/the user} can to

{omeopume/omeopu} ouanoeosus npozopey Multiline Style.
{open-2pl/open-3sg} dialogue  box Multiline Style.

67. Cz:
Vybrdanim  tlacitka Multiline Style {miuiZete / Ize / je mozné }
Selecting-ins button-gen Multiline Style {can-2pl/ it is possible}

otevrit  dialogové  okno  Multiline Style.
open-inf dialogue-acc box-acc Multiline Style.

The other semantic situation is the realisation by the user of a creative action factually

[P

having two actions: the creation of a “virtual” GUI object (symbol “I” or “a” in the
following examples) and its trigger:

Entering a (when PLINE is / has been started) switches to Arc mode.
Entering 1 (when PLINE is / has been started) switches to Line mode.

For these texts the location of the created and then triggered GUI object is always
presented by the prompt (command line). So its environment is different from the
precedent type as it is not described by a location, but by the software product or its module
(command). Or, in terms of A-box by an (explicit or implicit) action, as evidenced by the
paraphrase “Starting the PLINE command and then entering | switches to Line mod’. For
example, consider the following IMD text fragment:
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1. Start the PLINE command ...

2. Specify the start point of the line segment.
3. Specify the endpoint of the line segment.
4. Enter a to switch to Arc mode.

5. Specify the endpoint of the arc.

6. Enter 1 to return to Line mode.

As we see from the examples this environment is naturally presented by a temporal
subordinate clause.

The following example describes the function of two consecutive, explicit actions,
whereas all previous examples have involved only a single action. We must consider only
actions of a special class (see the formalisation). The second Sentence of the following
example shows a sentence where the “creative” (see formalisation) function “specify” is
attributed not to a functional object (a program, for example), but to the complex actions of
the user. These situations cannot be considered as examples of the functional description
text type in a proper sense, because of the functional object lacking. It can be considered as
the other type of description texts, where we have a list of “creative” functions (‘“‘create”,
“specify” and so on) and the actions for their realisation. However, this is not the topic at
the current stage of the project. Now we try to do only the first steps in modelling the type
variety in instructional texts.

“Choosing Arc then choosing 3 Points from the Draw menu under DOS and UNIX start / starts (2?)
the ARC command.

“Entering endp and then selecting the line so the arc snaps to the endpoint of the line when the ARC
command is / has been started specifies / specify the endpoint.

Another distinct type of descriptive texts or propositions we named “functional
description”. They are enough often presented in chunks marked in the real instructional
texts by a Related connector. They describe functions of commands or of GUI-objects:

PLINE draws polyline line and arc segments that form a single object.
MLINE draws multiple parallel lines. ...

But in our A-boxes we have only content oriented at procedural instructions, so we
cannot take the corresponding text semantics directly from A-boxes. Planning the
descriptive text we must perform some reasoning upon the A-box. A more commonly
encountered kind of descriptive text relates Goals and GUI objects like commands, menu
items, toolbar icons etc. Usually, the functions of commands are described, yet in our A-
boxes we have only the functions of individual buttons. The method of modelling them is
quite similar, though. We consider them on the base of the following examples of
functional descriptive texts composed for IDM demonstrator texts.

OF functional-descriptive texts for the IDM text 1: page 47-48:
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Choose the Multiline Styles button from the Object Properties toolbar or the Data menu under
Windows opens the Multiline Styles dialog box.

The Multiline styles button from the Data menu under DOS and UNIX opens the Multiline Styles
dialog box.

The Add button in the Element Properties dialog box adds an element.
The Color button in the Element Properties dialog box opens the Select Color dialog box.
The Linetype button in the Element Properties dialog box opens the Select Linetype dialog box.

The OK button in the Element Properties dialog box saves the style of the multiline element and exits
the Element Properties dialog box.

OF functional-descriptive texts for the IDM text 2: page 46:

The Polyline button on the Polyline flyout from the Draw toolbar (under Windows) starts the PLINE
command.

The button Polyline button on the Draw menu (under DOS and UNIX) starts the PLINE command.

OF functional-descriptive texts for the IDM text 3: page 46:
3 Points button on the Arc flyout on (or from?) the Draw toolbar starts the ARC command.

3 Points button chosen after the Arc button from the Draw menu starts the ARC command.

Again the second sentence demonstrates the action environment for the GUI object, and is
accordingly expressed by a temporal prepositional phrase.

5.3 Formalisation

First of all, modelling descriptive texts from a procedural text content representation (A-
box) needs some reasoning upon the A-boxes and hence additional information about the
DM concepts that are used. We propose some additional classes for concepts described in
our DM.

We need a classification of user actions taking the following into consideration. Our
user’s actions that can be considered in this domain as usual functions of functional objects:
GUI-objects (buttons) and Hardware-objects (keys). These object’s functions are to
“activate” and “deactivate” Displayed-objects. This class of objects is described in the DM
as the widest class of objects that can be viewed and clicked on the screen. But here we
mean objects as “dialog box”, “menu” etc., the other objects being defined by narrower
classes (Configured, Graphical, Data, GUI —objects, Option). Functions “activate” and
“deactivate” are valid also to the classification of the actions with Software-tools
(command, program, operating system). Other functions are related to the actions with
Configured, Graphical and, Data, —objects. As a function of GUI-object the action can be
“save”, “add-to”, “apply-property” etc., which we can call the “dispose” function. The last
class of functions can be attributed to Software-tools. They are actions with Graphical-
objects that the user can realise using this Software tool — “draw a line”, “add dimensions to
a drawing”, “create hatched area” and so on. We call these instances of the “create”

function.
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In our DM we have the following concepts:
* START-TOOL / QUIT-TOOL (software-actee) — “activate/ deactivate”;

* OPEN-SCREEN-OBJECT/CLOSE-SCREEN-OBJECT (displayed-actee) —
“activate / deactivate’;

* RETURN-TO - composition of “activate” and “deactivate” functions upon two
objects;

* ADD-TO (configured-actee) — “dispose’;
etc.

The class of our user’s actions which are physical actions that can be considered in this
domain as methods of activating the functional objects: GUI objects (buttons) and
Hardware objects (keys). They are:

* PRESS (hardware-actee) — “activate”.
* CHOOSE (displayed-actee) — “activate”.

We do not consider now the situations of the creative action of user as they were
considered in the discussion section, like in the example Enter “I”, which must be
presented as composition of “create” function and “activate” function.

Modelling descriptive texts from procedural A-boxes goes by stages.

The first stage has the aim to identify those portions of the content that are to be
included in the descriptive text. They are the fragments containing the two actions
(GOALs) belonging to the described DM classes. We consider the initial A-box fragment
using for illustration examples from the first and second IMD texts.

The fragment of A-box corresponding to the OF functional description is the following:

PROCEDURE
GOAL (*): Start the PLINE command / Add elements to the style /
METHODS: METHOD-LIST
FIRST:
METHOD
CONSTRAINT: Windows
SUBSTEPS: PROCEDURE-LIST
FIRST:
PROCEDURE :
GOAL (**): Choose Polyline /

Choose Element .Properties

In this fragment we have marked the higher level GOAL slot by (*) and the lower level
GOAL slot by (**) to make referring to the concepts in the structure description easier.

In this fragment of structure presented by configuration concepts the GOAL (*) slot
structure is the following:

USER-ACTION: Start-tool “activate”/ Add-to “dispose”—> Start / Add
ACTEE: Software—actee / Configurated-actee > command / elements
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The GOAL (**) slot structure is the following:

USER-ACTION: Choose “activate”/ Choose “activate”—> choose / choose
ACTEE: Displayed-actee / Displayed-actee > button / button
OPTIONS: GUI-actee

LOCATION: GUI-actee =2 the Polyline flyout /.

The USER-ACTION at the GOAL (*) belongs to the functions possible for “activate /
deactivate” or “dispose” DM classes of actions with software-actee or configurated-actee.

The USER-ACTION at the GOAL (**) must belong to “activate” DM class of actions
upon Displayed-actee, because the descriptive texts just describe the functions of functional
objects according to the software product design. We consider here only the “activate”
function, since we have not “deactivate” in our IMD demonstrator texts. We must follow
the general rule that “create” functions are only possible for Software objects as attributed
to them in the text structure while being in DM representation the user’ goals. “Create”
functions can not be attributed to GUI objects, which are rather triggers.

At the second stage, when the fragment of A-box is found we need to match the
structure like this into a text plan that arranges all its content. The text plan structure for the
OF description text can be presented as follows:

OF-DESCRIPTION : The Element Properties button adds elements to the
style.

FUNCTIONAL-OBJECT : The Element Properties button
LOCATION : O

OPTIONS : O

FUNCTION : adds elements to the style.

Functional objects usually have just one function, and therefore the FUNCTION slot
does not need to contain a list structure.

Next, let us discuss the mapping from A-box into the Text plan structure. The difference
from the text plan for procedural text concerns the Functional-object and Function elements
of the text plan.

The FUNCTIONAL-OBJECT corresponds to the ACTEE of an action in the GOAL (*%*)
slot.

The FUNCTION is the PROCEDURE, for which it holds that the METHOD, in whose
SUBSTEPS' PROCEDURE we found the FUNCTION-OBJECT, is a member of that
PROCEDURE's METHODS's METHOD-LIST. Or in other words it is a PROCEDURE of
the GOAL (*) slot.

Mapping:
OF-DESCRIPTIONS:
FUNCTIONAL-OBJECT « Actee in GOAL (**) slot.
LOCATION o Location (optional) specified with the action in GOAL (*).
OPTIONS « Options specified with the action in GOAL (*).
FUNCTION o Action in GOAL (¥) slot.

So the FUNCTION is the Action that FUNCTIONAL-OBJECT "obtains" in the sense
that the METHOD (under which PROCEDURE's GOAL (*) occurs) is a possible way of
obtaining a PROCEDURE's GOAL (**), and as such specified under that PROCEDURE's
METHODS.



AGILE 73

In the case there is a CONSTRAINT specified with the METHOD, we can opt for
introducing another text structure element, CONSTRAINT. What that CONSTRAINT
maps to is obvious: It should get identified with the CONSTRAINT of the METHOD under
which the PROCEDURE with “the lower GOAL” occurs.

A last comment concerns the process of the wording the content representation. Here we
have difference from the procedural texts for English, where the word for the Option,
expressed usually by Labelled-GUI-object “button” is regularly omitted in procedural texts,
but presented in functional descriptions:

Choose OK to save the style of the multiline element

VS.

The OK button saves the style of the multiline element.
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6. Overviews

6.1 Discussion of the text type

An overview is defined as running text, presenting a summary of the operations described
in a technical manual or chapter containing a set of procedural texts. Normally the aim of
an overview is to introduce a group of possible user tasks, so it can be found in the first
chapter of a manual or in the introductions to each chapter. The content to be revealed in
the overview is contained in the list of A-boxes, representing the set of procedures. A
global overview has to combine in a running text the main goals of the described
procedures, expressed by the task titles. This approach permits to include hypertext links in
the overview texts, each task title pointing to the corresponding full procedure text, if
properly marked.

We may have two different styles of overview genre, similar to the styles for procedural
texts (the layout of the examples do not follow the overview running text layout for better
readibility):

Personal style, with explicit 2 person plural reference to the user:®

68. En:
The AGILE-AUTOCAD enables you
to create a multiline style,
to specify the properties of a multiline,
to draw a line and arc combination polyline,
to draw an arc by specifying three points,
and to define a boundary set in a complex drawing.

69. Bu:
Cucremara AGILE-AUTOCAD Bu mno3BoisiBa fa Ch34aA€Te CTHI Ha
System-def AGILE-AUTOCAD you enable-3sg to create-2pl style of

MYJITUIMHUS, 1a 33a7ieTe  XapaKTepUCTHUKUTE Ha MYJITUIIMHMUS,
multiline, to define-2pl properties-def of multiline,

Ja HadepTaeTe IOJIUJIUHMS, CbCTABEHA OT OTCEYKU U JIbIH,
to draw-2pl polyline, composed of line-segments and arcs,

7la HauepTaeTe [bra o TpH TOYKH,
to draw-2pl arc by three points,

U faa nepuHUpaTe MHOXECTBO IPAHUIM B CIOXEH YEpPTEX.
and to define-2pl  set boundaries in complex drawing.

¥ We mark the reference to the user visually by typesetting it in bold face.
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70. Cz:
Systém AGILE-AutoCAD Vam  umoZiiuje,
System AGILE-AutoCAD You-dat enables
abyste vytvofili  styl multi¢ary,
so-that-would-2pl create-2pl style-acc multiline-gen
(abyste) urcili vlastnosti multicary,
(so-that-would-2pl) specify-2pl properties-acc multiline-gen
(abyste) nakreslili ¢aru sloZenou z piimek a olouku
(so-that-would-2pl) draw-2pl line composed from line-segments-gen and arc-
gen,
(abyste) nakreslili oblouk urCenim tri bodu,
(so-that-would-2pl) draw-2pl arc-acc specifying-ins three-gen points-gen
a (abyste) definovali hrani¢ni mnoZzinu
and (so-that-would-2pl) define-2pl boundary-acc set-acc
v komplexnim vykrese.
in complex-loc drawing-loc
71. Ru:

Cucrema  AGILE-AUTOCAD no3Boasier Bam cO31aBaTh
System-Nom AGILE-AUTOCAD enable-3sg you-Dat create-imprf-inf

CTUJIb MYJIbTUJIMHUH,
style-Acc multiline-Gen,

3a/aBaTh CBOICTBa MYJITHJIMHUHY,
define-imprf -inf  properties-Acc multiline-Gen,

pucoBatb MOJIUIMHUH,
draw-imprf-inf polyline-PL-Acc,

COCTOSILIIME U3 OTPE3KOB MPSAMBIX U Jyr,
composed by segments-Gen line-Gen and arcs-Gen,

pucoBatb ayry IO TPEM TO4YKaM,
draw-imprf-inf arc-Acc by three points-Dat,

ONpeneNsaTh Habop IPaHuULL B CJOXXHOM PpHCYHKE.
define-imprf-inf set-Acc ~ boundaries-Gen in complex drawing.



AGILE 76

Impersonal style, with no reference to the user:’

72. En:
The AGILE-AUTOCAD enables
the creation of multiline style, the specification of the properties of a multiline,
the drawing of a line and arc combination polyline, the drawing of an arc by
specifying three points, the definition of a boundary set in a complex drawing.

73. Bu: reflexive passive voice
Cucremara AGILE-AUTOCAD no3BoJisiBa
System-def AGILE-AUTOCAD enable-3sg

JIa ce cb3jane CTUJI HA MYJITUJIMHUSA,
to refl create-3sg style of multiline,

Jace 3adagaT  XapaKTePUCTHKUTE HAa MYJTUIMHUS,
to refl define-3pl properties-def of multiline

7la ce HayepTae MOJIMJIUHMS, CbCTABEHA OT OTCEYKH U JIbIU,
to refl draw-3sg polyline, composed by line-segments and arcs,

7la ce HayepTrae Abra mo TPpU TOUKH,
to refl draw-3sg arc by three points

nace aepuUHUpPAa MHOXECTBO FPAHULM B CJIOXEH YEpTEeX.
to refl define-3sg set boundaries in complex drawing.

74. Cz: infinitive
Systém AGILE-AutoCAD umoZiiuje
System-nom AGILE-AutoCAD enables

vytvofit  styl multi¢dry,
create-inf style-acc multiline-gen

urcit vlastnosti multicary,
specify-inf properties-acc multiline-gen

nakreslit €aru sloZenou z ptimek a olouku
draw-2pl line composed from line-segments-gen and arc-gen,

nakreslit oblouk urCenim trl bodu,
draw-inf arc-acc specifying-ins three-gen points-gen

a  definovat hrani¢ni mnoZinu v komplexnim vykrese.
and define-inf boundary-acc set-acc in complex-loc drawing-loc

®  We mark the reference to the user visually by typesetting it in bold face.
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75. Ru: infinitive
Cucrema AGILE-AUTOCAD no3Bonsier co3aaBaThb
System-Nom AGILE-AUTOCAD enable-3sg create-imprf-inf

CTUJIb  MYJbTUJIMHUH, 3371aBaTh CBOMCTBa MYJITUIUHUH,
style- Acc multiline-Gen, define-imprf -inf properties-Acc multiline-Gen,

pucoBathb MOJIUIIMHUH,
draw-imprf-inf polyline-PL-Acc,

COCTOSILIIME U3 OTPE3KOB MPSAMBIX U Jyr,
composed by segments-Gen line-Gen and arcs-Gen,

pucoBathb ayry [0 TPeM TOuKaMm,
draw-imprf-inf arc-Acc by three points-Dat,

OnpenensaTh Ha0op rpaHun B CIIO)KHOM pPHCYHKE.
define-imprf-inf set-Acc set boundaries-Gen in complex drawing.

It has to be mentioned that this style does not lead to a good English text, but Bulgarian,
Czech and Russian text are considered natural.

The OVERVIEW and TOC content cannot be expressed by a single A-box. Therefore
the presentation of an OVERVIEW or TOC may requires a new Domain model concept,
which can express the content of several procedural A-Boxes in a single structure. We call
this concept ACTIONS-GROUP, and it can be defined in the following manner.

(define-concept ACTIONS-GROUP
((HYPER-THEME :type USER-ACTION)
(ACTION-LIST :type PROCEDURE-LIST)))

This concept is instantiated by what we will call an ACTIONS-GROUP-A-BOX, which
by definition thus has the following slots:

» HYPER-THEME, expressing the content of the overview leading clause;

* ACTION-LIST, filled with a structure of type PROCEDURE-LIST, being a list of
PROCEDURESs. Each PROCEDURE has a structure as defined in the Domain model.

The elements expressing the OVERVIEW content are the main goals /the topmost goals/
of the procedures in the list of A-boxes, created by the user. The ACTIONS-GROUP-A-
BOX is using only the obligatory slot —- GOAL. Each GOAL corresponds to the GOAL of
the topmost PROCEDURE of an A-Box from the user's list of A-Boxes.

We can consider the following mapping between text structure elements and configuration concepts:
e OVERVIEW-INTRODUCTION ~ HYPER-THEME
e OVERVIEW-TASKS  ACTION-LIST
e OVERVIEW-TASK ~ GOAL of PROCEDURE
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The slot HYPER-THEME for the overview texts corresponds to OVERVIEW-
INTRODUCTION in the text structure. Each procedure’s GOAL is represented by an
OVERVIEW-TASK.

The procedure which pre-processes list of A-boxes and produces ACTIONS-GROUP-A-
BOX can be described in the following abstract manner:

construct-aboxes—generalization (list-of-aboxes)
make-new-actions—group—-a-box)

insert HYPER-THEME content)

while (there is more aboxes left)

insert in next-procedure

get next-abox-procedure))))

The resulting ACTIONS-GROUP-A-Box is processed further by the text planner
module using the formal descriptions in the next section.

In order to obtain more natural overview texts it is desirable to form them additionally.
The subordinate clauses in the sentences of the overview text may be aggregated according
to different criteria:

* Random ordering: The subordinate clauses follow the order in which the user has
described the A-boxes for generating procedural texts. The text planning process may
limit the number of the subordinated clauses in a single sentence. A reasonable sentence
would describe not more than 3-4 tasks.

* Aggregation according to the task actee: The text planning process may group the
tasks, described in an overview text, by their actee, i.e. to combine in separate sentences
the tasks concerning the same actee. Such an aggregation permits the construction of
clauses that describe possible actions executed on given object or on objects of the same
class. The later possibility requires that the text planning process considers the
ontology, presented by the domain model.

* Aggregation according to the task action: The text planning process may group the
tasks, described in an overview text, by their action, i.e. to combine in separate
sentences the tasks concerning the same action. Such an aggregation permits to
construct clauses, describing the same actions on different objects of the CADCAM
area.

The following example illustrates an aggregation according to the actee in the first
sentence and an aggregation according to the action in the second sentence:

76. En:
The AGILE-AUTOCAD system enables you to create a multiline style and to
specify the properties of a multiline. You can also draw a line and arc
combination polyline and an arc by specifying three points.
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77. Bu:
Cucremara AGILE-AUTOCAD Bu nossossisa
System-def AGILE-AUTOCAD you enable-3sg
7ia Ch3JaJ€Te CTUJ Ha MYJTUIMHUS
to create-2pl style of multiline
U Ja 3a7a/ere XapaKTePUCTHKUTE HAa MYJITUIMHMUS,
and to define-2pl properties-def of multiline,
Bue moxere  cpuio
You may-2pl also
7la HauepTaeTe MOJWJIMHUA, CbCTaBEHA OT OTCEYKHU U JIbrHy,
to draw-2pl  polyline, composed by line-segments and arcs,
U Abrano TpU TOUKH.
and arc by three points.
78. Cz:
Systém AGILE-AutoCAD Vam  umoZiuje vytvofit styl multicary,
System-nom AGILE-AutoCAD you-dat enables create-inf style-acc multiline-gen
a urcit vlastnosti multiCdry.
and specify-inf properties-acc multiline-gen
Muzete také nakreslit ¢aru slozenou z piimek a olouku
Can-2pl also draw-2pl line composed from line-segments-gen and arc-gen
nebo nakreslit oblouk uréenim tif bodu,
or draw-inf arc-acc specifying-ins three-gen points-gen
79. Ru:

Cucrema AGILE-AUTOCAD no3BossieT co3iaBaTh
System-Nom AGILE-AUTOCAD enable-3sg create-imprf-inf

CTUJIb  MYJbTWJIMHUU U 3a]aBaThb CBOMCTBa MYJITUJIMHUHY,
style- Acc multiline-Gen and define-imprf -inf properties-Acc multiline-Gen.

Bpl Takke MOXKeTe pucOBaTh HOJIUIMHUY,
You also may-2pl draw-imprf-inf polyline-PL-Acc,

COCTOSILLIUE U3 OTPE3KOB NpsIMBIX U JyT,
composed by segments-Gen line-Gen and arcs-Gen,

U Ayry [0 TPEM TOYKaM.
and arc-Acc by three points-Dat.

Different aggregation options may be specified by explicit user control, which will
complicate the work with the system. The alternative solution is to make aggregation
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decisions automatically by analysing the list of the tasks main goals looking for possible
aggregations according to common actee and/or to common action.

6.2 Formalisation

The text structure elements are implemented by means of the following functional-

grammar-like systems:
The following system inserts an OVERVIEW-TASK or an OVERVIEW-INTRODUCTION into the text
plan.

(SYSTEM OVERVIEW-ELEMENTS
:INPUTS OVERVIEW-GENRE
( (OVERVIEW-DOCUMENT
(INSERT OVERVIEW-INTRODUCTION)
(ORDERATFRONT OVERVIEW-INTRODUCTION) )
(OVERVIEW-TASK
(INSERT OVERVIEW-TASK))))

(CHOOSER OVERVIEW-ELEMENTS-CHOOSER
( (CHOOSE OVERVIEW-DOCUMENT
if HYPER-THEME needs to be realized)
else
(CHOOSE OVERVIEW-TASK)))

The next system goes recursively through the ACTION-LIST, which has as its value a
PROCEDURE-LIST containing PROCEDURES. For each head in the ACTION-LIST we
insert a text structure element OVERVIEW-TASKS in the text plan, alike INSTRUCTION-
TASKS in the text plans for full procedural instructional texts. By preselecting
OVERVIEW-TASKS as OVERVIEW-TASK we ensure that on the next traversal through
the systems, we enter the system dealing with OVERVIEW-TASK (OVERVIEW-
ELEMENTS). Upon entering that system an OVERVIEW-TASK will be inserted in the
text plan, and identified with the GOAL of the PROCEDURE that constitutes the head of
the (currently observed part of the) ACTION-LIST.

(SYSTEM OVERVIEW-TASK-TYPE
:INPUTS OVERVIEW-DOCUMENT, OVERVIEW-TASK
( (MORE-OVERVIEW-TASKS
(INSERT OVERVIEW-TASKS)
(ORDERATEND OVERVIEW-TASKS)
(PRESELECT OVERVIEW-TASKS OVERVIEW-TASK))
(NO-MORE-OVERVIEW-TASKS) ) )

(CHOOSER OVERVIEW-TASK-TYPE-CHOOSER
((ask (longer-list-q)
(more (CHOOSE MORE-TOC-TASKS))
(no—more (CHOOSE NO-MORE-TOC-TASKS)))))

Finally, the next two systems impose the proper constraints on the realisation of
OVERVIEW-INTRODUCTION and OVERVIEW-TASK. These constraints will be
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included in the SPLs (for the respective elements) that will be generated by the sentence
planner.

(SYSTEM OVERVIEW-INTRODUCTION-REALIZATION-STYLE
:INPUTS OVERVIEW-DOCUMENT
( (INTRO-PERSONAL
(INSERT INTRO-PERSONAL)
(REALIZE-WITH INTRO-PERSONAL
(:SPEECHACT IMPERATIVE)))
( (INTRO-IMPERSONAL
(INSERT INTRO-IMPERSONAL)
(REALTIZE-WITH INTRO-IMPERSONAL
(:PREFER-MENTION-AGENT-Q WITHHOLD))))))

(SYSTEM OVERVIEW-TASK-REALIZATION
:INPUTS OVERVIEW-TASK
( (OVERVIEW-TASK-PERSONAL
(INSERT OVERVIEW-TASK-PERSONAL)
(REALIZE-WITH OVERVIEW-TASK-PERSONAL
:SPEECHACT IMPERATIVE)))
(OVERVIEW-TASK-IMPERSONAL
(INSERT OVERVIEW-TASK-IMPERSONAL)
(REALTIZE-WITH OVERVIEW-TASK-IMPERSONAL
(:PREFER-MENTION-AGENT-Q WITHHOLD)))))

Personal style, with explicit 2" person plural reference to the user:'

80. En:
The AGILE-AUTOCAD enables you
to create a multiline style,
to specify the properties of a multiline,
to draw a line and arc combination polyline,
to draw an arc by specifying three points,
and to define a boundary set in a complex drawing.

' We mark the reference to the user visually by typesetting it in bold face.
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81.

82.

Bu:
Cucremara AGILE-AUTOCAD Bu no3sossiBa ja Ch3/1afieTe CTUI Ha
System-def AGILE-AUTOCAD you enable-3sg to create-2pl style of

MYJITUIMHUS, 1a 3a7a7€Te  XapaKTepUCTUKUTE Ha MYJITUIIMHUS,
multiline, to define-2pl properties-def of multiline,

7a HadepTaeTe IOJIUIUHMS, CbCTABEHA OT OTCEYKH U JIbI'H,
to draw-2pl polyline, composed of line-segments and arcs,

7la HauepTaeTe [bra o TPM TOYKH,
to draw-2pl arc by three points,

U faa nepuHMpaTe MHOXECTBO IPAHUIM B CIOXEH YEPTEX.
and to define-2pl  set boundaries in complex drawing.

Cz:
Systém AGILE-AutoCAD Vam  umoZiiuje,
System AGILE-AutoCAD You-dat enables

abyste vytvofili  styl multi¢ary,
so-that-would-2pl create-2pl style-acc multiline-gen

(abyste) urc€ili vlastnosti multiCary,
(so-that-would-2pl) specify-2pl properties-acc multiline-gen

(abyste) nakreslili ¢aru sloZzenou z piimek a olouku
(so-that-would-2pl) draw-2pl line composed from line-segments-gen and arc-
gen,

(abyste) nakreslili oblouk urenim tid bodu,
(so-that-would-2pl) draw-2pl arc-acc specifying-ins three-gen points-gen

a (abyste) definovali hrani¢ni mnoZzinu
and (so-that-would-2pl) define-2pl boundary-acc set-acc

v komplexnim vykrese.
in complex-loc drawing-loc
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83. Ru:
Cucrema  AGILE-AUTOCAD no3Bosasier Bam cO31aBaTh
System-Nom AGILE-AUTOCAD enable-3sg you-Dat create-imprf-inf

CTUJIb MYJIbTUJIMHUH,
style-Acc multiline-Gen,

3a/aBaTh CBOICTBa MYJITHJIMHUHY,
define-imprf -inf  properties-Acc multiline-Gen,

pucoBatb MOJIUIMHUH,
draw-imprf-inf polyline-PL-Acc,

COCTOSILIIME U3 OTPE3KOB MPSAMBIX U Jyr,
composed by segments-Gen line-Gen and arcs-Gen,

pucoBarb ayry IO TPEM TOYKaM,
draw-imprf-inf arc-Acc by three points-Dat,

ONpeneNsiTh Habop IPaHuULL B CJOXXHOM PpHCYHKE.
define-imprf-inf set-Acc ~ boundaries-Gen in complex drawing.
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7. Table of Contents

7.1 Discussion of the text type

This genre covers a presentation of the chapters/paragraphs titles of the texts, generated
during an AGILE session. These texts are supposed to form a consistent part of a technical
manual, describing the operation of a CAD-CAM system. During an AGILE session the
technical author specifies the content of the texts through the authoring interface,
constructing a list of semantic descriptions - A-boxes. The Table-of-Contents has to present
a numbered list of the headings of different texts, generated from a set of A-boxes, as
discussed in the other chapters of the present deliverable. This basic requirement leads to
the following structure:

TABLE OF CONTENTS

1. Overview

2. Procedures
2.1
220,

3. Command descriptions
3.
32 .l

4. Quick reference
4.1......
42 ...

The sections of the Table-of-Contents are numbered lists of the Task titles, possibly with
hyperlinks to the corresponding full texts. As the most common texts in AGILE are
procedural texts, the Task titles present the main goals of the “Full procedural Instructions”
texts. The “Quick reference” section present the “Basic step” texts and the “Command
descriptions” section presents ‘“Functional descriptive texts”.

The TOC content cannot be expressed by single A-box. Therefore a new Domain model
concept is necessary, which can express the content of several procedural A-Boxes in a
single structure. The concept name is CHAPTER-CONTENT and is described in the
chapter on overviews (Chapter 9).

We can consider the following mapping between text structure elements and
configuration concepts:

e TOC-TITLE « INITIAL-EVENT
* TOC-TASKS « ACTION-LIST
* TOC-TASK « GOAL of PROCEDURE
The INITIAL-EVENT can be just a label like “TABLE OF CONTENTS’.
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The text planner for planning the Table-of-contents text genre will need a procedure that
pre-processes a list of A-boxes and produces an ACTIONS-GROUP-A-BOX. The
procedure and this type of A-box are described in the chapter on overviews. The resulting
ACTIONS-GROUP-A-BOX is processed further by the text planner module using, the
formal descriptions given in the next section.

For better text layout one could imagine the following HTML mapping applied to the
Table-of-content text:

Text Structure Element Layout HTML Tags
TOC-TITLE Heading level N <HN> ... </HN>
TOC-TASKS Ordered list <OL> ... </OL>
TOC-TASK List Item <LI>

7.2 Formalisation

The text structure elements are implemented by means of the following functional-grammar-like
systems.

The following system inserts a TOC-TASK or a TOC-TITLE into the text plan.

(SYSTEM TOC-ELEMENTS
: INPUTS TOC-GENRE
( (TOC-DOCUMENT
(INSERT TOC-TITLE)
(ORDERATFRONT TOC-TITLE))
(TOC-TASK
(INSERT TOC-TASK))))

(CHOOSER TOC-ELEMENTS-CHOOSER
( (CHOOSE TOC-DOCUMENT
if INITIAL-EVENT needs to be realized)
else
(CHOOSE TOC-TASK)))

The next system goes recursively through the ACTION-LIST, which has as its value a
PROCEDURE-LIST containing PROCEDURES. For each head in the ACTION-LIST we
insert a text structure element TOC-TASKS in the text plan, alike INSTRUCTION-TASKS
in the text plans for full procedural instructional texts. By preselecting TOC-TASKS as
TOC-TASK we ensure that on the next traversal through the systems, we enter the system
dealing with TOC-TASK (TOC-ELEMENTS). Upon entering that system a TOC-TASK
will be inserted in the text plan, and identified with the GOAL of the PROCEDURE that
constitutes the head of the (currently observed part of the) ACTION-LIST.
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(SYSTEM TOC-TASK-TYPE
:INPUTS TOC-DOCUMENT, TOC-TASK
( (MORE-TOC-TASKS
(INSERT TOC-TASKS)
(ORDERATEND TOC-TASKS)
(PRESELECT TOC-TASKS TOC-TASK))
(NO-MORE-TOC-TASKS) ) )

(CHOOSER TOC-TASK-TYPE-CHOOSER
((ask (longer-list-q)
(more (CHOOSE MORE-TOC-TASKS))
(no—more (CHOOSE NO-MORE-TOC-TASKS)))))

Finally, the next two systems - gates, since they do not need any underlying choosers,
impose the proper constraints on the realisation of TOC-TITLE and TOC-TASK. These
constraints will be included in the SPLs (for the respective elements) that will be generated
by the sentence planner.

(GATE TOC-TITLE-REALIZATION
:INPUTS TOC-DOCUMENT
((TOC-TEMPLATE
(INSERT TOC-TEMPLATE)
(REALTZE-WITH TOC-TEMPLATE
(insert Template "TABLE OF CONTENTS"))))

(GATE TOC-TASK-REALIZATION
:INPUTS TOC-TASK
(NOMINALIZED-TOC-TASK
(INSERT NOMINALIZED-TOC-TASK)
(REALTZE-WITH NOMINALIZED-TOC-TASK
(:EXIST-SPEECH-ACT-Q NOSPEECHACT
:AGENT-MENTION-Q WITHHOLD))))
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8. Closing remarks

In this document we discussed various extensions to the Text Structuring Module (TSM) as
it was specified and implemented in WP 5.2 (cf. TEXS2, TEXM?2). We started the
deliverable by extending the coverage in depth, by specifying additional stylistic variations
for, for example, overall text style (Chapter 2).

In subsequent chapters (Chapters 3-7) we extended the coverage of the TSM in breadth.
We provided a more elaborate picture of discourse modelling in Chapter 3, in a way that
will enable us to develop "text grammars" in a manner similar to the way we have been
elaborating the lexicogrammars. In Chapters 4 through 7 we discussed genres that are
different from the full instructions type generated by the intermediate demonstrator -
summaries, descriptions, overviews and TOCs were described, and we specified how they
could be generated on the basis of the A-boxes specifying the content for full instructions.

The generation of function descriptions, overviews and tables of content amounts to
generating "meta-texts" on the basis of multiple input content specifications. Applications
generating such "meta-texts" are is fairly unique in current NLG, which means that our
work in this are is quite original.

During the implementation phase of WP 5.3 we will extend the TSM as specified here.
Furthermore, we believe that the following (implementational) issues should be addressed
as well at that point:

*  Style sheets, as groupings of coherent settings for different options of stylistic variation.
The idea of style sheets was already discussed in TEXM2, but the increase in possible
stylistic variation specified in this deliverable enables us to elaborate this notion in more
detail.

» Semanticization of concepts, being the proper realisation of concepts. Currently, there
are two ways in which the realisation of a concept can be specified. The first way is a
more or less iIsomorphic mapping from concept to word (i.e. modulo morphological
cases). The second way is by inclusion of more intricate SPL code in the SPL for the
sentence in which the concept is to be realised. This case is used for concepts that need
to be realised as multi-word expressions. For example, the concept DIALOGUE-BOX
needs to be realised by two separate words in the Slavic languages under consideration.
These two ways suffice for bringing about the natural realisation of most concepts.
However, there are cases that seem to warrant a third way in which the proper
realisation of particular concepts should be specified. These cases concern the
realisation of concepts that have particular slots (due to their definition in the DM and
inheritance from the UM) that should not be straightforwardly realised as the same
slots, but as different slots (e.g. SOURCE versus LOCATION).
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9. Appendices

9.1 Brief descriptions of inquiries available in the current TSM

Below the inquiries of the CADCAM-INSTRUCTIONS region are described, as actually used. The
implementations (CODE) of these inquiries are placed in the <t sm2000.1isp> file. The headings can be
used as formal representation. In CADCAM-INSTRUCTIONS.choosers it is easy to see which chooser relies
on which inquiries.

9.1.1 Descriptions of general inquiries

9.1.1.1 agile-abox-root-id-code (ONUS)

Assumes: nothing
Returns: The content under the current generation-root ONUS.

9.1.1.2 agile-abox-root-q-code (ONUS)

Assumes: nothing

Returns: Declares the generation-root, resets *text-element-associations* and returns the value ‘document if
we are at the root of the A-box and ‘component otherwise. *text-element-associations* contains constraints
associated to a particular text-element, notably those obtained by REALIZE-WITH.

9.1.1.3 get-abox-slot (SLOT)

Assumes: a root ROOT (determined in the context)
Returns: the value of the slot SLOT under ROOT, when that slot is filled.

9.1.1.4 get-abox-slot-sloppy (SLOT)

Assumes: a root ROOT (determined in the context)
Returns: the value of SLOT under ROOT, provided such a slot exists under ROOT and is filled.

9.1.2 Description of TASK-related inquiries

9.1.2.1 first-instruction-id-code (ROOT)

Assumes: Root

Returns: If there is a FIRST slot under the ROOT, checked using get-abox-slot-sloppy, then the value of that
FIRST slot is returned, otherwise ROOT is returned. ROOT is assumed to be a TASK/PROCEDURE’s
METHODS’s METHOD-LIST.
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9.1.2.2 multiple-methods-id-code (ROOT)

Assumes: Root
Returns: Returns the value of the METHODS slot under ROOT using get-abox-slot.

9.1.2.3 rest-instruction-id-code (ROOT)

Assumes: Root

Returns: If there is a REST slot under the ROOT, checked using get-abox-slot, then the value of that REST
slot is returned. ROOT is assumed to be a TASK/PROCEDURE’s METHODS’s METHOD-LIST.
Comments: Compare with the above inquiry, first-instruction-id-code.

9.1.2.4 task-id-code (ROOT)

Assumes: nothing
Returns: The value of the GOAL slot of ROOT by means of get-abox-slot.

9.1.2.5 task-sideeffect-id-code (ROOT)
Assumes: Root to be set in the context

Returns: The value of the slot SIDE-EFFECT under the current ROOT, using get-abox-slot. We might be
dealing with a list - if so, the ROOT is redirected to the FIRST element of that list.

9.1.2.6 task-side-effect-q-code (ROOT)

Assumes: ROOT to be set in the context, possibly pointing to a PROCEDURE-LIST.

Returns: Checks whether there is a filled slot SIDE-EFFECT, if so then return ‘with-effect otherwise
‘without-effect. The code checks whether we are dealing with a list or with a procedure (e.g. the top-most
procedure to which TASK-TITLE corresponds) by checking (using get-abox-slot-sloppy) whether there is a
FIRST slot. If so, then the root is redirected to the FIRST of the list.

9.1.2.7 task-title-id-code (ROOT)

Assumes: nothing
Returns: The value of the GOAL slot of ROOT by means of get-abox-slot.

9.1.2.8 task-type-q-code (ROOT)

Assumes: ROOT to be set in the context

Returns: If there is a filled slot METHODS (checked using get-abox-slot-sloppy) then return ‘with-instruct
otherwise ‘without-instruct.

Comments: Note the use of the sloppy version of get-abox-slot: it may well be the case that the inquiry looks
at a PROCEDURE-LIST rather than a PROCEDURE, when called. However, changing the code such that
ROOT is redirected to the FIRST procedure in a list when we are dealing with a list seems to make no
observable difference.

9.1.3 Descriptions of INSTRUCTION:-related inquiries

9.1.3.1 instruction-constraint-id-code (ROOT)

Assumes: Root to be set in the context
Returns: The value of the slot CONSTRAINT under the current ROOT, using get-abox-slot.

9.1.3.2 instruction-constraint-q-code (ROOT)

Assumes: ROOT to be set in the context
Returns: If there is a filled slot CONSTRAINT under the current root then return ‘with-constraint else return
‘without-constraint. Uses get-abox-slot.

9.1.3.3 instruction-precondition-id-code (ROOT)

Assumes: Root to be set in the context
Returns: The value of the slot PRECONDITION under the current ROOT, using get-abox-slot.
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9.1.3.4 instruction-precondition-q-code (ROOT)

Assumes: ROOT to be set in the context.
Returns: If there is a filled slot PRECONDITION under the current root then return ‘with-precondition else
return ‘without-precondition. Uses get-abox-slot.

9.1.3.5 instruction-substeps-id-code (ROOT)

Assumes: Root to be set in the context
Returns: The value of the slot SUBSTEPS under the current ROOT, using get-abox-slot.

9.1.3.6 instruction-type-q-code (ROOT)

Assumes: nothing
Returns: Defaults to ‘complexinstruct.



9.2 Target texts for Full Procedural Instructions

We present the versions of the texts differing in degree of aggregation and in sequence
marking, to be considered as targets for the Final Prototype. What we call "Baseline" for
each text is supposed to correspond very closely to the A-box. Aggregation is done only for
most simplex steps. Vertical lists are used rather than running text. Sequences are marked
by numbering or conjunctives, as discussed in the deliverable. Indentation reflects
hierarchy in A-box. There are (a,b) variants regarding explicit realisation of side-effects
(this gives two versions of each text, by taking consistently all the (a) or all the (b) variants;
no (a-b) combinations).

The subsequent versions of the texts exercise aggregation and explicit sequence marking
as discussed in the deliverable. There are two version for each text, one labelled as "more
aggregated" and the other as "running text".

As for the variation between personal and impersonal style, we only include the personal
style, using imperative mood. The impersonal style, using reflexive passive, is of course
also available, and is to be generated, but we do not include it in this appendix, for the sake
of space.
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9.2.1 ENGLISH

9.2.1.1 Based on IMD Text 1: pages 47-48

9.2.1.1.1 Baseline Text 1

Versions (1) and (ii) reflect different possibilities of anaphoric reference.

To create a multiline style
First open the Multiline Styles dialog box using one of these methods:"'

Windows: Choose Multiline Style from the Object Properties toolbar or choose Multiline Style
from the Data menu.

DOS and UNIX: Choose Multiline Style from the Data menu.
Now add elements to the style.
(@)
1. Choose Element Properties.
2. In the Element Properties dialog box, enter the offset of the multiline elements.
3. Define an element.
First select Add in the Element Properties dialog box to add an/one element.

(i) Now specify the element's color. First choose Color in the Element Properties dialog box to.
Then select the element's color from the Select Color dialog box."

(i1) Now specify the element's color. First choose Color in the Element Properties dialog box.
Then select a color from the Select Color dialog box.""*

(i) Finally, specify the element's line type. First choose Linetype in the Element Properties dialog
box. Then select the element's linetype from the Select Linetype dialog box.

(i) Finally, specify the element's line type. First choose Linetype in the Element Properties
dialog box. Then select a line type from the Select Linetype dialog box.

Repeat these steps to define another element.
4. Choose OK to save the properties of the multiline elements.
(b)
1. Choose Element Properties. The Element Properties dialogue box appears.
2.Enter the offset of the multiline elements.
3. Define an element.
First select Add to add an/one element.

(i) Now specify the element's color. First choose Color. The Select Color dialog box appears.
Select a color. The Select Color dialog box disappears'’

(i1) Now specify the element's color. First choose Color. The Select Color dialog box appears.
Select the element's color. The Select Color dialog box disappears'®

(i) Finally, specify the element's line type. Choose Linetype. The Select Linetype dialog box
appears. Select a line type. The Select Linetype dialog box disappears.

Here, we are treating this piece not as a precondition, but as a normal step. The modelling of the text is
sort of funny anyway, because in this case we treat opening a dialogue box as a Goal (corresp. To the
user's intention), while in other cases dialogue boxes appear (open) as side-effects of the user's actions.

We added a Goal here, in order to reflect a more hierarchical structure of the A-box.
We added a Goal here, in order to reflect a more hierarchical structure of the A-box.

Note a/the color. It appears that both are possible here, depending on the exact meaning the speaker would
have in mind. A color = any color from the color-chart, vs. the color = the value for the element's color.

We added the disappearing piece for explicitness' sake, as if that was in the A-box.

® We added the disappearing piece for explicitness' sake, as if that was in the A-box.
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(i1) Finally, specify the element's line type. Choose Linetype. The Select Linetype dialog box
appears. Select the element's linetype. The Select Linetype dialog box disappears.

Repeat these steps to define another element.

4. Choose OK to save the properties of the multiline elements. The Element Properties dialog box
disappears."”’

This is a version with the following schematic structure:

Define an element.

1.(First) ...

2. (Now)...

3. (Finally)...

4. () Repeat these steps to define another element.

Another possibility is to employ the following schematic structure:

Define elements by repeating the following steps.
1.(First) ...

2. (Now)...

3. (Finally)...

If there would be only one step to repeat, singular number should be used, and running
text rather than list.

9.2.1.1.2 More aggregated Version of Text 1

Given the discussion of aggregation in the deliverable, we can observe that more
aggregation is possible only for the steps in version (a), while the presence of explicit side-
effects in version (b) actually prevents more aggregation. So we only show version (a) here.
We include possible additional explicit sequence markers in brackets.

To create a multiline style

First open the Multiline Styles dialog box using one of these methods:'®
Windows: Choose Multiline Style from the Object Properties toolbar or from the Data menu.
DOS and UNIX: Choose Multiline Style from the Data menu.

Now add elements to the style.

(@)

1. Choose Element Properties and (then) enter the offset of the multiline elements in the Element
Properties dialog box.

2. Define an element.
First select Add in the Element Properties dialog box to add an/one element.

Now specify the element's color by (first) choosing Color in the Element Properties dialog box
and (then) selecting the (element's) color from the Select Color dialog box. 19

""" Originally: Choose OK to save the properties of the multiline element and to exit the Element Properties
dialog box. --but, these are two Goals with one "shared" Method. Would have to be modelled by co-
identification in the A-box, and then aggregation would have to take care of it...Currently the A-box
contains a side-effect corresponding to the closing =disappearing of the dialogue box (it is not exit,
because side-effect should not be a user-action, right?).

Here, I am treating this piece not as a precondition, but as a normal step. The modelling of the text is sort
of funny anyway, because in this case we treat opening a dialogue box as a Goal (corresp. To the user's
intention), while in other cases dialogue boxes appear (open) as side-effects of the user's actions.

% 1 added a Goal here, in order to reflect a more hierarchical structure of the A-box.
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Finally, specify the element's line type by (first) choosing Linetype in the Element Properties
dialog box and (then) selecting the (element's) linetype from the Select Linetype dialog box.

Repeat these steps to define another element.

3. Choose OK to save the properties of the multiline elements.

9.2.1.1.3 Running version of Text 1

For the more aggregated version of Text 1 it also makes sense to consider its realisation
using running text for the third level of embedding, rather than a list. We show the text for
version (a) below. Running text is not a viable option for version (b), again because of the
explicit side-effects.

To create a multiline style

First open the Multiline Styles dialog box using one of these methods:*
Windows: Choose Multiline Style from the Object Properties toolbar or from the Data menu.
DOS and UNIX: Choose Multiline Style from the Data menu.

Now add elements to the style.

(a)
1. Choose Element Properties and (then) enter the offset of the multiline elements in the Element
Properties dialog box.

2. To define an element, first select Add in the Element Properties dialog box to add an/one
element. Now specify the element's color by (first) choosing Color in the Element Properties
dialog box and (then) selecting the (element's) color from the Select Color dialog box. Finally,
specify the element's line type by (first) choosing Linetype in the Element Properties dialog box
and (then) selecting the (element's) linetype from the Select Linetype dialog box. Repeat these
steps to define another element.

3. Choose OK to save the properties of the multiline elements.

" Here, I am treating this piece not as a precondition, but as a normal step. The modelling of the text is sort
of funny anyway, because in this case we treat opening a dialogue box as a Goal (corresp. To the user's
intention), while in other cases dialogue boxes appear (open) as side-effects of the user's actions.
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9.2.1.2 Based on IMD Text 2: page 46

9.2.1.2.1 Baseline Text 2

To draw a line and arc combination polyline
First draw a line segment.
1.Start the PLINE command using one of these methods:
Windows: From the Polyline flyout on the Draw toolbar, choose Polyline.
DOS and UNIX: From the Draw menu, choose Polyline.
2.Specify the start point of the line segment.
3.Specify the endpoint of the line segment.
Then draw an arc segment.
1.(a) Switch to Arc mode. First enter a. Then select OK in the Arc mode confirmation dialog box.
(b) Switch to Arc mode. Enter a. The Arc mode confirmation dialog box appears. Select OK.
2.Specify the endpoint of the arc.
Then draw another line segment.
1.(a) Return to Line mode. First enter I. Then select OK in the Line mode confirmation dialog box.
(b) Return to Line mode. Enter [. The Line mode confirmation dialog box appears. Select OK.
2.Enter the distance of the line in relation to the endpoint of the arc.
3.Enter the angle of the line in relation to the endpoint of the arc.
Finally, press Return to end the polyline.

9.2.1.2.2 More Aggregated Version of Text 2

Again, this version only makes sense for version (a), because the explicit side-effects in
version (b) block aggregation.

To draw a line and arc combination polyline
First draw a line segment.
1.Start the PLINE command using one of these methods:
Windows: From the Polyline flyout on the Draw toolbar, choose Polyline.
DOS and UNIX: From the Draw menu, choose Polyline.
2.Specify the start point and the endpoint of the line segment.
Then draw an arc segment.

(a) 1. Switch to Arc mode by (first) entering a and (then) selecting OK in the Arc mode confirmation
dialog box.

2. Specify the endpoint of the arc.
Then draw another line segment.

(a) 1. Return to Line mode by (first) entering [ and (then) selecting OK in the Line mode confirmation
dialog box.

2. Enter the distance and the angle of the line in relation to the endpoint of the arc.

Finally, press Return to end the polyline.

9.2.1.2.3 Running version of Text 2

Again, the more aggregated version of the text lends itself to realisation by a running text at
the more deeply embedded level. Note that here, we use numbering at the highest level.

‘ To draw a line and arc combination polyline ‘
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1. Draw a line segment.
First start the PLINE command using one of these methods:
Windows: From the Polyline flyout on the Draw toolbar, choose Polyline.
DOS and UNIX: From the Draw menu, choose Polyline.
Then specify the start point and the endpoint of the line segment.

2. Draw an arc segment. First switch to Arc mode by entering a and selecting OK in the Arc mode
confirmation dialog box. Then specify the endpoint of the arc.

3. Draw another line segment. First return to Line mode by entering / and selecting OK in the Line
mode confirmation dialog box. Then enter the distance and the angle of the line in relation to the
endpoint of the arc.

4. Press Return to end the polyline.

9.2.1.3 Based on IMD Text 3: page 58

9.2.1.3.1 Baseline Version of Text 3

To draw an arc
First start the ARC command using one of these methods:
Windows: From the Arc flyout on the Draw toolbar, choose 3 Points.
DOS and UNIX: From the Draw menu choose Arc. Then choose 3 Points.
Now specify three points of the arc.

1. Specify the start point (of the arc). First enter endp. Then select a line. The arc snaps to {the
endpoint of the line / its endpoint}.

2. Specify the second point (of the arc). First enter poi. Then select a point. The arc snaps to {the
point / it}.

3. Specify the endpoint (of the arc).

9.2.1.3.2 More Aggregated Version of Text 3

To draw an arc by specifying three points.
First start the ARC command using one of these methods:
Windows: From the Arc flyout on the Draw toolbar, choose 3 Points.
DOS and UNIX: From the Draw menu choose Arc. Then choose 3 Points.
Now specify three points of the arc.

1. Specify the start point (of the arc) by entering endp and selecting a line so that the arc snaps to
the endpoint of the line.

2. (i) Specify the second point (of the arc) by entering poi and selecting a point so that the arc snaps
to {the point / it}.
(i1) Specify the second point (of the arc) by entering poi and selecting a point (for the arc) to snap
to.

3. Specify the endpoint (of the arc).
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9.2.1.3.3 Running Version of Text 3

To draw an arc by specifying three points.

1. Start the ARC command using one of these methods:
Windows: From the Arc flyout on the Draw toolbar, choose 3 Points.
DOS and UNIX: From the Draw menu choose Arc. Then choose 3 Points.

2. (Specify three points of the arc.) First specify the start point (of the arc) by entering endp and
selecting a line so that the arc snaps to the endpoint of the line. Then specify the second point (of
the arc) by entering poi and selecting a point {so that the arc snaps to the point / so that the arc
snaps to it / (for the arc) to snap to}. Finally, specify the endpoint (of the arc).
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9.2.1.4 Based on IMD Text 4: pages 48/9

9.2.1.4.1 Baseline Version of Text 4

(b)
First choose Multiline Style from the Data menu. The Multiline Styles dialog box appears.

To define a multiline style

(@)

First choose Multiline Style from the Data menu.
Then specify the properties of the multiline.

1. In the Multiline Styles dialog box, choose Multiline Properties.

2. In the Multiline Properties dialog box, select Display Joints to display a line at the vertices of the multiline.

3. (In the Multiline Properties dialog box,) Define the startpoint of the multiline. Select a line under Caps or
select an arc Under Caps.

4. (In the Multiline Properties dialog box,) Define the endpoint of the multiline. Select a line under Caps or
select an arc under Caps.

5. (In the Multiline Properties dialog box, ) Enter an angle.

6. (In the Multiline Properties dialog box,) Define background fill color. First select On Under Fill to display
a background color. Then choose Color. Finally, select the background fill color from the Select Color dialog
box.

7. (In the Multiline Properties dialog box,) Choose OK to return to the Multiline Styles dialog box.

Then specify the properties of the multiline.

1. Choose Multiline Properties. The Multiline Properties dialog box appears.

2. Select Display Joints to display a line at the vertices of the multiline.

3. Define the startpoint of the multiline. Select a line under Caps or select an arc Under Caps.
4. Define the endpoint of the multiline. Select a line under Caps or select an arc under Caps.
5. Enter an angle.

6. Define background fill color. First select On Under Fill to display a background color. Then choose Color.
The Select Color dialog box appears. Select the background fill color.

7. Choose OK to return to the Multiline Styles dialog box. The Multiline Properties dialog box disappears.

(a,b)
Then save the style.

1. Under Name, enter {the name of the style / a name}.

2. Under Description, enter {the description (of the style) / a description}.
3. Select Add to add the style to the drawing.

4. Select Save to save the style to a file.

(a) Finally, choose OK.
(b) Finally, choose OK. The dialog box Multiline Style disappears.
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9.2.1.4.2 More Aggregated Version of Text 4

To define a multiline style
()
First choose Multiline Style from the Data menu.
Then specify the properties of the multiline.
1. In the Multiline Styles dialog box, choose Multiline Properties.
2. In the Multiline Properties dialog box, select Display Joints to display a line at the vertices of the multiline.

3. (In the Multiline Properties dialog box,) Define the startpoint and the endpoint of the multiline by selecting
a line or an arc under Caps.

4. (In the Multiline Properties dialog box,) Enter an angle.

5. (In the Multiline Properties dialog box,) Define background fill color by first selecting On Under Fill to
display a background color, then choosing Color, and finally selecting the background fill color from the
Select Color dialog box.

6. (In the Multiline Properties dialog box,) Choose OK to return to the Multiline Styles dialog box.

(b)
First choose Multiline Style from the Data menu. The Multiline Styles dialog box appears.
Then specify the properties of the multiline.

1. Choose Multiline Properties. The Multiline Properties dialog box appears.

2. Select Display Joints to display a line at the vertices of the multiline.

3. Select a line or an arc Under Caps to define the startpoint of the multiline and to define the endpoint of the
multiline.

4. Enter an angle.

5. Define background fill color by first selecting On Under Fill to display a background color and then
choosing Color. The Select Color dialog box appears. Select the background fill color.

6. Choose OK to return to the Multiline Styles dialog box, so that the Multiline Properties dialog box
disappears.

(a,b)
Then save the style.
1. Under Name, enter {the name of the style / a name}.
2. Under Description, enter {the description (of the style) / a description}.
3. Select Add to add the style to the drawing.
4. Select Save to save the style to a file.

(a) Finally, choose OK.
(b) Finally, choose OK, so that the dialog box Multiline Style disappears.
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9.2.1.4.3 Semi-Running version of Text 4

We have swapped numbering, and tried a running version. However, the specification of
the multiline properties has so many substeps, that the realisation by a running text does not
really seem viable. Therefore, we include here a list using numbers at the top level and
linguistic markers at the embedded level.

To define a multiline style
()
1. Choose Multiline Style from the Data menu.
2. Specify the properties of the multiline.
First choose Multiline Properties in the Multiline Styles dialog box.

Then select Display Joints in the Multiline Properties dialog box, to display a line at the vertices of the
multiline.

Then define the startpoint and endpoint of the multiline by selecting a line or an arc Under Caps, and (then)
enter an angle.

Then define the background fill color by first selecting On Under Fill to display a background color, then
choosing Color, and finally selecting the background fill color from the Select Color dialog box.

Finally, choose OK to return to the Multiline Styles dialog box.

(b)
1. Choose Multiline Style from the Data menu. The Multiline Styles dialog box appears.

2. Specify the properties of the multiline. First choose Multiline Properties. The Multiline Properties dialog
box appears.

Then select Display Joints to display a line at the vertices of the multiline.

Then select a line or an arc Under Caps to define the startpoint of the multiline and to define the endpoint
of the multiline.

Then enter an angle.

Then define the background fill color by first selecting On Under Fill to display a background color and
then choosing Color, so that the Select Color dialog box appears. Select the background fill color.

Finally, choose OK to return to the Multiline Styles dialog box, so that the Multiline Properties dialog box
disappears.

(a,b)

3. Save the style. First, enter {the name of the style / a name} under Name, then enter {the description (of the
style) / a description }under Description, then select Add to add the style to the drawing, and finally select
Save to save the style to a file.

4.(a) Finally, choose OK.
(b) Finally, choose OK, so that the dialog box Multiline Style disappears.
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9.2.1.5 Based on IMD Text 5: page 75

9.2.1.5.1 Baseline version of Text 5

To define a boundary set in a complex drawing
1. Open the Boundary Hatch dialog box using one of these methods:
Windows: From the Hatch flyout on the Draw toolbar, choose Hatch.
DOS and UNIX: From the Draw menu, choose Hatch
2. (a) Under Boundary choose Advanced.
(b) Under Boundary choose Advanced. The Advanced Options dialog box appears.
3. (a) In the Advanced Options dialog box, choose Make New Boundary Set.
(b) Choose Make New Boundary Set.

4. Define the boundary set. First specify the corner points at the Select Objects prompt. Then Press
Return.

. (a) In the Advanced Options dialog box, choose OK.

W

6. In the Boundary Hatch dialog box, choose Pick Points.

7. Specify the internal point.

8. Press Return.

9. In the Boundary Hatch dialog box, choose Apply to apply the hatch.

(b) In the Advanced Options dialog box, choose OK. The Advanced Options dialog box disappears.

9.2.1.5.2 More Aggregated Version of Text 5

To define a boundary set in a complex drawing

1. Open the Boundary Hatch dialog box using one of these methods:
Windows: From the Hatch flyout on the Draw toolbar, choose Hatch.
DOS and UNIX: From the Draw menu, choose Hatch

(@)

2. Under Boundary choose Advanced and (then) in the Advanced Options dialog box, choose Make
New Boundary Set.

3. To define the boundary set, (first) specify the corner points at the Select Objects prompt and
(then) press Return.

4. In the Advanced Options dialog box, choose OK.

5. In the Boundary Hatch dialog box, choose Pick Points, (then) specify the internal point, (then)
press return, and (finally) choose Apply to apply the hatch.

(b)
2. Under Boundary choose Advanced, so that the Advanced Options dialog box appears, then
choose Make New Boundary Set.

3. To define the boundary set, (first) specify the corner points at the Select Objects prompt and
(then) Press Return.

4. In the Advanced Options dialog box, choose OK, so that the Advanced Options dialog box
disappears.

5. In the Boundary Hatch dialog box, choose Pick Points, (then) specify the internal point, (then)
press return and finally choose Apply to apply the hatch.
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9.21

.5.3 Running Version of Text 5

(b)

(a)

To define a boundary set in a complex drawing
First open the Boundary Hatch dialog box using one of these methods:

Windows: From the Hatch flyout on the Draw toolbar, choose Hatch.
DOS and UNIX: From the Draw menu, choose Hatch

Then choose Advanced under Boundary. In the Advanced Options dialog box, choose Make New
Boundary Set. Then define the boundary set by (first) specifying the corner points at the Select
Objects prompt and (then) pressing Return. Then choose OK in the Advanced Options dialog box.
Finally, in the Boundary Hatch dialog box, choose Pick Points, (then) specify the internal point,
(then) press return, and (finally) choose Apply to apply the hatch.

Then choose Advanced under Boundary, so that the Advanced Options dialog box appears, Choose
Make New Boundary Set. Then define the boundary set by (first) specifying the corner points at
the Select Objects prompt and (then) pressing Return. Then choose OK in the Advanced Options
dialog box. The Advanced Options dialog box disappears. Finally, in the Boundary Hatch dialog
box, choose Pick Points, (then) specify the internal point, (then) press return and finally choose
Apply to apply the hatch.
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9.2.2 CZECH

9.2.2.1 Based on IMD Text 1: pages 47-48

9.2.2.1.1 Baseline Text 1

Vytvoreni stylu multi¢ary
Nejdtive oteviete dialogové okno Styly multicdry jednim z nasledujicich zpiisobii:

Windows: Vyberte Styly multi¢dry z nastrojového panelu Viastnosti objektii nebo vyberte Styl
multi¢dry z menu Data.

DOS and UNIX: Vyberte Styl multicdry z menu Data.
Nyni pfidejte elementy ke stylu.
(a)
1. Vyberte Viastnosti prvkii.
2. V dialogovém okné& Vlastnosti prvkit zadejte {posunuti/vzdjemnou vzddlenost} elementii
multi¢éry.
3. Definujte element.
Nejdiive vyberte Pridat v dialogovém panelu Viastnosti prvkii, abyste pfidali (jeden) element.

Nyni v dialogovém panelu Viastnosti prvkii vyberte Barva, abyste ur€ili barvu tohoto elementu.
Potom barvu (elementu) vyberte v dialogovém panelu Vybér barvy.

Nakonec v dialogovém okné Vlastnosti prvkit vyberte Typ &dry, abyste ur€ili typ ¢ary tohoto
elementu. Potom typ ¢ary (elementu) vyberte v dialogovém panelu Vyber typii car.

Opakujte tyto kroky, abyste definovali dalsi elementy.
4. Vyberte OK, abyste ulozili vlastnosti elementii multi¢ary.
(b)
1. Vyberte Vlastnosti prvkii. Objevi se dialogovy panel Viastnosti prvkii.
2. Zadejte {posunuti/vzdjemnou vzdilenost} elementi multi¢ary.
3. Definujte element.
Nejdtive vyberte Pridat, abyste pfidali (jeden) element.

Nyni vyberte Barva, abyste ur€ili barvu tohoto elementu. Objevi se dialogovy panel Vybér
barvy. Vyberte barvu (elementu). Dialogovy panel Vybér barvy zmizi

Nakonec vyberte Typ cdry, abyste urcili typ €ary tohoto elementu. Objevi se v dialogovy panel
Vyber typii car. Vyberte typ Cary (elementu). Dialogovy panel Vybér typii car zmizi.

Opakujte tyto kroky, abyste definovali dalsi elementy.

4. Vyberte OK, abyste ulozili vlastnosti elementii multiCary. Dialogovy panel Viastnosti prvkii
Zmizi.

This is a version with the following schematic structure:

Definujte element.

1.(Nejdtive) ...

2. (Nyni)...

3. (Nakonec)...

4. () Opakujte tyto kroky, abyste definovali dalsi elementy.

Another possibility is to employ the following schematic structure:

Definujte elementy opakovanim nésledujicich krokd.
1.(Nejdtive) ...

2. (Nyni)...

3. (Nakonec)...
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If there would be only one step to repeat, singular number should be used, and running
text rather than list.

9.2.2.1.2 More aggregated Text 1

Vytvoreni stylu multi¢ary

Nejdiive oteviete dialogové okno Styly multicdry jednim z nasledujicich zpiisobii:
Windows: Vyberte Styly multi¢dry z nastrojového panelu Viastnosti objektii nebo z menu Data.
DOS and UNIX: Vyberte Styl multicdry z menu Data.

Nyni pfidejte elementy ke stylu.

(@)
1. Vyberte Vlastnosti prvkii a potom v dialogovém okné Viastnosti prvkii zadejte
{posunuti/vzajemnou vzdélenost} elementd multiary.

2. Definujte element.
Nejdiive vyberte Pridat v dialogovém panelu Viastnosti prvkii, abyste pfidali (jeden) element.

Nyni v dialogovém panelu Viastnosti prvkii vyberte Barva, abyste ur€ili barvu tohoto elementu,
a potom barvu (elementu) vyberte v dialogovém panelu Vybér barvy.

Nakonec v dialogovém okné Vlastnosti prvkii vyberte Typ &dry, abyste ur€ili typ ary tohoto
elementu, a potom typ ¢ary (elementu) vyberte v dialogovém panelu Vybér typii car.

Opakujte tyto kroky, abyste definovali dalsi elementy.
4. Vyberte OK, abyste ulozili vlastnosti elementii multi¢ary.

9.2.2.1.3 Running version of Text 1

Vytvoreni stylu multi¢ary

Nejdtive oteviete dialogové okno Styly multicdry jednim z nasledujicich zpiisobii:
Windows: Vyberte Styly multicdry z nastrojového panelu Viastnosti objektii nebo z menu Data.
DOS and UNIX: Vyberte Styl multi¢dry z menu Data.

Nyni pfidejte elementy ke stylu.

(@)

1. Vyberte Vlastnosti prvkii a potom v dialogovém okné Viastnosti prvkii zadejte
{posunuti/vzajemnou vzdélenost} elementd multiary.

2. Definujte element.

Nejdiive vyberte Pridat v dialogovém panelu Viastnosti prvkii, abyste pfidali (jeden) element.
Nyni v dialogovém panelu Viastnosti prvkit vyberte Barva, abyste ur€ili barvu tohoto elementu, a
potom barvu (elementu) vyberte v dialogovém panelu Vybér barvy. Nakonec v dialogovém okné
Vlastnosti prvkii vyberte Typ cdry, abyste ur€ili typ Cary tohoto elementu, a potom typ ¢ary
(elementu) vyberte v dialogovém panelu Vybér typii éar. Opakujte tyto kroky, abyste definovali
dalsi elementy.

4. Vyberte OK, abyste ulozili vlastnosti elementii multi¢ary.
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9.2.2.2 Based on IMD Text 2: page 46

9.2.2.2.1 Baseline Text 2

Nakresleni krivky (sloZené) z piimek a oblouku
Nejdtive nakreslete rovny segment.
1.Spustte ptikaz Krivka jednim z nésledujicich zplisobii:
Windows: Z plovouciho ikonového menu K#ivka na nastrojovém panelu Kresli vyberte Krivka.
DOS and UNIX: Z menu Kresli vyberte K¥ivka.
2.Urcete pocatecni bod rovného segmentu.
3.Ur¢ete koncovy bod rovného segmentu.
Potom nakreslete oblouk.

1.(a) Pfepnéte do rezimu Kresleni obloukit. Nejdiive zadejte 0. Potom vyberte OK v dialogovém
panelu Potvrzeni reZimu kresleni obloukii.

(b) Piepnéte do rezimu Kresleni obloukii. Zadejte o. Objevi se dialogovy panel Potvrzeni reZimu
kresleni obloukii. Vyberte OK.

2.Urcete koncovy bod oblouku.
Potom nakreslete dalsi rovny segment.

1.(a) Vratte se do rezimu Kresleni iisecek. Nejdiive zadejte [. Potom vyberte OK v dialogovém
panelu Potvrzeni reZimu kreslent tisecek.

(b) Vrat'te se do rezimu Kresleni iisecek. Zadejte I. Objevi se dialogovy panel Potvrzeni reZimu
kreslent lisecek. Vyberte OK.

2.Zadejte vzdalenost use€ky od koncového bodu oblouku.
3.Zadejte thel usecky ve vztahu ke koncovému bodu oblouku.

Nakonec stisknéte Enter, abyste kiivku ukon¢ili.

9.2.2.2.2 More Aggregated Version of Text 2

Nakresleni kiivky (sloZené) z piimek a oblouku
Nejdtive nakreslete rovny segment.
1.Spustte ptikaz Kivka jednim z nésledujicich zplisobii:
Windows: Z plovouciho ikonového menu K#ivka na nastrojovém panelu Kresli vyberte Krivka.
DOS and UNIX: Z menu Kresli vyberte K¥ivka.
2.Urcete poatecni a koncovy bod rovného segmentu.
Potom nakreslete oblouk.

(a) 1. Pfepnéte do reZimu Kresleni obloukii zadanim o vybranim OK v dialogovém panelu Potvrzeni
rezimu kresleni obloukii.

2. Ur&ete koncovy bod oblouku.
Potom nakreslete dalsi rovny segment.

(a) 1.Vrat'te se do rezimu Kresleni iise¢ek zadanim [ a vybranim OK v dialogovém panelu Potvrzent
reZimu kresleni tisecCek.

2. Zadejte vzdalenost a thel isecky ve vztahu ke koncovému bodu oblouku.

Nakonec stisknéte Enter, abyste kiivku ukon¢ili.
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9.2.2.2.3 Running version of Text 2

Nakresleni krivky (sloZené) z piimek a oblouku
1.Nakreslete rovny segment.
Nejdtive spust'te ptikaz K#ivka jednim z nasledujicich zpiisobii:
Windows: Z plovouciho ikonového menu K#ivka na nastrojovém panelu Kresli vyberte Krivka.
DOS and UNIX: Z menu Kresli vyberte K¥ivka.
Potom urcete pocate¢ni a koncovy bod rovného segmentu.

2. Nakreslete oblouk. Nejdiive ptepnéte do reZzimu Kresleni obloukii zaddnim o vybranim OK v
dialogovém panelu Potvrzeni reZimu kresleni obloukii. Potom ur&ete koncovy bod oblouku.
3. Nakreslete dalsi rovny segment. Nejdiive se vratte do rezimu Kresleni tisecek zaddanim [ a

vybranim OK v dialogovém panelu Potvrzeni reZimu kresleni tisecek. Potom zadejte vzdalenost a
uhel dseCky ve vztahu ke koncovému bodu oblouku.

4. Stisknéte Enter, abyste kiivku ukon¢ili.
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9.2.2.3 Based on IMD Text 3: page 58

9.2.2.3.1 Baseline Version of Text 3

Nakresleni oblouku

Nejdtive spust'te ptikaz Oblouk jednim z ndsledujicich zptisobii:
Windows: Z plovouciho ikonového menu Oblouk na nastrojovém panelu Kresli vyberte 3 body.
DOS and UNIX: Z menu Kresli vyberte Oblouk. Potom vyberte 3 body.

Nyni uréete tfi body oblouku.
1. Urcete poCatecni bod (oblouku). Njediive zadejte kon. Potom vyberte ¢aru. Oblouk se pfichyti
{ke koncovému bodu &ary / kjejimu koncovému bodu}.
2. Ur&ete druhy bod (oblouku). Nejdiive zadejte bod. Potom vyberte bod. Oblouk se {k bodu / k
nému} piichyti.
3. Ur¢ete koncovy bod (oblouku).

9.2.2.3.2 More Aggregated Version of Text 3

Nakresleni oblouku uréenim (jeho) tfi bodii

Nejdtive spust'te ptikaz Oblouk jednim z ndsledujicich zptisobii:
Windows: Z plovouciho ikonového menu Oblouk na néastrojovém panelu Kresli vyberte 3 body.
DOS and UNIX: Z menu Kresli vyberte Oblouk. Potom vyberte 3 body.

Nynf urete tfi body oblouku.
1. Urete poatecni bod (oblouku) zaddnim kon a vybranim Céry, takZe oblouk se pfichyti {ke
koncovému bodu &ary / kjejimu koncovému bodu}.
2. Ur€ete druhy bod (oblouku) zadanim bod a vybranim bodu, takze oblouk se {k bodu / k nému}
pfichyti.
3. Urcete koncovy bod (oblouku).

9.2.2.3.3 Running Version of Text 3

Nakresleni oblouku uréenim (jeho) tii bodii

1. Spust'te piikaz Oblouk jednim z nasledujicich zpiisobi:
Windows: Z plovouciho ikonového menu Oblouk na néstrojovém panelu Kresli vyberte 3 body.
DOS and UNIX: Z menu Kresli vyberte Oblouk. Potom vyberte 3 body.

2. (Ur&ete tii body oblouku.) Nejdiive urcete pocitecni bod (oblouku) zaddnim kon a vybranim Céry,
takZe oblouk se pfichyti {ke koncovému bodu ¢ary / kjejimu koncovému bodu }. Potom urcete
druhy bod (oblouku) zaddnim bod a vybranim bodu, takze oblouk se {k bodu / k nému} pfichyti.

Nakonec uréete koncovy bod (oblouku).
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9.2.2.4 Based on IMD Text 4: pages 48/9

9.2.2.4.1 Baseline Version of Text 4

Definovani stylu multi¢ary

(@)

Nejdiive vyberte Styl multicdry z menu Data.

Potom urCete vlastnosti multi¢ary.
1. V dialogovém panelu Styly multicdry vyberte Vlastnosti multic¢dry.
2.V dialogovém panelu Viastnosti multi¢dry vyberte Zobraz klouby, abyste zobrazili ¢aru/y ve vrcholech
multiCary.
3. (V dialogovém panelu Viastnosti multic¢dry) Definujte po¢ate¢ni bod multi¢ary. Pod Zakonceni Vyberte
usecku nebo pod Zakonceni vyberte oblouk

4. (V dialogovém panelu Viastnosti multic¢dry) Definujte koncova bod multi¢ary. Pod Zakonceni Vyberte
usecku nebo pod Zakonceni vyberte oblouk

5. (V dialogovém panelu Viastnosti multi¢dry) Zadejte dhel.

6. (V dialogovém panelu Viastnosti multicdry) Definujte barvu pro vyplnéni pozadi. Nejdiive vyberte Ano
pod Vyplnéni, abyste barvu pozadi zobrazili. Potom vyberte Barva. Nakonec vyberte barvu pro vyplnéni
pozadi z dialogového panelu Vybér barvy.

7. (V dialogovém panelu Viastnosti multic¢dry) Vyberte OK, abyste se vratili do dialogového panelu Styly
multicdr.

(b)

Nejdiive vyberte Styl multi¢dry z menu Data. Objevi se dialogovy panel Styly multicdr.

Potom urc€ete vlastnosti multi¢ary.
1. Vyberte Viastnosti multic¢dary. Objevi se dialogovy panel Viastnosti multicary.
2. Vyberte Zobraz klouby, abyste zobrazili ¢aru/y ve vrcholech multi¢éry.
3. Definujte pocéate¢ni bod multi¢ary. Pod Zakonéeni Vyberte dseCku nebo pod Zakonceni vyberte oblouk
4. Definujte koncova bod multi¢ary. Pod Zakonéeni Vyberte iseCku nebo pod Zakonceni vyberte oblouk
5. Zadejte thel.

6. Definujte barvu pro vyplnéni pozadi. Nejdfive vyberte Ano pod Vyplnéni, abyste barvu pozadi zobrazili.
Potom vyberte Barva. Objevi se dialogovy panel Vybér barvy. Vyberte barvu pro vyplnéni pozadi.

7. Vyberte OK, abyste se vrtili do dialogového panelu Styly multi¢dr. Dialogovy panel Viastnosti multic¢dry
zmizi.

(a,b)

Potom styl uloZte.
1. Pod Jméno zadejte {nazev stylu / ndzev}.
2. Pod Popis zadejte {popis (stylu) / jeho popis}.
3. Vyberte Pridat, abyste styl pfidali k vykresu.
4. Vyberte UloZit, abyste styl uloZili do souboru.

(a) Nakonec vyberte OK.
(b) Nakonec vyberte OK. Dialogovy panel Styly multic¢dr zmizi.
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9.2.2.4.2 More Aggregated Version of Text 4

Definovani stylu multi¢ary

(@)

Nejdtive vyberte Styl multicdry z menu Data.

Potom urCete vlastnosti multi¢ary.
1. V dialogovém panelu Styly multicdry vyberte Vlastnosti multic¢dry.
2.V dialogovém panelu Viastnosti multi¢dry vyberte Zobraz klouby, abyste zobrazili ¢aru/y ve vrcholech
multiCary.
3. (V dialogovém panelu Viastnosti multic¢dry) Definujte poCate¢ni a koncovy bod multi¢ary vybranim dsecky
nebo oblouku pod Zakonceni.
5. (V dialogovém panelu Viastnosti multicdry) Zadejte thel.

6. (V dialogovém panelu Viastnosti multi¢dry) Abyste definovali barvu pro vyplnéni pozadi, nejdiive vyberte
Ano pod Vyplnéni, abyste barvu pozadi zobrazili, potom vyberte Barva a nakonec z dialogového panelu
Vybér barvy vyberte barvu pro vyplnéni pozadi.

7. (V dialogovém panelu Viastnosti multi¢dry) Vyberte OK, abyste se vritili do dialogového panelu Styly
multicdr.

(b)
Nejdiive vyberte Styl multi¢dry z menu Data. Objevi se dialogovy panel Styly multicdr.
Potom urCete vlastnosti multi¢ary.
1. Vyberte Viastnosti multic¢dry. Objevi se dialogovy panel Viastnosti multicary.
2. Vyberte Zobraz klouby, abyste zobrazili ¢aru/y ve vrcholech multi¢ary.
3. Definujte po¢éte¢ni a koncovy bod multi¢ary vybranim tsecky nebo oblouku pod Zakonceni.
5. Zadejte thel.

6. Abyste definovali barvu pro vyplnéni pozadi, nejdiive vyberte Ano pod Vyplnéni, abyste barvu pozadi
zobrazili, potom vyberte Barva. Objevi se dialogovy panel Vybér barvy. Vyberte barvu pro vyplnéni pozadi.

7. Vyberte OK, abyste se vritili do dialogového panelu Styly multicdr, takze dialogovy panel Viastnosti
multicdry zmizi.

(a,b)

Potom styl ulozte.
1. Pod Jméno zadejte {nazev stylu / ndzev}.
2. Pod Popis zadejte {popis (stylu) / jeho popis}.
3. Vyberte Pfidat, abyste styl pfidali k vykresu.
4. Vyberte UloZit, abyste styl uloZili do souboru.

(a) Nakonec vyberte OK.
(b) Nakonec vyberte OK, takZe dialogovy panel Styly multi¢dr zmizi.
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9.2.2

4.3 Semi-Running version of Text 4

(b)

Definovani stylu multic¢ary

(@)

1. Vyberte Styl multi¢dry z menu Data.
2. Urcete vlastnosti multi¢éry.

Nejdiive vyberte Viastnosti multi¢dry v dialogovém panelu Styly multicdry.

Potom vyberte Zobraz klouby vdialogovém panelu Viastnosti multicdry, abyste zobrazili ¢aru/y ve vrcholech
multiCary.

Potom (v dialogovém panelu Viastnosti multicdry) definujte pocate¢ni a koncovy bod multi¢ary vybranim
usecky nebo oblouku pod Zakonceni a (potom) zadejte thel.

Potom (V dialogovém panelu Viastnosti multicdry) abyste definovali barvu pro vyplnéni pozadi, nejdiive
vyberte Ano pod Vyplnéni, abyste barvu pozadi zobrazili, potom vyberte Barva a nakonec z dialogového
panelu Vybér barvy vyberte barvu pro vyplnéni pozadi.

Nakonec (V dialogovém panelu Viastnosti multi¢dry) vyberte OK, abyste se vratili do dialogového panelu
Styly multiéar.

1. vyberte Styl multicdry z menu Data. Objevi se dialogovy panel Styly multicdr.
2. urcete vlastnosti multicary.

Nejdiive vyberte Viastnosti multicdry. Objevi se dialogovy panel Viastnosti multicdry.
Potom vyberte Zobraz klouby, abyste zobrazili ¢aru/y ve vrcholech multicéry.

Potom definujte pocate¢ni a koncovy bod multiCary vybranim dsecky nebo oblouku pod Zakonceni a (potom)
zadejte dhel.

Potom, abyste definovali barvu pro vyplnéni pozadi, nejdfive vyberte Ano pod Vyplnéni, abyste barvu pozadi
zobrazili, potom vyberte Barva. Objevi se dialogovy panel Vybér barvy. Vyberte barvu pro vyplnéni pozadi.

Potom vyberte OK, abyste se vritili do dialogového panelu Styly multicdr, takze dialogovy panel Viastnosti
multicdry zmizi.

(a,b)
3. Styl uloZte. Nejdiive pod Jméno zadejte {nazev stylu / ndzev}, potom pod Popis zadejte {popis (stylu) / jeho

popis}, potom vyberte Pridat, abyste styl pfidali k vykresu a nakonec vyberte UloZit, abyste styl uloZzili do
souboru.

(a) Nakonec vyberte OK.
(b) Nakonec vyberte OK, takzZe dialogovy panel Styly multic¢dr zmizi.
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9.2.2.5 Based on IMD Text 5: page 75

9.2.2.5.1 Baseline version of Text 5

Definovani hrani¢ni mnozZiny v komplexnim vykrese
1. Oteviete dialogovy panel Hrani¢ni mnoZina jednim z nésledujicich zptisobii:
Windows: Z plovouciho ikonového menu Srafyna ndstrojovém panelu Kresli vyberte Srafy.
DOS a UNIX: Z menu Kresli vyberte Srafy.
2. (a) Pod Hranice Srafovdni vyberte Pokrocilé.
(b) Pod Hranice Srafovdni vyberte Pokrocilé. Objevi se dialogovy panel Pokrocilé moZnosti.
3. (a) V dialogovém panelu Pokrocilé moznosti vyberte Tvorit novou hraniéni mnozinu.
(b) Vyberte Tvorit novou hraniéni mnoZinu.

4. Definujte hrani¢ni mnoZinu. Nejdfive pii vyzvé Vybér objektii urlete rohové body hraniéni
mnoZziny. Potom stisknéte Enter.

5. (a) V dialogovém panelu Pokrocilé moznosti vyberte OK.
(b) V dialogovém panelu Pokrocilé moZnosti vyberte OK. Dialogovy panel Pokrocilé moZnosti
zZmizi.

. V dialogovém panelu Hrani¢ni Srafovdni vyberte Vybér objektii.

. Stisknéte Enter.

. V dialogovém panelu Hranicni Srafovdni vyberte Aplikovat, abyste vysrafovali plochu.

6
7. Urcete vnitini bod.
8
9

9.2.2.5.2 More Aggregated Version of Text 5

Definovani hrani¢ni mnoZiny v komplexnim vykrese

1. Oteviete dialogovy panel Hrani¢ni mnoZina jednim z nésledujicich zptisobii:
Windows: Z plovouciho ikonového menu Srafyna ndstrojovém panelu Kresli vyberte Srafy.
DOS a UNIX: Z menu Kresli vyberte Srafy.

(@)

2. Pod Hranice Srafovdni vyberte Pokrocilé a (potom) v dialogovém panelu Pokrocilé moznosti
vyberte Tvorit novou hrani¢ni mnoZinu.

3. Abyste definovali hrani¢ni mnoZinu, nejdiive pti vyzvé Vybér objektii urCete rohové body
hrani¢ni mnoziny, a potom stisknéte Enter.
4. V dialogovém panelu Pokrocilé moznosti vyberte OK.

5. V dialogovém panelu Hranicni Srafovdni vyberte Vybér objektii, (potom) urcete vnitini bod,
(potom) stisknéte Enter a (nakonec) vyberte Aplikovat v dialogovém panelu Hranicni Srafovdni,
abyste vySsrafovali plochu.

(b)
2. Pod Hranice Srafovdni vyberte Pokrocilé, takZe se objevi dialogovy panel Pokrocilé moznosti,
potom vyberte Tvorit novou hraniéni mnoZinu.
3. Abyste definovali hrani¢ni mnoZinu, nejdiive pti vyzvé Vybér objektii urCete rohové body
hrani¢ni mnoziny, a potom stisknéte Enter.
4.V dialogovém panelu Pokrocilé moZnosti vyberte OK, takze dialogovy panel Pokrocilé moZnosti
zZmizi.
5. V dialogovém panelu Hranicni Srafovdni vyberte Vybér objektii, (potom) urete vnitini bod,

(potom) stisknéte Enter a (nakonec) vyberte Aplikovat v dialogovém panelu Hranicni srafovdni,
abyste vySrafovali plochu.

9.2.2.5.3 Running Version of Text 5

‘ Definovani hrani¢ni mnoZiny v komplexnim vykrese
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Nejdtive oteviete dialogovy panel Hrani¢ni mnoZina jednim z nasledujicich zpiisobii:
Windows: Z plovouciho ikonového menu Srafyna ndstrojovém panelu Kresli vyberte Srafy.
DOS a UNIX: Z menu Kresli vyberte Srafy.

(a)
Potom pod Hranice srafovdni vyberte Pokrocilé. V dialogovém panelu Pokrocilé moznosti
vyberte Tvorit novou hrani¢ni mnoZinu. Abyste definovali hrani¢ni mnozinu, nejdiive pfi vyzvé
Vybér objektii urCete rohové body hrani¢ni mnoziny, a potom stisknéte Enter. V dialogovém
panelu Pokrocilé moznosti vyberte OK. V dialogovém panelu Hraniéni srafovdni vyberte Vybér
objekti, potom urcete vnitini bod, potom stisknéte Enter a nakonec vyberte Aplikovat v
dialogovém panelu Hranicni Srafovdni, abyste vysrafovali plochu.

(b)

2. Pod Hranice Srafovdni vyberte Pokrocilé, takze se objevi dialogovy panel Pokrocilé moZnosti.
Vyberte Tvorit novou hranicni mnoZinu. Abyste definovali hraniéni mnoZinu, nejdfive pii vyzvé
Vybér objektii urCete rohové body hrani¢ni mnoziny, a potom stisknéte Enter. V dialogovém
panelu Pokrocilé moznosti vyberte OK, takze dialogovy panel Pokrocilé moZnosti zmizi. V
dialogovém panelu Hranicni srafovdni vyberte Vybér objektii, potom urlete vnitini bod, potom
stisknéte Enter a nakonec vyberte Aplikovat v dialogovém panelu Hraniéni Srafovdni, abyste
vySrafovali plochu.
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9.2.3 RUSSIAN

9.2.3.1 Based on IMD Text 1: pages 47-48

9.2.3.1.1 Baseline Text 1

Co3ganue CTHIISI MyJIbTUIMHUT
CHauanma OTKpOHTE AUATOTOBOEC OKHO OXHHM H3 CICAYIOMHUX CIOCOO0B!

Windows: Beibeputre myuxr Multiline Style Ha nanenu uHCTPYMEHTOB Object Properties unu
BbiOepure myHKT Multiline Style B Menro Data.

DOS and UNIX: Beibepure myskr Multiline Style B merro Data.
Teneps 100aBbTE 3TEMEHTHI B CTHIIb.
(a)
1. Hasxmure kHOLIKY Element Properties.
2. B nuanoroBoM okue Element Properties BBeIUTE CMEILCHHUE 3JIEMEHTA MYIbTHIHHAN.
3. Onpeaennre 3ICMEHT.

CHauana vaxxmute kHonky Add B quanoroBom okue Element Properties, 4To0Obl 100aBHTh
JIEMEHT.

3areM B 1uanoroBoM okHE Element Properties Haxmute KHONKY Color, 9TOOBI 331aTh IBET
3TOTO 3JICMCHTA. 3aTEM BBIOCPHTE IBCT 3JICMEHTA B AUATIOrOBOM OKHE B Select Color.

W maxoHen B 1uaoroBoM OKHE Element Properties HAXKMHUTE KHOIIKY Linetype, 4ToOBI 3a1aTh
THII JITHAH 3TOTO 3JICMEHTA. 3aTEM BBIOCPHTE THIT IHHHH 3]ICMCHTA B AUATIOTOBOM OKHE B Select
Linetype.

[ToBropure 3TH mAary, YTOOBI 3a7aTh €IIE OJUH JICMEHT.
4. Hasxmure kHONKY OK, 4TOOBI COXpAHHTH CTHJIb JJICMEHTOB MYJIbTHIHHHH.
(b)

1. Haxxmure kHOIIKY Element Properties. Ha skxpaHe OSABHTCS THATOTOBOE OKHO Element
Properties.

2. Beeaure CMEMICHHE 3IEMEHTA MYJIbTHUIHHUH.
3. OnpeaennTe 3ICMEHT.
CHavama HaxMuTe KHONKY Add, uT00BI JOOABHTH 3ICMEHT.

3areM HakMuTe KHOMKY Color, 9TOOBI 3a4aTh IBET 3TOTO 3ICMCHTA. Ha SKpaHe MOABHTCA
auanorooe okHO Select Color. Beibepure nser 3nemenTa. JlnanoroBoe okHO Select Color
HCYE3HET C IKPaHA.

U HaxoHeI HAKMHTE KHOIIKY Linetype, YTOOBI 3a8aTh THII THHUH 3TOTO 31eMeHTa. Ha sxpane
TIOSABUTCS THATIOTOBOE OKHO Select Linetype. BeibepuTe THII THHHH 371€MEHTA. /IHaI0roBOE OKHO
Select Linetype HCYE3HET C IKPAHA.

IToBropure 311 mary, YToObI 3a7aTh €IIE OJUH HJICMEHT.

4. Hasxmure kHonky OK, 4T0OBI COXPAaHUTH CTHIb 3JIEMEHTOB MYJIbTHIMHHH. [{HAIOrOBOE OKHO
Element Properties HCUE3HET C SKpPaHA.
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9.2.3.1.2 More aggregated Text 1

Co3zpanune CTI/IA MyYJILTHIIHHIT

CHauana OTKpoHTE THAIOrOBOE OKHO OJHUM H3 CICAYIOIIUX CIIOCOOO0B:
Windows: Beibepure nyskr Multiline Style Ha manenn HHCTPYMEHTOB Object Properties uiu B
MeHio Data.
DOS and UNIX: Beibepure nmyskr Multiline Style B merro Data.

Tenepp 100aBbTE 3T€MEHTHI B CTHIIb.

(@)

1. Haxxmure kHONIKY Element Properties, a 3aTeM B AHANOroBoM okue Element Properties BBeaute
CMEIICHHUE JICMEHTA MYJIbTHIHHUH.

2. OnpeAeauTe IICMEHT.

Crauama saxmute KHONKY Add B muamoroBoM okHE Element Properties, 4T00b1 JOOABHTH

3JIEMEHT.

3areM B 1uanoroBoM okHE Element Properties Haxmute KHONKY Color, 9TOOBI 331aTh IBET
3TOTO 3JICMCHTA, 3aTEM BBIOCPHUTE IBET 3JICMCHTA B JHATIOTOBOM OKHE B Select Color.

W maxoHen B 1UAIOrOBOM OKHE Element Properties HAXKMHUTE KHOIIKY Linetype, 4ToOBI 3a1aTh
THI TMHHH 3TOTO 3JICMCHTA, 3aTEM BbIOCPHTE THUII THHHHU 3JICMCHTA B AMAJIOrOBOM OKHE B Select
Linetype.

[MoBTOpHTE 3TH ATy, YTOOBI 3a7aTh CIIC OJWH 3JICMCHT.

4. Hasxmure kaonky OK, 4T0OBI COXPAaHUTH CTHIIb 3JIEMEHTOB MYJIbTHIHHUH.

9.2.3.1.3 Running version of Text 1

Co3znanne CTHIA MYJIbTHIHHIA

CHauana OTKpoHTE THAIOrOBOE OKHO OJHUM H3 CICAYIOIIHX CIIOCOOO0B:
Windows: Bsibepure myHkT Multiline Style na nanemn uactpymenros Object Properties W B
MeHro Data.
DOS and UNIX: Beibepure nyskr Multiline Style B merto Data.

Tenepp 100aBbTE 3T€MEHTHI B CTHIIb.

(a) Haxxmure kuHOTIKY Element Properties, a 3aTeéM B AMATIOTOBOM OKHE Element Properties BBeAUTS
CMEIICHHUE JICMEHTA MYJIbTHIHHUH.

OnpeaemuTe 3ICMEHT.

Cravama saxxmute KHONKY Add B tuamoroBoM okHe Element Properties, 4T00bI JOOABUTDH 3JICMCHT.
3areM B 1Han0roBoM OKHE Element Properties Haxmute KHONKY Color, 9TOOBI 3a4aTh IBET 3TOTO
3JICMEHTA, 3aTCM BBHIOCPHTE IBET 3JICMCHTA B AUATIOrOBOM OKHE B Select Color. Y1 HakoHEN B
JIUanoroBoM okue Element Properties HAXKMHUTE KHOIIKY Linetype, 4ToOBI 3a1aTh TUII THHUH 3TOTO
3JICMEHTA, 3aTCM BBHIOCPHTE THII IMHHH 3JICMCHTA B THATIOTOBOM OKHE B Select Linetype.
[ToBTOpHUTE 3TH MATH, YTOOBI 3a7aTh CIIE OJUH 3JICMCHT.

4. Hasxmure kaOnKy OK, 4T0OBI COXPAaHUTH CTHIIb 37IEMEHTOB MYJIbTHIHHHIH.
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9.2.3.2 Based on IMD Text 2: page 46

9.2.3.2.1 Baseline Text 2

PucoBanue noJIIMHIH, COCTOSIIIEI H3 OTPE3KOB NPSIMBIX H AYT
CHavama HAPUCYHTE OTPE30K MPAMOIL.
1.3anycrure xomaray PLINE ogHuM 3 CIeayrommx crioco00B:
Windows: B maimrpe Polyline Ha manenn uHCTpYyMEHTOB Draw BeIOepHTE MyHKT Polyline.
DOS and UNIX: B menro Draw Beidepure myHKT Polyline.
2.YKaKuTe HA4YANBHYIO TOUKY OTPE3Ka MPAMOIL.
3. YkaxuTe KOHEUHYIO TOUKY OTPEe3Ka HpAMOH.
3areM HApUCYHTE AYTY.
1.(a) Ilepetinure B pesxum Arc. CHa4ana HAKMHUTE KIABUILY a. 3aTeM HaxMuTe OK B AUAIOrOBOM
okHe Arc mode.

(b) Iepetinure B pexum Arc. Hasxmure xmasumy a.. Ha 3kpaHe HOSBHTCS THATIOTOBOE OKHO Arc
mode. Haxxmure kHONKY OK.

2.YKaKuTe KOHCYHYIO TOUKY AYTH.
3areM HaApUCYHTE OTPE30K MPAMOH.

1.(a) Bepaurecs B pexxum Line. CHayana HaxMuTe K1apumy /. 3areMm Haskmute OK B TMa0roBoM
okHe Line mode confirmation.

(b) Bepaurecs B pexuM Line. Haxxmute knapumy /. Ha 3kpaHe IOABHTCS THATOTOBOE OKHO Line
mode confirmation. Haxxmure xkaonky OK.

2. YkaxuTte PaCCTOAHUC IMHUH IO OTHOICHHUK) K KOHCYHOH TOUKE AYTH.
3. Vkaxmure Yroja JTHHUH IO OTHOICHHUK) K KOHCYHOH TOYKE AYTH.

W HakoHEI HAXKMHTE KIIaBHITY Return, YTOOBI 3aBCPIIUTD PUCOBAHHUC ITOTTHTTHHHUH.
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9.2.3.2.2 More Aggregated Version of Text 2

PucoBanue noJIIMHIH, COCTOSIIIEI H3 0TPE3KOB NPSIMBIX H AYT
CHavama HAPUCYHTE OTPE30K MPAMOIL.
1. 3amycrure komanxy PLINE omqHAM H3 CACAYIONIHX CIIOCOOO0B:
Windows: B mamurpe Polyline Ha maHenu HHCTPpYMEHTOB Draw BeIOEpHTE MYHKT Polyline.
DOS and UNIX: B menro Draw Boibepute nyHKT Polyline.
2.YKaKuTe HA4YANBHYIO H KOHCYHYIO TOUKY OTPE3Ka MPAMOH.
3areM HapUCYHTE AYTY.

1. Ilepeiaute B peskuM Arc HAKATHEM KIIABHINU g U HAKATHEM NMyHKTa OK B TUATOTOBOM OKHE
Arc mode.

2. VYKakuTe KOHEUHYK0 TOYKY JyTH.
3aTreM HApUCYHTE OTPE30K MPSIMOH.

(a) 1. Bepaurecs B pexxwuM Line HaxxaTieM Kinapumd [ u Haxatnem OK B
JIMATIOr0BOM OKHE Line mode confirmation.

2. YKaxkute pacCTOAHHUE U YIOJI THHUH IO OTHOIICHHUIO K KOHCYHOM TOYKE TYTH.
W Hakonen HA)XKMHUTE KI1aBuIry Return, 4ToObI 3aBEpIIUTH PHCOBAHUE MOTHIHHUH.

9.2.3.2.3 Running version of Text 2

PucoBanue no/IMINHAH, COCTOSIIIEI H3 OTPE3KOB NPSIMBIX H AYT
CHauana HapUCYHTE OTPE30K MPSIMOH.
1.3anycrure xomManay PLINE ogHAM W3 CICAYFOIUX CIIOCOOOB:
Windows: B nammrpe Polyline Ha maHenn HHCTPYMEHTOB Draw BbiOepuTe MyHKT Polyline.
DOS and UNIX: B mento Draw swibepute nyHKT Polyline.
3areM yKaXUTEe HAYAIbHYIO M KOHEUHYIO TOUKY OTPE3Ka IPAMOI.

2. Hapucyiite ayry. CHayana nepediaure B pexuM Arc HOKATHEM KIABHINH ¢ M HAKATHEM ITYHKTA
OK B 1HanoroBoM OKHE Arc mode. 3aTeM YKQKUTE KOHCUHYIO TOUKY AyTH.

3. Hapucyiire orpe3ok mpamoii. CHauama BEPHUTECH B PSKAM Line HAKATHEM KJIABHIIH [
HakaTHeM OK B TManoroBoM okHe Line mode confirmation. 3aTeM yKaXUTE PACCTOSHHE H YOI
JIMHHY 110 OTHOMICHUIO K KOHEYHOH TOYKE AYTH.

4. Hayxmure kaaBunry Return, 4ToObI 3aBEpIIATH PHCOBAHHE MOTHIHHHIH.
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9.2.3.3 Based on IMD Text 3: page 58

9.2.3.3.1 Baseline Version of Text 3

PucoBaunue ayru
CHavama 3amyCTUTe KOMAHIY Arc OOHHM U3 CIICAYIOIHX CIOCOOOB:
Windows: B naymrpe Arc Ha nasnenu HHCTPYMEHTOB Draw BBIOEPHTE IYHKT 3 points.
DOS and UNIX: B menro Draw BbiOepuTe MyHKT Arc. 3aTeM BBIOEPHTE IYHKT 3 points.
Teneps 3aalTe TPH TOYKH TYTH.
1. Ykaskute HA4YaNbHYIO TOUKY (ayru). Cravana seegure endp. 3aTem 3agaiite muam0. [yra
MIPHUBA3BIBACTCA K KOHCYHOH TOYKE JTHHHH.
2. Yxaxxure Bropyro To4ky (ayru). CHayana BBeaure poi. 3areM 3amaite Touky. Jyra
TIPHBA3BIBACTCA K 3TOH TOUKE.
3. YKa)KuTe KOHEUHYIO TOUKY (IyTH).

9.2.3.3.2 More Aggregated Version of Text 3

PucoBanue Ayru no TpeM To4Kam
CHavama 3amyCTUTe KOMAHIy Arc OOHHM U3 CICAYIOIAX CIOCOOOB:
Windows: B nmaymrpe Arc Ha nanenn HHCTPYMEHTOB Draw BBIOEPHTE IYHKT 3 points.
DOS and UNIX: B mento Draw BbiOepuTe MyHKT Arc. 3aTeM BBIOEPHTE IYHKT 3 points.
Teneps 3aaaiiTe TPH TOUKH TYTH.
1. YxaxxuTe Ha4YaNbHYH0 TOYKY AyTH BBeACHHEM endp W 3aJaHHEM JTHHHUH, IPHYEM Iyra
MIPHUBA3BIBACTCSA K KOHCYHOH TOUKE JTHHHH.
2. YKaKuTe BTOPYIO TOUKY AYTH BBEI POi H BBEIOAB TOUKY, IPHYEM JyTa MPHBA3BIBACTCI K
KOHEYHOH TOYKE JIMHHH.

3. YKa)kuTe KOHEYHYIO TOUKY (IyTH).

9.2.3.3.3 Running Version of Text 3

PucoBanue Ayra no TpeM To4Kam

CHauasa 3amycTHTe KOMaHAy Arc OJHHM H3 CICAYIOMHUX CIOCOO0B!
Windows: B maymrpe Arc Ha nanenn HHCTPYMEHTOB Draw BBIOEPHTE IYHKT 3 points.
DOS and UNIX: B mento Draw BiOepHTE MYHKT Arc. 3aTeM BBIOEPHTE IYHKT 3 points.

2. (3agaiite TpH TOYKHU AYTH.) YKAKUTE HAYATHHYIO TOUKY AYTH BBEACHHEM endp M 3a1aHHEM JHHUH,
TIPHYEM JyTa HPUBS3BIBACTCS K KOHEYHOH TOYKE THHUH. 3aTEM YKAKUTE BTOPYIO TOUKY JYTH
BBEA POi M BBIOAB TOUKY, IIPHYEM AyTra MPHBA3BIBACTCA K KOHEUHOH TOuKe 1nHuH. HakoHen

YKQKHTE KOHCYHYIO TOUKY (IyTH).
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9.2.3.4 Based on IMD Text 4: pages 48/9

9.2.3.4.1 Baseline Version of Text 4

Onpenesienne CTHIISE MYJILTHIHHIH
(a)
Crauana BeiOepure myHkt Multiline Style B menro Data.
3areM 3agaliTe CBOMCTBA MyIbTHIHHHH.
1. B nmanorosom okae Multiline Styles BeiOepute myHKT Multiline Properties.

2. B nmanorosom okHe Multiline Properties Beibepure myHkT Display joints, 4ToObI HOKA3aTh
(oTOOpa3uTh) THHHIO Y BEPIIHH MYJIbTHINHAH.

3. (B amanorosom okHe Multiline Properties) 3agaiite HAUaIBHYIO TOUYKY MyJIbTHIHHUH. B oxHE
Caps 3agaiite npsamyro uid B okHe Caps 3agaiTe ayry.

4. (B mmanoroBoM okae Multiline Properties) 3agaiiTe KOHCUHYHO TOUKY MYJIBTHIHHAH. B oxHe
Caps 3agaiite npsamyro uin B okHe Caps 3agaiTe ayry.

5. (B amanorosom okHe Multiline Properties) 3agaiite yro.

6. (B mmanorosom okae Multiline Properties) 3amaiite 3amonssromuii ueT ora. CHaUama B OKHE
Fill Ha>kmuTe kHONKY On, 4yT0oOBI MOKA3aTh IBET (oHa. 3aTeM HaxMuTe KHONKY Color. Y Hakoren
VKOKATE 3aMOTHAOMAH nBeT (poHa B quamoroBoM okHe Select Color.

7. (B amanoroBoM oxae Multiline Properties) Haxvute xaonky OK, 4ToOBI BEpHYTHCA B
auanorosoe okHo Multiline Styles.

(b)
Crauana seiOepure myHKT Multiline Style B menro Data. (Ha sxpaHe) mosBHTCSA AHATOTOBOE OKHO
Multiline Styles.

3arem 3agaiiTe CBOMCTBA MyIbTHIHHHM.

1. Betbepure myrkT Multiline Properties. (Ha sxpane) mosBuTcs auanorosoe okHO Multiline
Properties.

2. Betbepure myHKT Display joints, 4ToObI OKa3aTh (0TOOPA3HTH) JIHHHIO ¥ BEPIIHH
MYJIbTHIHHAM.

3. 3apaiite HaYATBbHYIO TOUKY MyIbTHUIMHAHE. B okae Caps 3agaiite nmpsamyio uiam B okHe Caps
3aJaiTe AyTy.

4. 3agaiiTe KOHEUHYIO TOUKY My nbTUIuHAHE. B oxkHe Caps 3amaiite npsamyro wim B okHe Caps
3aaiTe AyTYy.

5. 3agaiite yrou.

6. 3anaiire 3anonmsonmmii nBer (pona. Cravana B oxue Fill Haxxmure kHOIKy On, 4TOOBI MOKA3aTh
uBeT (pona. 3arem Haxkvute kHONKy Color. (Ha 3xpane) mossurca auanorosoe okHo Selec Color.
W HakOHEN YKAXKHUTE 3aMOTHAIOMMHA OBET (POHA.

7. Hasxmure kaonky OK, uToOb1 BepHYThCs B Auatorosoe okHO Multiline Styles. J/luanorosoe
okHO Multiline Styles Hcue3HeT (¢ 3KpaHa).

(a,b)
Tenepb COXPAHUTE CTHIIB.
1. B oxne Name 3agaiite uMs CTHIIA.
2. B oxne Description 3agaiite onucaHue CTHIA.
3. Haxxvute xHONKY Add, 4TOOBI 7OOABUTH CTHIb MYIBTHIHHUH B PHCYHOK (K PHCYHKY).
4. HaykmuTe KHOIIKY Save, YT00bI COXPAHHTh CTHIb B (paiir.

(a) Y makonen HaxkmuTe KHOMKY OK.
(b) U maxoren mHaxxmute kHOnKy OK. JlmamoroBoe okHO Multiline Styles mcue3HeT (¢ skpaHa).
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9.2.3.4.2 More Aggregated Version of Text 4

(b)

Crauana seiOepure myHkT Multiline Style B menro Data. (Ha sxpaHe) mosBHTCSA AHATOTOBOE OKHO

OnpenesieHne CBOHCTB MYJILTHIHHIH

(a)

Crauana BeiOepute myHkt Multiline Style B menro Data.
3areM 3agaliTe CBOMCTBA MYyJIbTHIHHHH.

1. B nmanorosom okae Multiline Styles BeiOepuTe myHKT Multiline Properties.

2. B nmanorosom okHe Multiline Properties Beibepure myHkT Display joints, 4ToObI HOKa3aTh
(oTOOpa3uTh) THHHIO Y BEPIIHH MYJIbTHINHAH.

3. (B amanorosom okHe Multiline Properties) 3agalite HAUaIbHYIO TOUKY MYJIbTHIHHHY 3aJaHAEM

npsAMOH uam ayru B okae Caps.

4. (B amanoroBom oxue Multiline Properties) 3agaiite KOHEUHYHO TOUKY MYJIbTHIHHHH 3aJaHHEM

npsMOH uiam ayru B okae Caps.
5. (B mmanorosom oxae Multiline Properties) 3azatire yrom.

6. (B mmanorosom okae Multiline Properties) UtoOsI 3a1aTh 3aMOTHAFOMIMI OBET (JOHA CHAUATIA
Haxkmute KHONKY On B okHe Fill, uroOsI mokasars nser (poHa, 3aTeM HaxkmuTe kHomky Color, 0
HAaKOHeI B 1uanorosoM okHe Selec Color yka)kuTe 3aHONHAIOMIH IBET (OHA.

7. (B amanorosom oxue Multiline Properties) Haxvute xkaonky OK, utoObl BEpHYTHCS B
auanorosoe okHo Multiline Styles.

Multiline Styles..

3arem 3agaiiTe CBOMCTBA MyIbTHIHHHM.

1. Betbepure myrkT Multiline Properties. (Ha sxpane) mosBuTcs nuamorosoe okHO Multiline
Properties.

2. Betbepure myHKT Display joints, 4ToObI 0Ka3aTh (0TOOPA3HTH) JIHHHIO ¥ BEPIIHH
MYJIbTHIHHAH.

3. 3agaiiTe HAYATBHYIO TOUKY M KOHEUHYIO TOUKY MYTbTHIHHUH 3aJaHHEM MPAMOH HIH IYTH B
oxae Caps.

4. 3apmaiTe yrom.

6. UtoOBI 331aTh 3aMOTHAIOMIH IBET ()OHA CHA4aTa HakMuTe KHONKY On B okHe Fill, uro6s1
moKa3aTh uBeT (poHa, 3aTeM Haxkmute KHONKY Color. (Ha 3kxpaHe) mosABHTCA AMATOTOBOC OKHO
Selec Color. Ykakute 3amoTHAFOMMI OBET (POHA.

7. Y HakoHen Haxkmute KHONKY OK, uT0oOBI BepHYThCS B AHATOroBoe okHO Multiline Styles, mpu
3ToM Amanorosoe okuo Multiline Properties mcuesHer (C 3kpaHa).

(a,b)
Tenepb COXpAaHUTE CTHIIB.

1. B okae Name 3aaaiiTe ums CTHILA.

2. B okne Description 3axalite onucanue CTHIAL

3. Haxxmute kxHONKY Add, 4TOOBI JOOABUTH CTHIb MYIBTHIHHHH B PUCYHOK (K PHCYHKY).
4. HaykMHTE KHOTIKY Save, YT00BI COXpPAaHHTh CTHIIb B (DAt

(a) U nakonen Haxxmute KHONKY OK.
(b) M maxoren Haxkmute kaonky OK, mpu sTom quanorosoe okao Multiline Styles ncuesHer (¢

JKpaHa).
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9.2.3.4.3 Semi-Running version of Text 4

Onpenesienne CTHIISE MYJILTHIHHIH
(a)
1. Beibepure myrkr Multiline Style B mento Data.
2. 3ajaiite CBOMCTBA MYJIbTHIHHAM.
Crauana BeiOepure myHKT Multiline Properties nuamorosom okxae Multiline Styles.

3arem BeiOepuTe mMyHKT Display joints, 4ToObI OKa3aTh (OTOOPA3HUTH) THHHIO Y BEPIIUH
MYJIbTHIHHAH.

3arem (B muanorosom oxae Multiline Properties) 3amaiite Ha4aIbHYIO TOYKY H KOHEYHYO TOUKY
MYJIbTHIHHAY 33JAHHEM IIPAMOHN uim Ayru B okae Caps u (3aTeM) 3amaiTe yrom.

? 3arem (B amanorosom oxxe Multiline Properties) UToObl 3a1aTh 3am0THSIOMUEA IBET (POHA
cHayana Haxmure kHonky On B okHe Fill, utoOsI oka3aTs nser (oHa, 3aTEM HAKMHUTE KHOIIKY
Color, u HakoHeN B quanoroBoM okue Selec Color ykakuTe 3aNONHAOMMIA UBET (PoHA.

W naxowner (B nmamorosom okxe Multiline Properties) HaxxmuTe kHONKY OK, 4T00BI BEPHYTHCA B
auanorosoe okHo Multiline Styles.

(b)
1. Bribepure myunkt Multiline Properties. (Ha 3xpane) mossutcs auanorooe okHo Multiline
Properties.

2. 3apaiite CBOMCTBA MYJIbTHIHHAH.

Crauana eiOepure myHkT Multiline Properties. (Ha sxpaHe) mOSBHTCSA AHATOTOBOE OKHO
Multiline Properties.

3arem BeiOepuTe myHKT Display joints, 4ToObI OKa3aTh (0TOOPA3HTh) THHHIO Y BEPIIUH
MYJIbTHIHHAH.

3areM 3agaliTe HAYAIBHYIO TOUYKY H KOHCYHYIO TOUKY MYJIbTHIHHHY 3aJaHUEM IPSIMOH HIIH AyTH
B okHe Caps u (3aTeM) 3a7aiiTe yrou.

3arem, 4TOOBI 33JaTh 3amoNHIONHH nBeT (poHA CHAUa1a HKMHUTE KHONKY On B okHe Fill, 4ToOb1
nmokasarh uset (poHa, 3ateM HaxkmuTe KHONKY Color. [TosBurcsa auarorosoe okHO Selec Color.
VYxaxuTe 3an0mHomui et GoHa.

3ateM Hakmute kHomky OK, mpu sToM muanorosoe okHo Multiline Styles Hcue3HeT (¢ 3kpaHa).

(a,b)

3. Coxpannmte cTrs. CHauasna B okHe Name 3amaiite uMs CTHIIA, 3aTeM B OKHE Description 3amgaiire
OIMCAHUE CTHJLA, 3aTEM HaXMHUTE KHONKY Add, uToOBI 70OABUTH CTHIb MYJIbTHIHHUH B PHCYHOK
(K pUCYHKY) H HAKOHELl HOKMHTE KHOIIKY Save, YT00bI COXPaHUTh CTHIIb B (haiir.

(a) U nakonen Haxxmute KHONKY OK.

(b) M maxoren Haxkmute kaonky OK, mpu 3Tom quanorosoe okao Multiline Styles ncuesHer (¢
3KpaHa).
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9.2.3.5 Based on IMD Text 5: page 75

9.2.3.5.1 Baseline version of Text 5

Onpenesienne HAGOpa rpaHMIl B CJIOZKHOM PHCYHKE

1. Otxpoiire muanorosoe okHO Boundary Hatch omauM n3 cneayromux croco6oB:
Windows: B naimrpe Hatch Ha manenn macTpyMeHTOB Draw BeiOepure mynkT Hatch.
DOS a UNIX: B menro Draw BriOepute mynkr Hatch.

2. (a) B mynkre Boundary Haxxmute kHONKY Advanced.

(b) B mynkre Boundary maxmute kHonky Advanced. Ha sxpaHe HOSBHTCS JHATOTOBOE OKHO
Advanced Options.

3. (a) B nmanorosom okHe Advanced Options HaxxmMuTe kHONKy Make New Boundary Set.
(b) Haxxmure kaonky Make New Boundary Set.

4. Onpenenure Habop rpanun. CHavana B cTpoke 3ampoca Select Objects yKaKuTe yriroBble TOYKH
HaOopa rpanuy. 3ateM HaxxMuTe Return.

5. (a) B nmanorosom okHe Advanced Options HaxMuTe kKHONKY OK.

(b) B nmamorosom okxe Advanced Options Haxvute kHOnKy OK. Jlmanorosoe okao Advanced
Options HCYE3HET (C 3KPaAHA).

. B nmaorosom okHe Boundary Hatch HaxkmuTe kHOIKY Pick Points.

6
7. YKaXuTe BHYTPCHHIOKO TOUKY.
8. Haxxmure Enter.

9

. B nmanorosom oxxe Boundary Hatch Ha>kmuTe kHODKY Apply, 4TOOBI MPHMEHUTH MITPHXOBKY.
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9.2.3.5.2 More Aggregated Version of Text 5

Onpenesienne HAGOpA rpaHMIl B CJIOZKHOM PHCYHKE

1. Otxpoiire mnanorosoe okHO Boundary Hatch omauM n3 cneayromux croco6oB:
Windows: B nammrpe Hatch Ha manenn macTpymMeHTOB Draw BeiOepure myHnkT Hatch.
DOS a UNIX: B menro Draw BriOepute mynkr Hatch.

(@)

2. B nysakre Boundary Haskmure kaonky Advanced u (3aTtem) B amatoroBoM okHe Advanced
Options Haxxmute kHonky Make New Boundary Set.

3. YroOsI onpeienuTh HAOOP rpaHMI] CHa4YaIa B CTpoke 3ampoca Select Objects yka>kute yrioBbie
TOUYKH HAOOpa rpaHMN u 3aTeM HaxMuTe Enter.

4. B nmanorosom okHe Advanced Options Hakxmute kHonky OK.

5. B amanorosom okHe Boundary Hatch Haxkmure kHOnKy Pick Points, (3aTem) ykaskure
BHYTPCHHIOK TOUYKY, (3aTeM) HakMute Enter u (HakoHeN) HAXKMHTE KHONKY Apply B AHAI0roBOM
oxae Boundary Hatch, 4ToObI mpHMEHHTH MITPHXOBKY.

(b)
2. B nysakre Boundary Haskmure kHOnKy Advanced mpu 3TOM (Ha SKpaHE) MOSBHTCSA THAIOTOBOC
okxHO Advanced Options, 3arem Haskmute kHOKY Make New Boundary Set.

3. Yrobsl onmpeacnuts HAOOP TPaHUI CHAYANA B CTPOKE 3ampoca Select Objects yKaKUTE YTIOBBIC
ToukH HaOopa rpaHul u 3aTeM Haxkmute Enter.

4. B nmanorosom okHe Advanced Options Haskmute kHonky OK, mpu 3T0M IHAIOrOBOE OKHO
Advanced Options ncue3HeT (C IKpaHa)..

5. B amanorosom okae Boundary Hatch Haxkmmre kHODKY Pick Points, (3aTem) ykaskure
BHYTPCHHIOIO TOUKY, (3aTeM) HaykmuTe Enter U (HakoHeI) HAKMHTE KHOIIKY Apply B AWaIOroBoM
oxae Boundary Hatch, 4To0b! IpHMEHHTH IITPHXOBKY.

9.2.3.5.3 Running Version of Text 5

Onpenesienne HAGOpa rpaHMIl B CJIOZKHOM PHCYHKE

Crauama otkpoite auatoroBoe okHo Boundary Hatch oguum u3 cemyrommx crocobos:
Windows: B naimrpe Hatch Ha manenn macTpyMeHTOB Draw BeiOepure myHnkT Hatch.
DOS a UNIX: B menro Draw BriOepute mynkr Hatch.

(a)
3arem HakMmute kHONMKY Advanced B myrkte Boundary. B nrnamorosom okae Advanced Options
HaxMuTe KHONKy Make New Boundary Set. 3aTem onpeaemure Habop rpaHum (a) yKa3aHHEM
YITIOBBIX TOUCK HAOOpa rpaHun U HakaTueM kHonku Enter B mmamorosom oxae Advanced
Options saxxmute kHonky OK. B nmanorosom okae Boundary Hatch masxmure xnonky Pick
Points, (3aTeM) ykakuTe BHYTPEHHIOIO TOUKY, (3aTeM) HaxkMuTe Enter i (HakoHEI) HayKMHTE
kHOTIKY Apply B AmanoroBom okae Boundary Hatch, 4To0bI mpEMEHHATD IITPHXOBKY

(b)
2. B nyskre Boundary Haskmure kaOonKy Advanced, npu 3ToM (Ha 3KpaHE) NOSBHTCS JAHATOTOBOE
okxHO Advanced Options. Haxxmure kaonky Make New Boundary Set. Uro6s1 onpenenure Habop
TPaHUL, CHa4aja B CTpoke 3ampoca Select Objects ykasKuTe YITIOBBIC TOUKH HAOOpa IpaHUI] U
3areM Haskmute Enter. B muanorosom okae Advanced Options Haxkmute kKHONIKY OK, mpu sToM
auanorosoe okHo Advanced Options Hc4e3HeT (¢ 3kpaHa). B nmanorosom okHe Boundary Hatch
HakMuTe KHONKY Pick Points, 3aTeM ykaskute BHYTPSHHIOKO TOUKY, 3aTeM HaxxMuTe Enter n
HAKOHeIl HaykMuTe KHONKY Apply B amanoroBom okae Boundary Hatch, uro6s1 mpumeHnTS
IITPHXOBKY
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9.2.4 BULGARIAN

9.2.4.1 Based on IMD Text 1: pages 47-48

9.2.4.1.1 Baseline Text 1

Ch3gaBane HA CTHII HA MYJITIIHHAS
[TepBo OTBOPETE AMATOrOBHUA mpo3oper Multiline Style kKaTo H3MOI3BATE CAUH OT CIICAHHTE MCTOIH:

Windows: Ot ¢pyuxuuonanuus pex Object Properties numu mentoTo Data, m3oepere Multiline
Style.

DOS and UNIX: Ot menroro Data, w3bepere Multiline Style.
Cera nobaBere €1€MEHTH KbM CTHIIA.
(a)

1. U3bepete Element Properties.

2. B nmanorosus npozopen Element Properties BbBeJETE OTMECTBAHETO HA €IEMEHTA HA
MYJITHIHHHATA.

3. JeuHnpaiite cIeMCHT.
ITspBo m36epere Add B nmanorosus npo3open Element Properties 3a a n0OaBUTE €IEMEHT.

Cera B quanorosus npo3open Element Properties m3depere Color, 3a Aa HOCOYHUTE IIBETA HA
enemenTa. Cien ToBa m30epere UBAT(SIEMEHT) OT Juanorosms nposopen Select Color.

Haxkpas B nuanorosus npo3open Element Properties u30depere Linetype, 3a Aa MOCOYUTE BHA HA
TuHHATA Ha edeMeHTa. Caex ToBa u30epeTe BUAA HA THHUATA HA €ICMEHTA OT JHATOTOBHA
nposoper Select Linetype.

[ToBTOpeTe TE3U CTHIKH, 32 Aa Ae(DHHUPATE APYT CICMEHT.
4. Uzbepere OK, 3a ma 3anmumieTe XapaKTCPHCTHKHUTE HA CJICMCHTHTC HA MYITHIHHHUATA.
(b)
1. Us6epete Element Properties. OTBaps ce AMAIOroBUA nposopel] Element Properties.
2. BpBeaeTe OTMECTBAHETO HA CICMEHTHTE Ha MYITHIHHHATA.
3. Je(uHnpaiite cIeMCHT.
ITepBo M3bepere Add, 3a na AOOABHTE CICMEHT.

Cera m3bepere Color, 3a aa mocounTe 1BETa HA eaeMeHTa. OTBApA CC AUATOTOBHS MPO30PEL
Select Color. 36epere mBat. JAmanorosus mposopen Select Color ce 3aTBaps.

Haxpas m30epere Linetype, 3a Ja MOCOYMTE BAA HA THHHUATA HAa exeMeHTa. OTBaps ce
IHAIOroBHA mpo3open Select Linetype. 30epeTe BUa HA THHUATA HA CICMCHTA. J[MaoroBus
mpo3open Select Linetype ce 3aTBap4.

IToBTopere T€3U CTHIKH, 3a Aa AC(DHHUPATE APYT CICMEHT.

4. U3bepere OK, 3a ma 3amumere XapaKTEPUCTHKUTE HA CICMEHTHTE HA MYITHIHHHATA.
Jwmanorosus nposopen; Element Properties ce 3aTBapsl.

This is a version with the following schematic structure:

Je(puHupaiite eIeMCHT.
1.(ITspBoO) ...

2. (Cera)...

3. (Hakpas)...

4. () [ToBropeTe Te3W CTHIKH, 32 Aa ACPHHAPATE APYT CICMCHT.

Another possibility is to employ the following schematic structure:

Je(uanpaiite €IEMEHT KaTO H3MOI3BATE CICTHUTS CTHIIKH.
1.(ITspBoO) ...




AGILE 127

2. (Cera)...
3. (Hakpas)...

If there would be only one step to repeat, singular number should be used, and running
text rather than list.

9.2.4.1.2 More aggregated Text 1

Cr3gaBane HA CTHUT HA MYJITHITHHAS
[TepBO OTBOPETE AMATOrOBHA mpo3oper Multiline Style kKaTo H3MOI3BATE CUH OT CICAHHTE MCTOIH:

Windows: Ot ¢yuxuuonanuus pex Object Properties wma mertoto Data, m3oepere Multiline
Style.

DOS and UNIX: U3bepere Multiline Style or mentoto Data.

Cera gobaBeTe €IEMEHTH KbM CTHIA.

(a)
1. U3bepete Element Properties ¥ cex TOBa BbBEACTE OTMECTBAHETO HA €IEMEHTA HA
MYJITHIHHHATA B JHATOTOBUA npo3oper Element Properties.

2. JleuHaupaiite eneMeHT.
[TepBo U3bepere Add B amanorosus npo3open Element Properties, 3a 7a JOOABHTE CIICMCHT.

Cera B auanorosus npo3open Element Properties n3depere Color, 3a 1a IOCOYUTE IBETA HA
€JIEMEHTA, a CJIeA TOBA H30epeTe UBAT OT AWATOroBus mposopen Select Color.

Haxpas B muanorosus nposopen Element Properties u3oepere Linetype, 32 Aa IOCOUHTE
JHMHUATA HA €IEMEHTA, a CIIe TOBA u30epeTe IMHMA HA SIEMEHTA OT JUAJIOrOBHA Ipo3open Select
Linetype.

[ToBToOpere T€3U CTHIKH, 32 Aa Ae(DHHUPATE APYT CICMEHT.

3. M36epere OK, 3a ma 3anumiere XapakTEPHCTUKHUTE HA €IEMEHTA HA MYITHIHHHIATA.

9.2.4.1.3 Running version of Text 1

Cr3aaBane Ha CTHII HA MYJITHIMHHS

[TepBO OTBOPETE AMATOrOBUA mpo3opel Multiline Style kKaTo H3MOI3BATE CUH OT CIICAHUTE MCTOIU:
Windows: Ot ¢yuxuuonanuus pex Object Properties wma mentoto Data, m3oepere Multiline
Style.
DOS and UNIX: Ot mentoro Data, w3bepere Multiline Style.

Cera mpubaBeTe SICMCHTH KBbM CTHIIA.

(@)
1. Us6epete Element Properties, a cieq TOBa B AUAIOTOBUA npo3opel Element Properties
BBBEACTE OTMECTBAHETO HA €IEMEHTA HA MYITHIHHHATA.
2. Jle(uHupaiite eneMeHT.

ITspBo m3bepere Add B muanorosms npo3open Element Properties, 3a 1a 10OABHTE €ICMEHT.
Cera B quanorosus npo3open Element Properties m3depere Color, 32 Aa HOCOYHUTE IIBETA HA
€JIEMEHTA, a CJIe/ TOBA H30epere UBAT 0T AuanoroBus mposopen Select Color. Hakpas B
auanorosus mposopen Element Properties m30epere Linetype, 3a Ja IOCOYNTE BAAA HA THHUATA
HA €JICMCHTA, a CI¢ TOBa M30¢peTe BUAA HA TMHHUATA OT JHATOTOBHS Mpo3oper Select Linetype.
[ToBTOpeTe TE3U CTHIKH, 32 Aa AS(DHHUPATE APYT CICMEHT.

3. M3bepere OK, 3a ma 3anumiere XapakTePHCTHKHUTE HA €IEMEHTA HA MYITHIHHUATA.
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9.2.4.2 Based on IMD Text 2: page 46

9.2.4.2.1 Baseline Text 2

Yepraene HA HOJIMIMHHA, CHCTABEHA 0T OTCEYKHU U JbI'H.
ITepBO HauepTaiiTe OTCEUKATA.
1.Craprupaiire komaraata PLINE xaTto W3M0I3BATe CAHWH OT CICIHHTE MCTOIH:

Windows: Ot mnaBamoro MeHto Polyline Ha QyHkimonanaus pex Draw, uzdepere Polyline.
DOS and UNIX: Or menroro Draw u3bepere Polyline.
2.3amalite HA4YATHATA TOYKA HA OTCEYKATA.
3.3apaiiTe KpaliHaTa TOYKA HA OTCCYKATA.
Cren ToBa HauyepTaiTe aBra.

1.(a) IIpeBxmouere B pexxum Arc. [TbpBo BbBenere a. Cren ToBa m3depere OK B THATOTOBUA
MPO30peL HA pexkuMa Arc.

(b) IIpesrroucte B pexum Arc. Bebeaere a. [TosgBsaBa ce AMATOTOBHAT MPO30PEI] HA PSIKAMA
Arc. U3bepere OK.

2.3apmaiTe KpaliHaTa TOYKA HA IBraTa.
Caen ToBa HavyepTaiiTe Apyra OTCEUKA.

1.(a) BepHere ce B pexumM Line. ITspso BbBenere [. Cnen ToBa m3depere OK B AMaTOroBUA
MPO30peEL HA pexkuMa Line.

(b) Bpaere ce B pexxuM Line. Beeenere [. [TosBsBa ce 7uanoroBusT Mpo30pel Ha peskuma Line.
H3bepere OK.

2.B’I>B6II€T6 ABJDKHHATA HA OTCCUKATA OT KpaﬁHaTa TOYKA HA Abrara.
3.B’I>B6}.'ICT6 BI'bJId HA OTCCYKATa CIIPAMO KpaﬁHaTa TOYKA Ha Abrara.

HaIcpa;I HATHCHETE Return, 3a Aa 3aBbPIIHUTC MOJTHIHHHATA.

9.2.4.2.2 More Aggregated Version of Text 2

Yepraene HA NOTMIHHIS, CHCTABEHA OT OTCEYKHU U JbIU
ITepBO HauepTaiiTe OTCEUKATA.
1.Craprupatire komanaata PLINE xaTo W3M0I3BATE CAHWH OT CICIHHTS MCTOIH:
Windows: Ot mnaBamoro MeHto Polyline Ha QpyHkumonanaus pex Draw, uzdepere Polyline.
DOS and UNIX: Ot mentoto Draw uzbepere Polyline.
2.3apaliTe HAYaTHATA U KpaifHaTa TOUKA HA OTCEYKATa.
Caen ToBa Havyeprakre qbra.
(a) 1. IIpeBrmroucTe B pekuM Arc Kato (IIBPBO) BBBEACTE @ | (C1ed ToBa) u3dbepere OK B AHATOTOBHA
MPO30pEL HA PexxuMa Arc.
2. 3apaiite KpalfHaTa TOYKA HA ABraTa.
Cren ToBa HauepTalTe qpyra OTCEUKA.

(a) 1.BbpHeTe ce B pexuM Line xato (rbpBo) BbBeaeTe [ U (crnex ToBa) m3depere OK B AMATOTOBHA
po30pen Ha pexuMa Line.

2. BbBeaere AB/DKUHATA U BI'BJIA HA OTCEYKATA CIPSAMO KpalHATA TOUYKA HA Abrara.

Haxpas natucHere Return, 3a 1a 3aBbPIIUTE MOTUIUHHATA.
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9.2.4.2.3 Running version of Text 2

Yepraene HA HOJIMIMHAS, CHCTABEHA 0T OTCEYKH U IbI'H
1. Hauepraiite oTceukara.

ITspBo craprupaiite komanzata PLINE kato u3non3Bare €auH OT CICIHUTE METOAU:

Windows: Ot mnaBamoro MeHto Polyline Ha pyHkimonanaus pex Draw, uzdepere Polyline.
DOS and UNIX: Or menroro Draw u3bepere Polyline.

Cren ToBa 3a7aliTe HAYATHATA H KPAHHATA TOYKA HA OTCCUKATA.

2. Hauepraiite apra. [TspBO MpeBKIIOYCTE B PEKHM Arc KaTO BbBEACTE a u m3depere OK B
JHAIOTOBHA MPO30pen Ha pexkuMa Arc. Cien ToBa 3amalite kpaifHaTa TOYKA HA Brara.

3. Hauepraiite npyra aera. I[TepBo ce BppHETE B pexkuM Line karo BpBeaeTe [ u m3depere OK B

JUATIOTOBHA TPO30peI Ha pexkiMa Line. Ciex ToBa BHBSACTE NBIDKHHATA M BI'bJIA HA OTCECUKATA
CIPAMO KpalHATa TOYKA HA ABrara.

4. HatucHere Retfurn, 3a a 3aBbPIINTS MO THIHHAATA.




AGILE 130

9.2.4.3 Based on IMD Text 3: page 58

9.2.4.3.1 Baseline Version of Text 3

Yepraene Ha Abra

IIspBo crapTupaiite koManaaTa ARC kaTo U3MOA3BATE €AUH OT TE3H METOAH:
Windows: Ot maBamoro MeHIO Arc Ha (PyHKOUOHATHUA pea Draw toolbar, m3depere 3 Points.
DOS and UNIX: Ot mentoro Draw m3bepere Arc. Crex ToBa m3bepere 3 Points.

Cera 3agafiTe TpH TOYKH HA JBbTaTa.
1. 3apmatite HauaTHATA TOUYKA (HA ABrarta). [IspBO BEBEACTE endp. Caen ToBa W30CpETE OTCCUKA.
Jlprara ce 3axBama 3a {KpaiHAaTa TOYKA HA JIHHUATA/ 3a CBOATA KpalHA TOYKA}.

2. 3agatite BTOpara Touka (Ha aprara). [IspBo BpBeaeTe poi. Caen ToBa m3depere Touka. Jlprata
ce 3axBamia 3a {Toukara/ Hes ).

3. 3apaiite kpaifHaTa Touka (Ha IBraTa).

9.2.4.3.2 More Aggregated Version of Text 3

Yepraene Ha Abra 0 TPH TOYKH.

IIspBo crapTupaiite koMmangaTa ARC kaTo U3MOA3BATE €AUH OT TE3H METOIH:
Windows: Ot mnaBamoro MeHI0 Arc Ha (pyHKImonaxHus pen Draw, n3depere 3 Points.
DOS and UNIX: Ot mentoro Draw u3bepere Arc. Cnex ToBa m3bdepere 3 Points.

Cera 3amaiiTe TpH TOYKH HA IBTaTa.
1. 3apmaiite HayaTHATA TOUKA (HA XbraTa), KATO BHBEACTE endp U MOCOUUTE THHHA, Taka Ye Jbrata
Jla CE 3aXBAaHE 3a KpailHaTa TOUKA HA JIMHUATA.
2. 3apmaiiTe BTOpaTa TOUKAa (Ha ABraTa), KaTo BHBEACTE poi H MOCOUYHTE TOYKA, TAKA U¢ ABraTa a ce
3axBaHE (3a TOUKATA/ 3 HEs).

3. 3agatite kpaiHaTa TOUYKA (HA ABIaTa).

9.2.4.3.3 Running Version of Text 3

Yepraene Ha Abra 0 TPH TOYKH.

1. Craprupaiite komaHmata ARC kaTo H3MOI3BATE SAWH OT TE3H METOIH:
Windows: Ot mraBamoro MeHto Arc Ha (pyHKImoHaxHus pen Draw, m3depere 3 Points.
DOS and UNIX: Ot mentoro Draw u3bepere Arc. Cnex ToBa m3bepere 3 Points.

2. (3agaiiTe Tpu TOUYKH HA Abrara.) [IspBo 3agaiite HavaIHATA TOYKA(HA ABTaTa), KATO BBBEACTE endp
H TOCOYHTE IHHUATA, TAKA YC IBraTa Aa CC 3aXBaHE 3a KpaliHaTa Touka Ha muHmaTa. Crex ToBa
3amalTe BTOpPAaTa TOUKA(HA ABraTa), KaTo BHBEACTE poi M MOCOYNTE TOUKA {TaKa Ue Ibrara aa ce
3aXBaHE 32 TOUKATa/ Taka 4e AbraTa Ja ce 3aXBaHE 3a Hed ). Hakpas 3amaiite kpaitHata Touka(Ha

JbraTa).
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9.2.4.4 Based on IMD Text 4: pages 48/9

9.2.4.4.1 Baseline Version of Text 4

3axaBane cTHII HA MYJITIIHHHSA
(@)
ITepBo u3depere Multiline Style or MeHIOTO Data.
Caen ToBa 3amaliTe XapaKTEPHCTHKATE HA MYJITHIHHAITA.
1. B amanorosus mpo3open, Multiline Styles n3depere Multiline Properties.

2. B amanorosus mposopen, Multiline Properties n3zdepere Display Joints, 3a Aa Ce OSBH JTHHIA
BB BBPXOBETE HA MYJITHIHHHATA.

3. (B nmanorosus npo3open Multiline Properties) 3ajaiire Ha4anoTo Ha MyaTuauaEITa. M30epere
muHEA 0T moaMertoTo Caps wiam u3depere asra oT noaMeHrTo Caps.

4. (B amanoroBus npo3open, Multiline Properties) 3ajaiire Kpas Ha My ITHiIMHAATA. M30epete
muHEA 0T moaMertoTo Caps wiam u3depere Asra oT moaMeHrTo Caps.

5. (B amanorosus mpo3open, Multiline Properties) BeBenere proiL

6. (B amanorosus mpo3open, Multiline Properties) 3apaiite OCHOBEH 3ambaBam IBAT. [I6pBo
m3bepere On ot moaMeHtoTo Fill, 3a na ce nosBu ocHOBHIAT 1BAT. Criex ToBa m3depere Color.
Haxkpas mocouere OCHOBEH 3aIbIBAMI OBAT OT AHAIOroBHA mpo3oper Select Color.

7. (B amanoroBus mpo3oper Multiline Properties) U36epete OK, 3a Aa Ce BbPHETE B AHANOTOBHA
mpo3open Multiline Styles.

(b)
IIspBo H30epere Multiline Style ot MeHrOTO Data. ITosBaBa ce AMANOTOBUAT npo3open Multiline
Styles.

Caen ToBa 3amaliTe XapaKTEPHCTHKHTE HA MYJITHIHHAATA.
1. 3bepere Multiline Properties. IlosBsaBa ce quanoroBuaT mpo3oper Multiline Properties.
2. U3bepere Display Joints, 3a 1a ce MOABH JIUHAS BbB BbPXOBETE HA MYITHIHHHAATA.

3. 3ajaifre HAYAJI0TO HA My ITHIHHAATA. M30epeTe muHUA 0T moaMeHI0TO Caps win u30epeTe apra
OT NoAMEHIOTO Caps.

4. 3apaitre Kpas Ha My TTUIHHEATA. M30epere muams ot moaMenroto Caps Wi H30epeTe Abra ot
noaMeHTO Caps.

5. BeBeaere proi.

6. 3ajaitre OCHOBEH 3ambJBam UBAT. [16pBo m30epere On ot noaMeHtoTo Fill, 3a fa ce mosaBu
ocHOBHIAT 1BAT. Ciiex ToBa m3depere Color. Iossasa ce muanoropuaT mposopen Select Color.

IlocoueTe OCHOBEH 3aIbIBANI IBAT.

7. U36epete OK, 3a Aa ce BpHETE B THANOTOBHA npo3open Multiline Styles. JluanoroBusar
nposopen, Multiline Properties ce 3aTBapsL.

(a,b)
Crnex ToBa 3aIHIICTE CTHIA.
1. B moneTro Name BbBeAeTe {MIMETO HAa CTHIA/ UME}.
2. B moneto Description BbBEACTE {OMACAHUETO (HA CTUA) / OMMUCAHUE }.
3. U30epete Add, 3a na nobaBuTe CTHIA KBM YEPTCHKA.
4. 3bepete Save, 3a Aa 3anmmnieTe CTUnA BbB (paiir.

(a) Haxpas uzGepere OK.
(b) Haxpas usGepere OK. lnanorosusar npo3open; Multiline Style ce 3aTBaps.
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9.2.4.4.2 More Aggregated Version of Text 4

3axaBane cTHII HA MYJITIIHHHSA
(@
ITspBo m3bepere Multiline Style ot mentoro Data.
Caen ToBa 3amaliTe XapaKTEPHCTHKATE HA MYJITHIHHAITA.
1. B qmanorosus mpo3open, Multiline Styles n3depere Multiline Properties.

2. B amanorosus mposopen, Multiline Properties n3zbdepere Display Joints, 3a Aa Ce OB THHIA
BB BBPXOBETE HA MYJITHIHHHATA.

3. (B nmanorosus npo3oper Multiline Properties) 3ajaiire HA4aI0TO B KPas HA MyJITHIHHHAATA,
KaTo m30epeTe MUHMA HIH Abra OT MOAMEHIOTO Caps.

4. (B nmanorosus npo3open Multiline Properties) BpBeneTe pIbiL

5. (B amanorosus mpo3open, Multiline Properties) 3agalite OCHOBEH 3aIIbIIBAI I[BAT, KATO IBPBO
mbepere On 0T moaAMEHIOTO Fill, 3a 1a Ce MOSBH OCHOBHHAT LBAT, KAaTO Cliex ToBa m3dbepere Color
H HAKpas NOCOYUTE OCHOBEH 3aIbJIBAII IBAT B AHATOTOBUA npo3oper Select Color.

6. (B nmanorosua npo3open Multiline Properties) N36epere OK, 3a fa c€ BBPHETE B AHATOTOBHSA
mpo3open Multiline Styles.

(b)
IIspBo m3depere Multiline Style ot mertoTo Data. IlosBsiBa ce auamoroBuar nposopen Multiline
Styles.

Cren ToBa 3aJalTe XapaKTCPHCTHKUTE HA MY ITHIHHUATA.
1. I36epere Multiline Properties. [TosBsBa ce AMANTOTOBUAT Hpo3opel, Multiline Properties.
2. U3bepere Display Joints, 3a 1a ce MOABH JTUHAS BbB BPXOBETE HA MYITHIHHHATA.

3. B nOAMEHIOTO Caps n36epeTe JIUHHAA WIH Abra, 3a Ad 3a4a4CTC HA4YAJI0TO HA MYJITHITHHHATA H
3a Aa 3a4a4CTC Kpasd Ha MYJITHIHHHATA.

4. BpBeaere »roi.

6. 3ajjaiire OCHOBCH 3aIIbIIBAMI IBAT, KATO IBPBO H30epeTe On B MOAMEHIOTO Fill, 3a 1a ce MOSABH
OCHOBHIIT LIBAT H crex ToBa m3depere Color. IlosBssa ce auanorosuit nposoper Select Color.

TTocoueTe OCHOBEH 3ambJBamI IBAT.

6. U3bepere OK, 3a 1a ce BBPHETS B AMATIOrOBHA npo3oper; Multiline Styles, 3a 1a ce 3aTBOpH
auanoroBuAT nposopen Multiline Properties.

(a,b)
Cren ToBa 3amuIIeTe CTHNIA.
1. B monero Name BBBEACTE {MMETO HA CTHIA/ HME }.
2. B monero Description BBBEACTE {ONMUCAHUCTO (HA CTHIIA) / OMUCAHHAS }.
3. 30epere Add, 3a na nobaBuTe CTHIA KBM YEPTEHKA.
4. U30epete Save, 3a Aa 3aIUIIETE CTHIA BB (Daiil.

(a) Haxpast u36epere OK.
(b) Haxpas usGepere OK, 3a 1a ce 3aTBOpH JHATOTOBHAT mpo3open Multiline Style.
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9.2.4.4.3 Semi-Running version of Text 4

3axaBane cTHII HA MYJITIIHHHSA
(@
1. Usbepere Multiline Style ot merroTO Data.
2. 3agaliTe XapakTCPHCTHKHTS HA MYJITHIHHHATA.
ITspBo w3bepere Multiline Properties B amanorosus mposopeny Multiline Styles.

Cnex toa m30epere Display Joints 8 nuamorosus npo3open Multiline Properties, 3a Aa CE MOABH
JIHHASA BBB BBPXOBCTC HA MYITHIHHHATA.

Crez ToBa 3ajaiite HAYATOTO H Kpas Ha MyITHIHHAATA, KATO H30CPETE THHUSA WK IbIA B
noaMeHI0TO Caps U (CIe TOBA) BbBEACTE BI'bIL.

Cieji ToBa 3a1aliT¢ OCHOBEH 3aIThJIBATI I[BAT, KATO IEPBO H30epeTe On oT moaMeHroTo Fill, 3a Aa ce
TIOABH OCHOBHHJT LBAT, CICA TOBA H36epere Color u HAKpasg mOCOIUTEC OCHOBCH 3aITbJIBAI LIBAT B
muanorosus mposopen Select Color.

Hakpast m30epere OK, 3a ma ce BppHETE B qHaI0roBHA nposopen. Multiline Styles.

(b)
1. U3bepere Multiline Style ot mertotro Data. [lossasa ce auanorosusaT mpo3open Multiline Styles.

2. 3agaiiTe XapaKTCpUCTHKHUTE HA MyITHIHHIATA. 1IbpBo uzdbepere Multiline Properties. IosBsiBa
ce auanoroBmaT nmposopen Multiline Properties.

Cnen tosa u3bepere Display Joints, 3a 1a C€ NOSABH JIHHUA BB BHPXOBETC HA MYJITHIHHHUATA.

Cizez ToBa H30€pETE THHIL WU Abra B HoaMeHoTo Caps, 3a 1a 3a1a1eT€ HAYAJI0TO HA
MYJTHIHHHATA U 32 Ja 3a7a7eTe Kpas Ha MyITHIHHHATA.

Cies ToBa BBBEACTE BIBIL

Cren ToBa 3ajaiite OCHOBCH 3aITBJIBAMI IBAT, KATO IBPBO m30epere On B moaMeHIOTO Fill, 3a ma ce
TOSIBH OCHOBHUAT IBAT U ciex ToBa m3depere Color, 3a Aa ce MOsSBH AHATOTOBHAT Ipo3open Select
Color. Tlocodere OCHOBHHS 3aITBIBAI IIBAT.

Haxpas u30epere OK, 3a Aa CE BBPHETE B AUATOTOBHA npo3open Multiline Styles, Taka 4e na ce
3aTBOPH AHATOTOBHUAT Npo3open Multiline Properties.

(a,b)

3. 3anumiere cTuna. ITspeo BEBEACTE { MMETO HA CTHIIA/ HME} B OICTO Name, CICA TOBA BBBEACTS
{omucanmeTo (Ha cTHia) / ommcaHue }B moIeTo Description, Cien ToBa u3depere Add, 3a na
JobaBuTe CTHIA KBM YCPTEIKA M HAKpasd u3depere Save, 3a 1a 3aMUMICTE CTHIA BBB (DAL

4. (a) Hakpas usbepere OK.

(b) Haxpas usGepere OK, 3a 1a ce 3aTBOpH JHATOTOBHAT mpo3open Multiline Style.
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9.2.4.5 Based on IMD Text 5: page 75

9.2.4.5.1 Baseline version of Text 5

Jeduanpane HA 00J1aCT 32 MIPIXOBAHE B CJI0KEH YEPTEK

1. OtBopere mmanorosus npo3open Boundary Hatch, KaTo H3MOI3BATE CAUH OT CIICTHATC MCTOIM:
Windows: Ot mnasamoro Mmento Hatch va QpyakuunoHamHua pex Draw, u3bepere Hatch.
DOS a UNIX: Ot mertoro Draw, uzbepere Hatch.

2. (a) Ot mogmenr0TO Boundary, m3depere Advanced.

(b) Ot nommentoTo Boundary, m3bepere Advanced. [losBsBa ce nHanoroBuAT nmpo3open Advanced
Options.

3. (a) Ot guamorosus npo3open Advanced Options, u3depere Make New Boundary Set.
(b) Usbepere Make New Boundary Set.

4. lepurupaiiTe rpaHAIHTE HA MHOKeCTBOTO. Criex moacka3BamoTo crobmeHue Select Objects,
3aJaiTe BIIOBUTE TOUKH HA 00IACTTA 32 MIPHXOBAHE M HATUCHETE Return.

5. (a) U3bepere OK B amamorosus mposopen; Advanced Options.

(b) U36epete OK B nuanorosms nposopen Advanced Options. JlnanorosusaT mpo3open Advanced
Options ce 3ameaps.

6. Ot nmamorosus nposopen Boundary Hatch, u3bepere Pick Points.
7. ITocoyeTe BBTPEMIHA TOUKA.
8. Hatucuere Return.

9. Ot mmamorosus npo3open, Boundary Hatch m3bepere Apply,.3a 1a MOIy4YHTE IIPUXOBKATA.
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9.2.4.5.2 More Aggregated Version of Text 5

Jedunupane Ha 00,1aCT 32 NIPHXOBAHE B CJIOJKEH YEPTEK

1. OtBopere amanorosus npo3open Boundary Hatch, KaTo H3MOI3BATE CAUH OT CIICTHATC MCTOH:
Windows: Ot maBamoro meHto Hatch Ha (pyHKmoHATHAA pex Draw, uzbepere Hatch.
DOS a UNIX: Ot mertoro Draw, uzbepere Hatch.

(a)

2. Ot nonmentoTo Boundary m3bepere Advanced, a (cen ToBa) m3depere Make New Boundary Set
OT IHANOroBHAT mpo3open Advanced Options.

3. 3a ma aepuHMpaTe rpaHUIUTE HA MHOYKECTBOTO, (ITBPBO) 33AaHTE BIIIOBHTE TOUKH HA 00IacTTa
3a IPUXOBAHE, a (ClIEJ TOBA) HATHCHETE Return.

4. U36epete OK B ananoroBus nposopey Advanced Options.

5. Ot amanorosus npo3open, Boundary Hatch, u3bepere Pick Points, (Ciex ToBa) HOCOYETE
BBTPCIIHA TOUKA, (CIICT TOBA) HATHCHETE Retfurn, u (Hakpas) uzdepere Apply,.3a 1a TOXyIUTE
IIPHXOBKATA.

(b)
2. Ot nonmentoTo Boundary m3bepere Advanced, 3a 1a ce OSBH AHAIOTOBHAT IIPO30PELL
Advanced Options, cnen ToBa uzdepere Make New Boundary Set.

3. 3a ma aepuHEpaTe rpaHUIUTE HA MHOYKECTBOTO, (ITBPBO) 334aHTE BIIIOBHTE TOUKH HA 00IacTTa
3a MPHUXOBAHE, a (CJIE TOBA) HATUCHETE Return.

4. Usbepete OK B quamoroBus nposopen Advanced Options, 3a 1a C€ 3aTBOPH JUATOTOBHAT
mpo3open Advanced Option.

5. Ot amanorosus nposopen, Boundary Hatch, w3bepere Pick Points, (Ciex ToBa) HOCOYETE
BBTPCIIHA TOYKA, (CIIC TOBA) HATHCHETE Return, U (Hakpas) uzdepere Apply,.3a 1a MOTyIHTE
mpuxoBkaTa. Running Version of Text 5

9.2.4.5.3 Running Version of Text 5

Jedunupane Ha 00,1aCT 32 NIPHXOBAHE B CJIOJKEH YEPTEK

ITspBo OoTBOpETE AMAnOroBHA Npo3opew Boundary Hatch, Kato H3MON3BATE CAHH OT CIACAHHTE
METOH:

Windows: Ot mnasamorto MeHt0 Hatch Ha (pyHKOHoHATHUA pex Draw, w3bepere Hatch.
DOS a UNIX: Ot mentoro Draw, m3bepere Hatch.

(@)
Crnex ToBa oT moaMeHIOTO Boundary m30epere Advanced. Ot quanorosuar mpo3open Advanced
Options m3bepere Make New Boundary Set. Cex ToBa nepuHHpaliTe TPaHALIATE HA MHOXKECTBOTO
KaTo (II'bPBO) 33Ja1aT€ BIIOBUTE TOYKH HA 00IACTTA 3a IPHUXOBAHE U (CJIE TOBA) HATUCHETE
Return. Caex ToBa u3bepete OK B AHanorosus nposopen; Advanced Options. Hakpas ot
Jauanorosms nposopen Boundary Hatch, m3depere Pick Points, (caex ToBa) moco4eTe BhTPEIIHA
TOYKA, (CTIC TOBA) HATHCHETE Return, u (HaKkpas) uzdepere Apply,.3a 1a MOIYIHTE MIPHXOBKATA.

(b)
Crnex ToBa 0T mOaAMEHIOTO Boundary m3bepere Advanced 3a 1a C¢ MOABH AHATOTOBHAT MPO30PLIT
Advanced Options. 30epete Make New Boundary Set. Cnen ToBa ne(pHHUpAiTe TpaHUIATE HA
MHOKECTBOTO KaTO (I'bPBO) 3313aT€ BIIOBHTE TOUKH HA 00JIACTTA 32 IIPHXOBAHE H (CJIE TOBA)
HaTHCHETE Refurn. Ciex ToBa m3bepere OK B AuanoroBus mposopen Advanced Options. Hakpas ot
auanorosms nposopen Boundary Hatch, w3depere Pick Points, (caex TOBa) MOCO4ETE BHTPEIIHA
TOYKA, (CTIC TOBA) HATHCHETE Return, u (HaKpas) uzdepere Apply,.3a 1a OMYIHTE MIPHXOBKATA.
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9.3 Basic steps

9.3.1 English

9.3.1.1 IMD Text 1: pages 47-48

To create a multiline style

Open the dialog box Multiline style.

Choose Element Properties.

[In the Element properties dialog box] Enter the offset of the multiline element.
Select Add.

Choose Color.

Select the element's color [from the Select Color dialog box].
Choose Linetype.

Select the element's linetype [from the Linetype dialog box].
Repeat these steps to define another element.

Choose OK.

9.3.1.2 IMD Text 2: page 46

To draw a line and arc combination polyline

Start the PLINE command.

1. Specify the start point of the line segment.

2. Specify the endpoint of the line segment.

3. Enter a.

4. Select OK in the Arc mode confirmation dialog box.

5. Specify the endpoint of the arc.

6. Enter L

7. Select OK in the Line mode confirmation dialog box.

8. Enter the distance of the line in relation to the endpoint of the arc.
9. Enter the angle of the line in relation to the endpoint of the arc.
10. Press Return.

9.3.1.3 IMD Text 3: page 58

To draw an arc by specifying three points.

Windows: From the Arc flyout on the Draw toolbar, choose 3 Points.
DOS and UNIX: From the draw menu choose Arc. Then choose 3 Points.
Enter endp.

Select the line (so the arc snaps to the endpoint of the line).

Enter poi.

Select a point to snap to.

Specify the endpoint.
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9.3.1.4 IMD Text 4: pages 48-49

To specify the properties of a multiline and save the style.
From the Data menu, choose Multiline Style.

Choose Multiline Properties

Select Display Joints.

Under Caps: Select a line or an arc for the startpoint of the multiline. Select a line or an arc for the
endpoint of the multiline. Enter an angle.

Under Fill, select On.

Choose Color.

Select the background fill color.

Choose OK.

Under Name, enter the name of the style.
Under Description, enter a description.
Select Add.

Select Save.

9.3.1.5 IMD Text 5: page 75

To define a boundary set in a complex drawing

Windows: From the Hatch flyout on the Draw toolbar, choose Hatch.
DOS and UNIX: From the Draw menu, choose Hatch

Under Boundary choose Advanced.

Choose Make New Boundary Set.

At the Select Objects prompt, specify the corner points for the boundary set.
Press Return.

Choose OK.

Choose Pick Points.

Specify the internal point.

Press return.

In the Boundary Hatch dialog box, choose Apply.
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9.3.2 Bulgarian

9.3.2.1 IMD Text 1: pages 47-48

9.3.2.1.1 Personal style

Crb3aaBane CTHII HA MYJITH/IMHHS
OrtBopere amamorosus mpo3open, Multiline Style.
Usbepere Element Properties.

[B mmamorosmsa npo3opern Element Properties] BpBeaeTe 0TMECTBAHETO HA €IEMEHTA HA
MYJITHIHHHATA .

Iocouere Add.

H3sbepere Color.

INTocouere nBera Ha exemeHTa [oT quanorosus nposopen Select Color].

Usbepere Linetype.

ITocouere Buaa HA THHUATA HA €IEMEHTA [OoT muamorosBmsa nposoper Select Linetype] .
IToBTOpETE TE3U CTHIKH.

H3sbepere OK.

9.3.2.1.2 Impersonal style

Cob31aBaHe CTHI HA MYJITIINHASA
OrtBaps ce auanorosusT npo3zopen Multiline Style.
Wszbupa ce Element Properties.

BpBekaa ce OTMECTBAHETO HA €TICMEHTa HAa MyJNTHIMHHATA [B Auatorosusa mposoper Element
Properties].

INocousa ce Add.

H306mpa ce Color.

INTocousa ce nBeTHT HA eaeMeHTa [B muamorosmsa nposopen Select Color].

Hsbupa ce Linetype.

ITocousa ce BHABT HA THHUATA Ha €IEMEHTa [B AuanoroBus mposoper Select Linetype].
TToBTapsT ce TE3H CTHIKH.

H36mpa ce OK.
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9.3.2.2 IMD Text 2: page 46

9.3.2.2.1 Personal style

Yepraene HA NI0JIMIIHHIS, CHCTABEHA 0T OTCEYKHU U JbIU
Craprupaiite komaszata PLINE.

1. 3agaiiTe HAYaTHATA TOYKA HA OTCEYKATA.

. 3apmaiiTe kpaliHAaTA TOYKA HA OTCCUKATA.

. BeBegere a.

. M36epere OK B amamoroBus mpo3oper Ha peskuMa Arc.

. 3amaiite kpaifHaTa TOUKA HA ABrara.

. Beeegere 1.

. M36epere OK B amanorosus mpo3opern Ha peskuma Line.
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. BpBeaeTe Ab/DKHHATA HA OTCEYKATa OT KpalHATa TOYKA HAa Abrara.
9. BpBeaeTe Bprbjia Ha OTCEUKATA COPAMO KpalfHaTa TOYKA HA ABrara.

10. Hatucuere Return.

9.3.2.2.2 Impersonal style

YepraeHe HA HOTHIHHHSA, CHCTABEHA 0T OTCEYKH H JBI'H

Craprupa ce komaHzata PLINE.

1. 3amaBa ce HaUaTHATA TOUKA HA OTCCUKATA.

. 3amaBa ce kpaifHaTa TOUKa HA OTCEUKATA.

. BeBexkna ce a.

. M36mpa ce OK B muanorosms mpo3opern Ha pexuma Arc.

. 3amaBa ce KpaiHATa TOYKA HA ABrara.

. BeBexxna ce 1.

. M36mpa ce OK B mnanorosus mpo3open Ha pexuMa Line.

. BpBexkaa ce Ib/DKHHATA HA OTCEYKATA OT KpaifHaTa TOYKA HA IBraTa.
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. BeBexa ce BI'BIBT HA OTCEUKATA COPAMO KpalfHATa TOUKA HA ABraTa.
10. HaTucka ce Return.
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9.3.2.3 IMD Text 3: page 58

9.3.2.3.1 Personal style

Yepraene Ha Abra 10 TPH TOYKH.

Windows: Ot mnaBamoro MeHIO Arc Ha (yakumonamHua pex Draw, m3bepere 3 Points.
DOS and UNIX: Ot menroro Draw, m36epere Arc. Crex ToBa m3bepere 3 Points.
BeBeacere endp.

[NTocouere muHUA (Taka ye ABraTa Aa CE 3aXBAHE 3a KpAHHATA TOUKA HA JIMHHATA).
BsBeaere poi.

[Tocouere Touka HA 3aXBaIIAHE.

3agaiite kpaiiHaTa TOUKA.

9.3.2.3.2 Impersonal style

Yepraene HA Abra 0 TPH TOYKH.

Windows: Ot mraBanoro MeHI0 Arc Ha (pyHKIuoHamHuA pex Draw ce m36mpa 3 Points.
DOS and UNIX: Ot menroro Draw ce m36mpa Arc. Criex ToBa ce m36mpa 3 Points.
BeBexaa ce endp.

INocousa ce nuHMA (TaKa 4Ye ABraTa Ja ce 3aXBAHC 33 KpalHATa TOYKA HA JIMHHATA).
BsBexaa ce poi.

INocoupa ce ToUKa Ha 3aXBaIIaHE.

3amaBa ce KkpaiHaTa TOUYKA.
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9.3.2.4 IMD Text 4: pages 48-49

9.3.2.4.1 Personal style

3asaBaHe XapaKTePUCTHKUATE HA MYJITHIHHHASA U 3A1ICBAHE HA CTIWIA
Ot menroro Data u3bepere Multiline Style.

H3bepere Multiline Properties.

H3zbepere Display Joints.

Ot moamenroro Caps: M30epere THHUS WM ITa 32 HAYAIOTO HA My aTHauHMATA. Y30epere muHUS
MJIM ABra 3a Kpas Ha MyJITUIHHHUATA. BpBEaeTe bIbi.

Ot moamenroro Fill m3depere On.

H3bepere upAr.

H30epere OCHOBCH 3aIIbIBAII IBAT.

H3sbepere OK.

B noamenroro Name BBBeIeTe HME HA CTHIIA.
B moamenroro Description BbBeAeTEe OUCAHHE.
H3bepere Add.

H3bepere Save.

9.3.2.4.2 Impersonal style

3anaBaHe XapaKTEePUCTHKATE HA MYJITHIMHHASA 1 3ANIICBAHE HA CTIJIA
Ot menroro Data ce m3dmpa Multiline Style.

H36mpa ce Multiline Properties.

H36wupa ce Display Joints.

Ot moamenroro Caps: M30mpa ce TuHUA Wik Jbra 3a Ha4ajaoTo Ha MyITHIMHEATA. M30mpa ce muHus
HITH TbTA 32 Kpas Ha MyJTHIHHUATA. BpBEKaa Ce BIbiL

Ot noamentoro Fill ce n3bmpa On.

H30mpa ce upsr.

H30mpa ce OCHOBCH 3aITbIBAM] IIBAT.

H306mpa ce OK.

B noamenroTo Name ce BbBEKIA HIME HA CTHIIA.

B moamenroto Description ce BpBEKAA OMHUCAHHUC.
H36mpa ce Add.

H36mpa ce Save.
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9.3.2.5 IMD Text 5: page 75

9.3.2.5.1 Personal style

Jedunupane Ha 00,1aCT 32 NIPHXOBAHE B CJIOJKEH YEPTEK

Windows: Ot maBamoro mento Hatch flyout Ha dynximonanams pex Draw usbepere Hatch.
DOS and UNIX: Ot menroro Draw m36epere Hatch.

Ot moamenroro Boundary m30epere Advanced.

H3bepere Make New Boundary Set.

Crnen moacka3samoto csodmenne Select Objects 3amalTe IIOBHTE TOUKH HA 00IACTTa 32
IPUXOBAHE.

Harucuere Return.

H3sbepere OK.

H3sbepere Pick Points.
ITocodere BBTPEIHATA TOYKA.
Harucuere Return.

Ot auanorosus npo3oper; Boundary Hatch m36epere Apply.

9.3.2.5.2 Impersonal style

Jednnaupane Ha 00,1aCT 32 MIPHXOBAHE B CJIOJKEH YEPTEK

Windows: Ot mnasamoro mento Hatch flyout Ha (ynkumonansaus pen Draw ce m30upa Hatch.
DOS and UNIX: Ot menroro Draw ce u36mpa Hatch.

Ot moamenroro Boundary ce m36mpa Advanced.

H36mpa ce Make New Boundary Set.

Crnen noackassamoro crodmenne Select Objects ce 3aAaBaT BIIIOBHTE TOYKH HA 0071aCTTa 32
IPUXOBAHE.

Harucka ce Return.

H36mpa ce OK.

H306mpa ce Pick Points.

TTocousa ce BBTpEIIHATA TOYKA.

Harucka ce Return.

Ot amanorosus nmpozoper; Boundary Hatch ce u30upa Apply.
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9.3.3 Czech

9.3.3.1 IMD Text 1: pages 47-48

9.3.3.1.1 Personal style

Vytvoreni stylu multi¢ary

Windows: Z ndstrojového panelu Vlastnosti objektii nebo z menu Data vyberte Styl mutiddry.
DOS a UNIX: Z menu Data vyberte Styl multicdry.

1. Vyberte Vlastnosti prvkii.

. V dialogovém panelu Vlastnosti prvkii zadejte rozmér posunuti multic¢ary.
. Vyberte Pridat.

. Vyberte Barva.

. Zvolte barvu elementu z dialogového panelu Vybér barvy.

. Vyberte Typ cdry.

. Zvolte typ ¢ary daného elementu z dialogového panelu Vybér typti Car.

. Opakujte tyto kroky.

. Vyberte OK.
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9.3.3.1.2 Impersonal style

Vytvoreni stylu multi¢ary

Windows: Z néstrojového panelu Vlastnosti objektii nebo z menu Data se vybere Styl muticdry.
DOS a UNIX: Z menu Data se vybere Styl multicdry.

1. Vybere se Viastnosti prvkii.

. V dialogovém panelu Vlastnosti prvki se zadd rozmér posunuti multi¢ary.
. Vybere se Pridat.

. Vybere se Barva.

. Zvoli se barva elementu z dialogového panelu Vybér barvy.

. Vybere se Typ cdry.

. Zvoli se typ ¢ary daného elementu z dialogového panelu Vybér typii Car.

. Tyto kroky se opakuji.

. Vybere se OK.
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9.3.3

.2 IMD Text 2: page 46

9.3.3.2.1 Personal style
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Nakresleni kFivky kombinované z pifimek a oblouki

Windows: Z plovouciho ikonového menu Ktivka na nastrojovém panelu Kresli vyberte K#ivka.
DOS a UNIX: Z menu Kresli vyberte K#ivka.

1. Urcete po€atecni bod rovného segmentu.

. Ur&ete koncovy bod rovného segmentu.

. Zadejte o.

. Vyberte OK v dialogovém panelu Potvrzeni rezZimu kresleni oblouki.
. Ur€ete koncovy bod oblouku.

. Zadejte e.

. Vyberte OK v dialogovém panelu Potvrzeni rezimu kreslen{ usecek.

. Zadejte vzdalenost tsecky ve vztahu ke koncovému bodu oblouku.

. Zadejte uhel tsecky ve vztahu ke koncovému bodu oblouku.

10. Stisknéte ENTER.

9.3.3.2.2 Impersonal style

00 N N W B~ W N

Nakresleni kFivky kombinované z pifimek a oblouki

Windows: Z plovouciho ikonového menu Ktivka na nastrojovém panelu Kresli se vybere Kfivka.
DOS a UNIX: Z menu Kresli se vybere Krivka.

1. Uréf se po€atecni bod rovného segmentu.

. Uréi se koncovy bod rovného segmentu.

. Zad4 se o.

. Vybere se OK v dialogovém panelu Potvrzeni reZimu kresleni obloukii.
. Uréi se koncovy bod oblouku.

. Zad4 se e.

. Vybere se OK v dialogovém panelu Potvrzeni rezZimu kresleni tsecek.

. Zada se vzdalenost tsecky ve vztahu ke koncovému bodu oblouku.

9. Zad4 se uhel useCky ve vztahu ke koncovému bodu oblouku.

10. Stiskne se ENTER.
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9.3.3.3 IMD Text 3: page 58

9.3.3.3.1 Personal style

Nakresleni oblouku uréenim tii bodu

Windows: Z plovouciho ikonového menu Oblouk na nastrojovém panelu Kresli vyberte 3 body.
DOS a Unix: Z menu Kresli vyberte Oblouk. Vyberte 3 body.

1. Zadejte kon a vyberte Caru.

2. Zadejte bod a vyberte bod.

3. Urcete koncovy bod.

9.3.3.3.2 Impersonal style

Nakresleni oblouku urcenim tii bodua

DOS a Unix: Z menu Kresli se vybere Oblouk. Vybere se 3 body.
1. Zada se kon a vybere se Cara.

2. Zada se bod a vybere se bod

3. Ur¢i se koncovy bod.

Windows: Z plovouciho ikonového menu Oblouk na nastrojovém panelu Kresli se vybere 3 body.
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9.3.3.4 IMD Text 4: pages 48-49

9.3.3.4.1 Personal style

Urceni vlastnosti multi¢ary a uloZeni stylu

1. Z menu Data vyberte Styl multiédry.

. Vyberte Vlastnosti multicdry.

. V dialogovém panelu Viastnosti multi¢dry vyberte Zobraz klouby.

. Pod Zakonceni zvolte tsecku nebo oblouk pro po¢itecni bod multi¢ary
. Vyberte tiseku nebo oblouk pro koncovy bod multicary.

. Zadejte dhel.

. Pod Vyplnéni vyberte Ano.

0 N N L A W N

. Vyberte Barva.

9. Zvolte barvu pro vyplnéni pozadi.
10. Vyberte OK

11. Pod Jméno zadejte nazev stylu.
12. Pod Popis zadejte popis.

13. Vyberte Ptidat.

14. Vyberte UloZit.

15. Vyberte OK.

9.3.3.4.2 Impersonal style

Urdeni vlastnosti multi¢ary a uloZeni stylu

1. Z menu Data se vybere Styl multicdry.

. Vybere se Viastnosti multicdry.

. V dialogovém panelu Vlastnosti multi¢dry se vybere Zobraz klouby

. Pod Zakonceni se zvoli tsecka nebo oblouk pro pofateni bod multiCary.
. Vybere se tsecka nebo oblouk pro koncovy bod multiary.

. Zada se thel.

. Pod Vyplnéni se vybere Ano.
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. Vybere se Barva.

9. Z dialogového panelu Vybér barvy se zvoli barva pro vyplnéni pozadi.
10. Vybere se OK

11. Pod Jméno se zada nazev stylu.

12. Pod Popis se zada popis.

13. Vybere se Pfidat.

14. Vybere se UloZit.

15. Vybere se OK.
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9.3.3.5 IMD Text 5: page 75

9.3.3.5.1 Personal style

Definovani hrani¢ni mnoZiny v komplexnim vykrese

Windows: Z plovouciho ikonového menu Srafy na nastrojovém panelu Kresli vyberte Srafy.
DOS a Unix: Z menu Kresli vyberte Srafy.

1. Pod Hranice Srafovani vyberte Pokrocilé.

. V dialogovém panelu Pokro€ilé moznosti vyberte Tvofit novou hraniéni mnoZzinu.
. Pfi vyzv€ Vybér objektii uréete rohové body hrani¢ni mnoziny.

. Stisknéte Enter.

. V dialogovém panelu Pokro€ilé moznosti vyberte OK.

. V dialogovém panelu Hrani¢ni Srafovani vyberte Vybér objektu.

. UrCete vnitini bod.

. Stisknéte Enter.

. V dialogovém panelu Hrani¢ni Srafovan{ vyberte Aplikovat.
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9.3.3.5.2 Impersonal style

Definovani hrani¢ni mnozZiny v komplexnim vykrese

Windows: Z plovouciho ikonového menu Srafy na nastrojovém panelu Kresli se vybere Srafy.
DOS a Unix: Z menu Kresli se vybere Srafy.

1. Pod Hranice Srafovani se vybere Pokrocilé.

. V dialogovém panelu Pokro€ilé moznosti se vybere Tvofit novou hrani¢ni mnozZinu.
. Pfi vyzv€ Vybér objekti se uréi rohové body hrani¢ni mnoZziny.

. Stiskne se Enter.

. V dialogovém panelu Pokro€ilé moznosti se vybere OK.

. V dialogovém panelu Hrani¢ni Srafovan{ se vybere Vyb&r objektii.

. Ur¢i se vnitini bod.

. Stiskne se Enter.

. V dialogovém panelu Hrani¢ni Srafovani se vybere Aplikovat.
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9.3.4 Russian

9.3.4.1 IMD Text 1: pages 47-48

9.3.4.1.1 Personal style

Coszpanue CTiiIs MyJIbTHIIHHIT

Orkpoiire nmamorosoe okHO Multiline style.

Haxxmure xHonky Element Properties.

[B amanorosom oxue Element properties] BBeAUTE CMEMICHHE 3JICMECHTA MY IbTHINHHH.
Haxxmure xknonky Add.

Haskmure xnonky Color.

Bribepure nBer smemMenTa [B xuamoroBoM okHe Select Color].

Haxxmure xnonky Linetype.

Beibepure T nuHuE [B 1ManoropoM okue Linetype].

[ToBropure 3TH mAary, YTOOBI ONPEACIUTD CIIE OJUH HICMEHT.

Haxxvmre xHonky OK.

9.3.4.1.2 Impersonal style

Y1001 €031aTh CTIWIb MYJIbTHIHHAA

Heobxoammo OTKpPEITS 1Hanorosoe okHO Multiline style.

Hasxats xaonky Element Properties.

[B nnamorosom okHe Element properties] BBeCTH CMEIICHUE 3IEMEHTA MY IbTHIHHAM.
Haskats kaonky Add.

Haxars kaonky Color.

BriOparts uBet 3neMeHTa [B AuanorosoM okee Select Color].

Haskats kHODKY Linetype.

BeiOpars Tun muHEHE [B AmatoroBoM okHe Linetypel].

T1oBTOpPHTH 3TH MATH, YTOOBI ONPEICIHTH SIIE OUH 3TCMEHT.

Haskats xHOnKy OK.
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9.3.4.2 IMD Text 2: page 46

9.3.4.2.1 Personal style

PucoBanue noJIIMHIH, COCTOSIIIEI H3 OTPE3KOB NPSIMBIX H AYT
3anycrute komanay PLINE.

1. Ykaxxute HAYAIBHYIO TOUKY OTPE3Ka IMPAMOH.

. YKa)kuTE KOHEYHYIO TOUKY OTPE3Ka MPSIMOH.

. Haxxvure xiaBumiy a.

. Haxxmure xaonky OK B quamoroBom okHe Arc mode.

. YKa)KuTE KOHCUHYIO TOUKY AYTH.

. Hasxmmure knasumy 1.

. Haxvure xaonky OK B muamoroBom okHe Line mode.
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. Yxakure PACCTOAHHUE TMHUH ITO OTHOMICHHIO K KOHCYHOH TOUKE AyTA.
9. Vkaxmure Yroj JAHUH 10 OTHOHICHHUIO K KOHCYHOH TOUYKE AYTH.

10. Haxxmure xnaBumy Return.

9.3.4.2.2 Impersonal style

Heobxoaumo 3anycruts komanay PLINE.

1. Yka3aTh Ha4aTbHYIO TOUKY OTpe3Ka IpAMOIi.

. YKa3aTh KOHCUHYH TOUKY OTPE3Ka MPAMOIA.

. Haxxats x1aBumy a.

. Haxarp xHOnKy OK B nmanoroBom okeHE Arc mode.
. YKap3aTh KOHCYHYHO TOYKY JyTH.

. Hasxatp xmasumy I.

. Haxarp xHOnky OK B mramoroBom okHe Line mode.

. Ykazatp PaCCTOAHUC THHUH MO OTHOIICHHUK) K KOHCYHOH TOYKE AYTH.
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. Ykazatp Yroja THHAH IO OTHOIICHHK) K KOHCYHOH TOUKE AYTH.

10. Haxxats kmasumy Return.

Y10o0nI HApHUCOBATH NOJUIHHHI, COCTOAMYIO U3 OTPEC3KOB INPAMBIX H Ayr
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9.3.4.3 IMD Text 3: page 58

9.3.4.3.1 Personal style

PucoBanue ayru no TpeM (3aJaHHbIM) TOYKAM

Windows: B nammrpe Arc Ha nasemu uHcTpyMeHToB Draw BoiOepute myHkr 3 Points.
DOS and UNIX: B menro Draw Beibepure Arc. 3atem BoiOepute myHKT 3 Points.
Beeaure endp.

3agaiite THHUIO, K KOHEYHOH TOYKE KOTOPOH MPHBA3aHA AyTa.

Beeaure poi.

3apaiite TOUKY MIPHBA3KH TyTH.

3agaiite TOUKY MPHBAZKH TyTH

9.3.4.3.2 Impersonal style

Y1001 HAPHCOBATH AYTY 1O TPEM (3aAAHHBIM) TOUKAM

Heobxoammo

Windows: B nammrpe Arc Ha nanemu wHCTpyMeHTOB Draw BeIOpaTts nyHKT 3 Points.
DOS and UNIX: B menro Draw BeiOpaTts Arc. 3arem BbIOpars myHkT 3 Points.
Beectu endp.

3a7aTh JIMHAIO, K KOHEYHOH TOYKE KOTOPOH IPUBS3AHA AYyTa.

BsectH poi.

3a7aTh TOUKY MPUBA3KH TYTH.

3a7aTh TOUKY NPUBSI3KA TyTH.
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9.3.4.4 IMD Text 4: pages 48-49

9.3.4.4.1 Personal style

OnpenesieHne CBOCTB U COXPAHEHUE CTIIIS MYJIbTHIIHHIT

B menro Data Beibepure myHkr Multiline Style.

B amanorosom okae Multiline Styles Beibepure mynkr Multiline Properties.
Beibepute mynkr Display Joints.

B oxne Caps 3agaiite OpAMYrO WIH AYTY A7 HA4YaIbHOH TOYKH MYJIbTHIHHUH.
3agaiite MPAMYIO MM AYTY AT KOHCYHOH TOYKH MYJIbTHIHHHH.

3agaiire yrom.

B oxk=e Fill, Betbepure myHkr On.

Haxxmure xnonky Color.

B ananoroBom okHe Select Color yKaXKUTe 3amOTHAONAN IBET (POHA.
Haxxmure OK.

B okne Name BBeaUTE UM CTUIIA.

B oxne Description BBeAUTE OIMUCAHUE.

Haxxmure xHonky Add.

Beibepure myHKT Save.

9.3.4.4.2 Impersonal style

Yr100b1 ONIpeAeHTH CBOIICTBA MY JIbTIJIMHAHE M COXPAHHUTH €€ CTIIIh
Heobxoammo

B menro Data Betopats myakr Multiline Style.

B amanorosom okae Multiline Styles BeiOpaTs mynkr Multiline Properties.
Beibpars mynkT Display Joints.

B oxne Caps 3aaaTh OpsAMYIO HJIH AYTY A1 HAYATbHOH TOUYKH MYJIbTHIHHAM.
3a7aTh NPAMYIO WU AYTY U1 KOHEUHOH TOYKH MYJIbTHIHHAH.

3azars yrom.

B oxse Fill Beiopats myskr On.

Hasxats kaonky Color.

B munamoroeom okHe Select Color yka3aTs 3aN0THAIONMN IBET (DOHA.
Hasxkats OK.

B oxHe Name BBECTH UM CTHIIA.

B oxne Description BBeCTH OIIHCAHHE.

Hasxats kaOnKy Add.

BeiOpaTs myHKT Save.
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9.3.4.5 IMD Text 5: page 75

9.3.4.5.1 Personal style

Onpenesienne HAGOpa rpaHMIl B CJIOZKHOM PHCYHKE

Ortxpoiite auanorosoe okao Boundary Hatch.

B myrkreBoundary Haskmure knonky Advanced.

Hasxmure xHonky Make New Boundary Set.

B crpoxke 3ampoca Select Objects yKakATe TPaHAYHBIC TOYKH HA0OpA TPAHHMII.
Haxxvmure xHomky Return.

B amanorosom okre Advanced Options HaxMuTe kHONIKY OK.

B amanorosom okre Boundary Hatch BriOepute kHOnNKy Pick Points.
YKaKuTe BHYTPEHHIOK) TOUKY.

Haxxvmure xHomky Return.

B auanorosom okue Boundary Hatch maskmute xHonky Apply.

9.3.4.5.2 Impersonal style

Y0061 onipeae T HA00P IPAHMIL B CI0KHOM PHCYHKE

HeobxoammMo OTKpEITH AHAIOroBoe okHO Boundary Hatch.

B myrkreBoundary Haskath kHONIKY Advanced.

Hasxats kHonKy Make New Boundary Set.

B crpoke 3ampoca Select Objects yka3zaTh IpaHHYHBIC TOUKH Ha0Opa TPaHHULI.
Haxats knonky Return.

B muamoroom oxHe Advanced Options Haxats kaonky OK.

B amanorosom okue Boundary Hatch BriOpats knomky Pick Points.

YKa3aTh BHYTPECHHIOK) TOUKY.

Haxats knonky Return.

B amanorosom okae Boundary Hatch maxats xaomky Apply.
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9.4 Function descriptions

9.4.1 English

9.4.1.1 IMD Text 1: pages 47-48

9.4.1.1.1 User actions-based functional descriptive text.

* Choosing Multiline Style from the Object Properties toolbar or the Data menu under Windows
opens the Multiline Styles dialog box.

* Choosing Multiline Style from the Data menu under DOS and UNIX opens the Multiline Styles
dialog box.

Selecting Add in the Element Properties dialog box adds an element.
* Choosing Color in the Element Properties dialog box opens the Select Color dialog box.
* Choosing Linetype in the Element Properties dialog box opens the Select Linetype dialog box.

Choosing OK in the Element Properties dialog box saves the style of the multiline element and exits
the Element Properties dialog box.

9.4.1.1.2 Object function-based functional descriptive text

The Multiline Style button from the Object Properties toolbar or the Data menu under Windows opens
the Multiline Styles dialog box.

The Multiline Style button from the Data menu under DOS and UNIX opens the Multiline Styles
dialog box.

The Add button in the Element Properties dialog box adds an element.
The Color button in the Element Properties dialog box opens the Select Color dialog box.
The Linetype button in the Element Properties dialog box opens the Select Linetype dialog box.

The OK in the Element Properties dialog box saves the style of the multiline element and exits the
Element Properties dialog box.

9.4.1.2 IMD Text 2: page 46

9.4.1.2.1 User actions-based functional descriptive text.

Choosing Polyline from the Polyline flyout on the Draw toolbar under Windows starts the PLINE
command

Choosing Polyline from the Draw menu under DOS and UNIX starts the PLINE command
Entering a (when PLINE is / has been started) switches to Arc mode.

Entering 1 (when PLINE is / has been started) switches to Line mode.

9.4.1.2.2 Object function-based functional descriptive text

The Polyline button from the Polyline flyout on the Draw toolbar under Windows starts the PLINE
command.

The Polyline button from the Draw menu under DOS and UNIX starts the PLINE command.
The a key (when PLINE is / has been started) switches to Arc mode.
The 1 key (when PLINE is / has been started) switches to Line mode.

9.4.1.3 IMD Text 3: page 58

9.4.1.3.1 User actions-based functional descriptive text.

‘ Choosing 3 Points from the Arc flyout on the Draw toolbar under Windows starts the ARC command.
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9.

9.

9.

9.

“Choosing Arc then choosing 3 Points from the Draw menu under DOS and UNIX start / starts (??)
the ARC command.

“Entering endp and then selecting the line so the arc snaps to the endpoint of the line when the ARC
command is / has been started specifies / specify the endpoint.

4.1.3.2 Object function-based functional descriptive text

The 3 Points button from the Arc flyout on the Draw toolbar under Windows starts the ARC
command.

The Arc button and then the 3 Points button from the Draw menu under DOS and UNIX starts the
ARC command.

“Entering endp and then selecting the line so the arc snaps to the endpoint of the line when the ARC
command is / has been started specifies / specify the endpoint. )

4.1.4 IMD Text 4: pages 48-49

4.1.4.1 User actions-based functional descriptive text.

“Choosing Multiline Style from the Data menu opens the Multiline Style dialog box.

“Choosing Multiline Properties in the Multiline Styles dialog box opens the Multiline Properties
dialog box.

Selecting Display Joints in the Multiline Properties dialog box displays a line at the vertices of the
multiline.

Selecting On under Fill in the Multiline Properties dialog box displays a background color.
Choosing OK in the Multiline Properties dialog box exits the Multiline Properties dialog box.
Selecting Add in the Multiline Style dialog box add a style to a drawing.

Selecting Save in the Multiline Style dialog box saves a style to a file.

Choose OK in the Multiline Style dialog box closes the dialog box.

4.1.4.2 Object function-based functional descriptive text

The Multiline Style button from the Data menu opens the Multiline Style dialog box.

The Multiline Properties button in the Multiline Styles dialog box opens the Multiline Properties
dialog box.

The Display Joints button in the Multiline Properties dialog box displays a line at the vertices of the
multiline.

The On button under Fill in the Multiline Properties dialog box displays a background color.
The OK button in the Multiline Properties dialog box exits the Multiline Properties dialog box.
The Add button in the Multiline Style dialog box adds a style to a drawing.

The Save button in the Multiline Style dialog box saves a style to a file.

The OK button in the Multiline Style dialog box closes the dialog box.
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9.4.1.5 IMD Text 5: page 75

9.4.1.5.1 User actions-based functional descriptive text.

“Choosing Hatch from the Hatch flyout on the Draw toolbar under Windows opens the Boundary
Hatch dialog box.

“Choosing Hatch from the Draw menu under DOS and UNIX opens the Boundary Hatch dialog box.

“Choosing Advanced under Boundary in the Boundary Hatch dialog box opens the Advanced Options
dialog box.

Choosing Apply in the Boundary Hatch dialog box applies the hatch.

9.4.1.5.2 Object function-based functional descriptive text

The Hatch button from the Hatch flyout on the Draw toolbar under Windows opens the Boundary
Hatch dialog box.

The Hatch button from the Draw menu under DOS and UNIX opens the Boundary Hatch dialog box.

The Advanced button under Boundary in the Boundary Hatch dialog box opens the Advanced Options
dialog box.

The Apply button in the Boundary Hatch dialog box applies the hatch.

9.4.2 Bulgarian

9.4.2.1 IMD Text 1: pages 47-48

9.4.2.1.1 User actions-based functional descriptive text.

ITpu m3bmpare Ha Multiline Style ot pyrknuoramHIA pex Object Properties wim mentoto Data mox
Windows ce orBaps amamorosmar npo3opery Multiline Styles.

ITpu n3bmpare Ha Multiline Style ot menroro Data mox DOS u UNIX ce orBaps AnanoroBusT
mpo3open Multiline Styles.

ITpu uzbupane Ha Add B muanorosus npo3open Element Properties ce mpu0aBs e1eMeHT.

ITpu u3bmpane Ha Color B auamorosmsa npo3open; Element Properties ce oTBaps 1uanoroBusaT
nposoper; Select Color.

ITpu n3bmpane Ha Linetype B quanorosms nposopern Element Properties ce oTBaps 1uanoroBuaT
mpo3opern Select Linetype .

ITpu n3bmpare Ha OK B amanorosmsi npo3oper Element Properties ce 3ama3BaT XapakTepHCTHKHUTE HA
€JIEMEHTA Ha MYITHIHHHATA H CE H3JIM3a 0T Auanorosms mposopern Element Properties .

9.4.2.2 IMD Text 2: page 46

9.4.2.2.1 User actions-based functional descriptive text.

ITpu m3bmpanre Ha Polyline ot mmaBamoto Mento Polyline Ha pyHkmmoHamHus pex Draw moza
Windows ce craprupa komasaara PLINE.

ITpu u3bmpanre Ha Polyline ot mertoTo Draw nox DOS u UNIX ce craptupa komannata PLINE.
ITpu BBBEKAaHE HA a (korato PLINE e craprupana) ce NPeBKIOYBA B pexkuM Arc.
ITpu BrBeknane Ha |l (koraro PLINE e craptupana) ce npeBiiousa B peskum Line.

9.4.2.3 IMD Text 3: page 58

9.4.2.3.1 User actions-based functional descriptive text.

ITpu u3bupane Ha 3 Points 0T mraBamoto MeHIO Arc Ha (pyHkuuoHanHHA pe Draw mox Windows ce
craptupa xomasaara ARC.
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ITpu n3bmpane Ha Arc u (cien ToBa) m3dupane Ha 3 Points ot merroro Draw mox DOS u UNIX ce
craptupa komaHzaara ARC.

[Ipu BBBEKAAHE HA endp u (CICx TOBA) MOCOYBAHE HA JTHHUA, TAKA Y¢ ABraTa Ja CC 3aXBaHE 3a
KpaiiHaTa Touka Ha JHHHUATA, KOraTo € craprupana komaHgara ARC, ce 3a1aBa kpaiiHaTa To4ka.

9.4.2.4 IMD Text 4: pages 48-49

9.4.2.4.1 User actions-based functional descriptive text.

[Tpu m3bmpare Ha Multiline Style ot Menroro Data ce orBaps nuamorosmar npozoper Multiline Style.

[Tpu n3bmpane Ha Multiline Properties B quanorosms npozopen Multiline Styles ce oTBaps
quanorosmaT npozoper; Multiline Properties.

IIpu u3bmpane Ha Display Joints B amaorosus mpo3open Multiline Properties ce nosigsiBa THHUA BbB
BBPXOBETE HA MYJITHIHHUATA.

Ipu m3bupare Ha On B moameHtoTo Fill B muanorosma nmpozopery Multiline Properties ce mosaBsaBa
OCHOBHUAT LIBST.

Ipu m3bmpare Ha OK B mmanorosms npozopen Multiline Properties ce m3mm3a 0T A#anoroBusa
mpo3open Multiline Properties.

IIpu n3bupane Ha Add B muanorosms nmpozopen Multiline Style kbM yepTeka ce 100aBs CTHIL.
IIpu u3bupane Ha Save B amamorosmsi npo3open Multiline Style cTunbT ce 3anucsa BB (aitr.

[Ipu u3bumpane va OK B amanorosmsa mpo3oper Multiline Style ruamoroBuar mpo3oper/ mpo30peubT
ce 3aTBaps.

9.4.2.5 IMD Text 5: page 75

9.4.2.5.1 User actions-based functional descriptive text.

ITpu n3bmpare Ha Hatch or mnaBamoro menro Hatch Ha gyrkmuonamsms pex Draw mox Windows ce
0TBapA AHATOTOBHAT mpo3opern; Boundary Hatch.

[Tpu u3dumpane va Hatch ot merroTo Draw mox DOS u UNIX ce oTBaps AHATOTOBHAT MPO30PEI]
Boundary Hatch.

ITpu uzbupane Ha Advanced ot moamertoTo Boundary B amanorosus nposoper Boundary Hatch ce
orBapa amanorosmat nmposopen Advanced Options.

ITpu n3bmpare Ha Apply B amanorosus mpo3oper; Boundary Hatch ce momydasa mpuxoBkara.
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9.4.3 Czech

9.4.3.1 IMD Text 1: pages 47-48

9.4.3.1.1 User actions-based functional descriptive text.

9.

V operaénim systému Windows se vybranim Multiline Style na nastrojovém panelu Object Properties
nebo v menu Data otevira dialogové okno Multiline Styles.

V opera&nich systémech DOS a UNIX se vybranim Multiline Style v menu Data otevira dialogové
okno Multiline Styles.

Vybranim Add v dialogovém okn€& Element Properties se pfidava element.
Vybranim Color v dialogovém okné& Element Properties se otevira dialogové okno Select Color.

Vybranim Linetype v dialogovém okné Element Properties se otevira dialogové okno Select
Linetyper.

Vybranim OK v dialogovém okné Element Properties se uklada styl elementu multiCary a opusti se
dialogové okno Element Properties.

4.3.1.2 Object function-based functional descriptive text

V operaénim systému Windows ptikaz Multiline Style na nastrojovém panelu Object Properties nebo
v menu Data otevird dialogové okno Multiline Styles.

V opera&nich systémech DOS a UNIX ptikaz Multiline Style v menu Data otevird dialogové okno
Multiline Styles.

Piikaz Add v dialogovém okné Element Properties ptidava element.
Volba Color v dialogovém okné& Element Properties otevira dialogové okno Select Color.
Volba Linetype v dialogovém okné Element Properties otevira dialogové okno Select Linetyper.

Tlac¢itko OK v dialogovém okné Element Properties uklada styl elementu multi€ary a opusti
dialogové okno Element Properties.

9.4.3.2 IMD Text 2: page 46

9.4.3.2.1 User actions-based functional descriptive text.

V operaénim systému Windows se vybranim Polyline v plovoucim ikonovém menu Polyline na

7 M

ndastrojovém panelu Draw spousti piikaz PLINE.

V operaénich systémech DOS a UNIX se vybranim Polyline v menu Draw spousti piikaz PLINE.
Zadanim a (kdyz je/byl spustén piikaz PLINE) se ptepina do rezimu kreslen{ obloukii.

Zadanim / (kdyZ je/byl spustén ptikaz PLINE) se pfepina do rezimu kreslenf Car.

9.4.3.2.2 Object function-based functional descriptive text

V operaénim systému Windows piikaz Polyline v plovoucim ikonovém menu Polyline na nastrojovém
panelu Draw spousti piikaz PLINE.

V operacnich systémech DOS a UNIX ptikaz Polyline v menu Draw spousti piikaz PLINE.
(1) Kdyz je/byl spustén pitkaz PLINE, piepind klavesa a do reZimu kresleni obloukd.

(ii) Kldvesa a ptepina do reZimu kresleni obloukd.

(i) Kdyz je/byl spustén ptikaz PLINE, ptepina klavesa / do rezZimu kreslen{ Car.

(i1) Klavesa [ pfepind do rezimu kreslenf Car.
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9.4.3.3 IMD Text 3: page 58

9.4.3.3.1 User actions-based functional descriptive text.

V operaénim systému Windows se vybranim 3 Points v plovoucim ikonovém menu Arc na
néstrojovém panelu Draw spousti piikaz ARC.

V opera&nich systémech DOS a Unix se vybranim Arc v menu Draw a ndslednym vybranim 3 points
spousti piikaz ARC.

Kdyz je/byl spustén piikaz ARC, zadanim endp a naslednym vybranim &ary se ur€uje koncovy bod
oblouku.

9.4.3.3.2 Object function-based functional descriptive text

V operaénim systému Windows volba 3 Points v plovoucim ikonovém menu Arc na nastrojovém
panelu Draw spousti piikaz ARC.

V opera&nich systémech DOS a Unix ptikaz Arc v menu Draw a ndslednym vybranim 3 points spousti
ptikaz ARC.

Kdyz je/byl spustén piitkaz ARC, endp a nasledné vybrani ¢ary ur€uje koncovy bod oblouku.

9.4.3.4 IMD Text 4: pages 48-49

9.4.3.4.1 User actions-based functional descriptive text.

Vybranim Multiline Style v menu Data se otevira dialogové okno Multiline Style.

Vybranim Multiline Properties v dialogovém okné Multiline Styles se otevird dialogové okno
Multiline Properties.

Vybranim Display Joints v dialogovém okn& Multiline Properties se zobrazuji Cary ve vrcholech
multi¢éry.
Vybranim On pod Fill v dialogovém okné& Multiline Properties se zobrazuje barva pozadi.

Vybranim OK v dialogovém okné& Multiline Properties se opousti dialogové okno Multiline
Properties.

Vybranim Add v dialogovém okné Multiline Style se styl piidavd k vykresu.
Vybranim Save v dialogovém okné Multiline Style se styl uklad4 do souboru.

Vybranim OK v dialogovém okné& Multiline Style se dialogové okno zavira.

9.4.3.4.2 Object function-based functional descriptive text

Ptikaz Multiline Style v menu Data otevird dialogové okno Multiline Style.

Ptikaz Multiline Properties v dialogovém okné& Multiline Styles otevira dialogové okno Multiline
Properties.

Volba Display Joints v dialogovém okné Multiline Properties zobrazuje ¢ary ve vrcholech multi€ary.
Vokba On pod Fill v dialogovém okné Multiline Properties zobrazuje barva pozadi.

Tlacitko OK v dialogovém okn& Multiline Properties opousti dialogové okno Multiline Properties.
Ptikaz Add v dialogovém okné Multiline Style ptidava styl k vykresu.

Ptikaz Save v dialogovém okné Multiline Style uklada styl do souboru.

Tlacitko OK v dialogovém okné Multiline Style zavira dialogové okno.

9.4.3.5 IMD Text 5: page 75

9.4.3.5.1 User actions-based functional descriptive text.

V operacnim systému Windows se vybranim Hatch v ikonovém menu Hatch na nastrojovém panelu
Draw otevira dialogové okno Boundary Hatch.
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V operaénich systémech DOS a Unix se vybranim Hatch v menu Draw otevira dialogové okno
Boundary Hatch.

Vybranim Advanced pod Boundary v dialogovém okné Boundary Hatch se otevira dialogové okno
Advanced Options.

Vybranim Apply v dialogovém okné Boundary Hatch se aplikuje Srafovani.

9.4.3.5.2 Object function-based functional descriptive text

V operaénim systému Windows piikaz Hatch v ikonovém menu Hatch na nastrojovém panelu Draw
otevira dialogové okno Boundary Hatch.

V opera&nich systémech DOS a Unix ptikaz Hatch v menu Draw otevira dialogové okno Boundary
Hatch.

Volba Advanced pod Boundary v dialogovém okné Boundary Hatch otevira dialogové okno Advanced
Options.

Ptikaz Apply v dialogovém okné& Boundary Hatch aplikuje Srafovani.

9.4.4 Russian

9.4.4.1 IMD Text 1: pages 47-48

9.4.4.1.1 User actions-based functional descriptive text.

Haskatmem xnonkm Multiline Style Ha marenn uacTpymMeHTos Object Properties mnu B MeHto Data nox
Windows oTkpeiBaercs amanorosoe okHo Multiline Styles.

Haxxatmem xuonkm Multiline Style B merro Data mog DOS and UNIX oTKpbIBa€TCS AHATOTOBOE OKHO
Multiline Styles.

selectAddprocHaxkatuem xHOmkH Add B quamoroBom okHe Element Properties 700aBIAeTCA 3IEMCHT.
Haskatmem xuonku Color B nranorosom okue Element Properties oTkpbiBaeTcsl THAIOrOBOE OKHO
Select Color.

Haskatmem xuonku Linetype B amanorosom okHe Element Properties OTKpbIBaeTCS AHATOTOBOE OKHO
Select Linetype.

Haskatnem xnonku OK B mmamorosom okue Element Properties coxpaHsieTcs CTHIIb 31€MEHTA
MYJIbTHIHHHY H 3aKphIBaeTCA Auanorosoe okHO Element Properties.

9.4.4.1.2 Object function-based functional descriptive text

Kaonka Multiline Style Ha marenn uacTpyMenToB Object Properties nnm B Menro Data mox Windows
OTKpBIBAET quanorosoe okHo Multiline Styles.

Kaonka Multiline Style B mento Data nox DOS and UNIX otkpeiBaeT quanorosoe okao Multiline
Styles.

selectAddproc Krnomka Add B quanoroBoM okee Element Properties 100aBIseT 31¢MCHT.

Kaonka Color B ruanorosom okae Element Properties oTkpsiBaer amamorosoe okHo Select Color.
Knaonxka Linetype B nuamorosom okxe Element Properties oTkpbIBaeT nuaorosoe okHo Select
Linetype.

Kaonka OK B quanorosom okae Element Properties coxpasseT CTHIb 31€MEHTa My IbTHIHHAH 1
3aKpsIBacT auanorosoe okHo Element Properties.

9.4.4.2 IMD Text 2: page 46

9.4.4.2.1 User actions-based functional descriptive text.

Haskatmem xuonku Polyline B mamutpe Polyline flyout Ha manemn uHcTpyMeHTOB Draw nox Windows
3anyckaercsa komanaa PLINE.

Hasxatnem xuonku Polyline B merto Draw nox DOS and UNIX 3amyckaercs komanna PLINE.

Haxarue xnaBumu a (koraa amymeHa komanaa PLINE) nepexmouaer B pexxum Arc.
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‘ Haskatme xmaBumm | (koraa 3amymena komaHzaa PLINE) nepekmouaer B peskum Line.

9.4.4.2.2 Object function-based functional descriptive text

Kaonxka Polyline B mamuTpe Polyline Ha manemn nuctpymenToB Draw mox Windows 3amyckaer
komanay PLINE.

Knonka Polyline B merro Draw mog DOS and UNIX 3amyckaer komaHny PLINE.
Knasumia a (koraa 3amymena komanaa PLINE) nepexrouaet B pexxum Arc.
Knasmnma | (korma 3amymena komanaa PLINE) nepexmoyaer B pexxum Line.

9.4.4.3 IMD Text 3: page 58

9.4.4.3.1 User actions-based functional descriptive text.

Hakatmem xuonku 3 Points B manurpe Arc Ha maHeaw HHCTPYMEHTOB Draw mox Windows
3amyckaercsa komaaaa ARC.

Hasxatnem xkHOIKH Arc H 3aTeM HaxkatueM KHONKH 3 Points B menro Draw mog DOS and UNIX
3amyckaercsa komaHaa ARC.

Bsoaom endp (xorza 3amymeHa koMaHaa ARC) u 3ajaHieM THHAH, K KOHCYHOH TOUKE KOTOPOH
MPHUBA3AHA AYra, 3a4a€TCA KOHEYHAs TOYKA JYTH.

9.4.4.3.2 Object function-based functional descriptive text

Knaonka 3 Points B mamurpe Polyline flyout Ha marenn uactpymenros Draw nox Windows 3amyckaer
komaHay ARC.

Kaonka Arc u xHonka 3 Points B MeHr0 Draw noa DOS and UNIX 3amyckaer komanay PLINE.

9.4.4.4 IMD Text 4: pages 48-49

9.4.4.4.1 User actions-based functional descriptive text.

Haskatmem xuomku Multiline Style B Merro Data menu oTkpsIBaeTcs aAuaxoroBoe okHo Multiline
Style.

Haskatmem xnonkm Multiline Properties B nuamorosom okue Multiline Styles dialog box oTkpsIBaercs
auanorosoe okHo Multiline Properties.

Hasxatuem xuomnku Display Joints B muanorosoM okae Multiline Properties muxIA 0TOOpaskaerca y
BEPIIMH MYJIbTHIHHHH.

Haskatmem xuonku On B okue Fill B amamorosom okxe Multiline Properties mokassisaercs nser ()oHa.

Haskatmem xuonku OK B mmamorosom oxue Multiline Properties 3akpbIBaeTcs AHATOrOBOE OKHO
Multiline Properties.

Haxxatmem xnonku Add B tnanorosom oxse Multiline Style cruimp 106aBIsAETCS K PHCYHKY.
Haxatumem xHOIKH Save B quamoroBoM okHe Multiline Style cTwib coxpansaerca B (paiiie.

Haskatnem xuonku OK B nmamorosom okue Multiline Style 3axpbIBaeTcs AHATOTOBOE OKHO.
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9.4.4.4.2 Object function-based functional descriptive text

Kaonka Multiline Style B Mmernro Data menu oTkpbiBaeT quanorosoe okao Multiline Style.

Kaonka Multiline Properties B suanorosom okae Multiline Styles dialog box oTKpbIBaeT AHAIOrOBOE
oxHo Multiline Properties.

Knomnka Display Joints B suaxoroom okHe Multiline Properties 0ToOpa«aeT THHUFO y BEpIIHH
MYJIbTHIHHAH.

Knonka On B okne Fill B amanorosom okue Multiline Properties moka3siBaeT uset ()oHA.

Kaonka OK B muanorosom oxae Multiline Properties 3akpsiBaer quanorosoe okao Multiline
Properties.

Kaonka Add B muanorosom okxue Multiline Style 7006aBIsI€TCs CTHID K PHCYHKY.
Knomnka Save B qmanorosom okue Multiline Style coxpanser ctunb B (atine.

Kaonka OK B quanorosom okae Multiline Style 3axpsIBacT 1HAIOrOBOE OKHO.

9.4.4.5 IMD Text 5: page 75

9.4.4.5.1 User actions-based functional descriptive text.

Haskatmem xuonkm Hatch B manmurpe Hatch va manemn wuctpymenToB Draw mog Windows
OTKpBIBAaeTCs Auanorosoe okao Boundary Hatch.

Haskatmem xuonku Hatch B merto Draw mog DOS u UNIX otkpsiBaercs amatoroBoe okHo Boundary
Hatch.

Haskatmem xuonku Advanced B myHkTe Boundary B tuamorosom okHe Boundary orkpsiBaercs
auanorosoe okHo Advanced Options.

Haskatmem xuonku Apply B nranorosoMm okHe Boundary Hatch mpumensieT mTpruxoBKy.

9.4.45.2 Object function-based functional descriptive text

Kaonka Hatch B mamurpe Hatch Ha manenm uacrpymenToB Draw mog Windows OTKpeIBaeT
auanorosoe okHo Boundary Hatch.

Kaonka Hatch B menro Draw mog DOS um UNIX orkpeiBaer quanorosoe okao Boundary Hatch.

Kaonka Advanced B myHkTe Boundary B quanorosom okae Boundary oTKpeIBacT THAIOrOBOE OKHO
Advanced Options.

Kaonka Apply B nramorosom okae Boundary Hatch npumenser mrpuxoBky.
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10. Overviews
10.1 English

10.1.1 Random ordering

The system enables you to create a multiline style, to specify the properties of a multiline, to draw a
line and arc combination polyline, to draw an arc by specifying three points, and to define a
boundary set in a complex drawing

10.1.2 Aggregation according to actee/action

The system enables you to create a multiline style, and to specify the properties of a multiline. You
may also draw a line and arc combination polyline,
and an arc by specifying three points.

10.2 Bulgarian

10.2.1 Random ordering

10.2.1.1 Personal style

Cucremara Bu mo3BoJIBa Ja Ch3AaAeTe CTHI HA MYNTHIMHHA, A 337aJeTe XapaKTCPUCTUKUTE HA
MYJITHIHHESA, A HAYEPTACTE MONHMIHHI, ChCTABEHA OT OTCEYKH M JABTH, /A HAYEPTAeTe ABra I0
TPH TOYKH, H 1 Ae(uHUpaTe 007aCT 3a MPUXOBAHE B CIOKEH YEPTEHK.

10.2.1.2 Impersonal style

Cucremara mo3BOJIIBA AA CE CH3AAJAC CTHI HA MYITHIHHHEA, A CC 337aJaT XapaKTCPUCTHKHTE HA
MYJITHIAHES, 1A CE HAYCPTAC MOIMIMHES, ChCTABCHA OT OTCCYKH W IBbCH, 1A CC HAYCPTAC Ibra
O TPH TOYKH, U Aa C¢ Ac(hUHApa 00IaCT 3a MPHUXOBAHE B CIIOXKEH YCPTEK.

10.2.2 Aggregation according to actee/action

10.2.2.1 Personal style

CucremaTta Bu mo3BoxaBa Ad Ch3AAACTC CTUI HA MYJITHIIHHWA, H A4 3a8aACTC XAPAKTCPUCTHKHUTC HA
MYJITHIHHHAA, Bue moxere cbmio aa HAUCPTACTE NMOTHITHHIA, CbCTABCHA OT OTCCYKH H AbI'H, H
ABbra o TPpH TOMKH.

10.2.2.2 Impersonal style

CucremaTa TO3BOIABA Aa €€ Ch3aaac CTUI HA MYJITHIWHHA, H Ja CC 3a4a4dT XAPAKTCPUCTHKHUTE HA
MYJITHIHHHAA, B®3M0KHO € CHIIO 1 CE HAUCPTAC NOTHUITHHUA, ChCTABCHA OT OTCCYUKH U OABrH, H
Abra 10 TPH TOIKH.

10.3 Czech

10.3.1 Random ordering

10.3.1.1 Personal style

Systém Vam umoziiuje, abyste vytvofili styl multi¢ary, (abyste) ur€ili vlastnosti multi€ary, (abyste)
nakreslili oblouk uréenim tii bodi, (abyste) nakreslili iseCku sloZenou z ¢ar a oblouku a (abyste)
definovali hraniéni mnoZinu v komplexnim vykrese.
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10.3.1.2 Impersonal style

Systém umoziiuje, vytvéret styly multi€ar, ur€ovat vlastnosti multi¢ar, kreslit oblouk uréenim ti{
bodi, kreslit dsecku sloZenou z ¢ar a oblouku a definovat hrani¢ni mnoZinu v komplexnim
vykrese.

10.3.2 Aggregation according to actee/action

10.3.2.1 Personal style

Systém Vam umoziluje, abyste vytvofili styl multiCary a ur€ili jeji vlastnosti. MiZete také nakreslit
oblouk uréenim tif bodu, nakreslit tiseCku sloZenou z ¢ar a oblouku nebo definovat hrani¢ni
mnozinu v komplexnim vykrese.

10.3.2.2 Impersonal style

Systém umoziiuje, vytvafet styly multi¢a a ur€ovat jejich vlastnosti. Dale je mozné kreslit oblouky
uréenim tii bodi, kreslit dseCky sloZené z Car a oblouku nebo definovat hrani¢ni mnoZinu v
komplexnim vykrese.

10.4 Russian

10.4.1 Random ordering

10.4.1.1 Personal style

Cucrema mno3Boisier Bam co3aaBaTh CTHIIb MYJIBTHJIMHHUM, 33JaBaTh CBOMCTBA MYJITHIIMHHH,
PpHUCOBATh MOMMIHHUM, COCTOANINE M3 OTPE3KOB NPAMBIX U AyT, PHCOBATH AYTY IO TPEM TOUKAM,
OIIPEACTATH HAOOP IPAHHUIL B CIIOKHOM PHCYHKE.

10.4.1.2 Impersonal style

CucreMa MO3BOJIAET CO3AABATh CTHIb MYJIBTHIHHHY, 337aBaTh CBOWCTBA MYITHIHHHH, PHCOBATH
MOTHJTHHHY, COCTOSAIIAE H3 OTPE3KOB MPSMBIX H AYT, PHCOBATh AYTY IO TPEM TOUKAM,
OIIPEACTATH HAOOP I'PAHHUIL B CIIOIKHOM PHCYHKE.

10.4.2 Aggregation according to actee/action

10.4.2.1 Personal style

Cucrema mno3Boisier Bam co3aaBarh CTHIIb MYIBTHIIMHHH, M 331aBaTh CBOHCTBA MYITHIHHHH. Bl
MOJKETE TAKKE PHCOBATH MOTHINHHH, COCTOAIIKAEC M3 OTPE3KOB MPAMBIX U AYr, H AYTY IO TPEM
TOYKAM.

10.4.2.2 Impersonal style

CHcTeMa MO3BOJACT CO3aaBATh CTHJIb MYJIbTHIHHHH, H 33a0dBaTh CBOMCTBa MYJITHIHHUHA. MoxHO
TAKXKC PUCOBATH NMOJTHIHHHUA, COCTOAIMAEC H3 OTPC3KOB IMPAMBIX H AyT, H AYTY IO TPEM TOIKAM.
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11.1 English
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1. Overview
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2.1. Creation of multiline style.

2.2. Specifying the properties of a multiline.

2.3. Drawing a line and arc combination polyline.
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2.5. Defining a bounda+ry set in a complex drawing

3. Command descriptions

3.1. Creation of multiline style.

3.2. Specifying the properties of a multiline.
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3.4. Drawing an arc by specifying three points.
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4. Quick reference
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4.2. Specifying the properties of a multiline.

4.3. Drawing a line and arc combination polyline.
4.4. Drawing an arc by specifying three points.
4.5. Defining a boundary set in a complex drawing

11.2 Bulgarian

CbABbPXAHUE

1. Pesrome
2. Ilpouenypu
2.1. Cp3maBaHe CTHII HA MYJITHIHHUAL.
2.2. 3a1aBaHe XapaKTCPHCTHKHUTS HA MYITHIHHHSA.
2.3. UepracHe HA MOTHINHHA, ChCTABEHA OT OTCEUKH H ABIH.
2.4. YepTaeHe Ha Ibra 1o TPH TOYKH.
2.5. Je(purnpane HA 00IACT 32 IPHUXOBAHE B CIOKCH YCPTCIK.

3. Onucanue HA KOMAHIUTE

3.1. Cp3maBaHe CTUI HA MYJITHIHHHSA.

3.2. 3anaBaHe XapaKTCPHCTHKHUTE HA MYITHIHHHUA.

3.3. UepTacHe Ha NONUIHHHA, ChCTABEHA OT OTCEYKH H JBIH.
3.4. UepracHe HA ABra IO TPH TOUKH.

3.5. Je(puanpane HA 00IACT 32 MPUXOBAHE B CIIOKCH YCPTCIK

4. CnpaBOYHHK

4.1. Cp31aBaHe CTHI HA MYJITHIHHUAL.

4.2. 3apaBaHC XapaKTCPUCTHKUTS HA MY TTHTHHHAL

4.3. YepTacHe HA NOTHIUHUS, ChbCTABEHA OT OTCEYKH H JBIH.
4.4. YepTracHe Ha ABIa IO TPH TOYKH.

4.5. lepuaupane HAa 001aCT 3 MIPUXOBAHE B CTI0XKCH YCPTEIK
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11.3 Russian

COJEP)KAHUE

1. Pesrome
2. Ilpouenypu
2.1 Co3maHue CTHIA MyJIbTHIHHHH
2.2 OmpeneneHue CBOUCTB My IbTHIHHHA
2.3 PucoBaHHE NOTHIHHUY, COCTOAIICH H3 OTPE3KOB MPAMBIX H AYT
2.4 PucoBaHu€e AyTH IO TPEM 33JAHHBIM TOYKAM
2.5 Ompeaencane HAOOPA TPAHHUI] B CTIOKHOM PHCYHKE

3. Onucanue KOMaH[

3.1 Co3maHue CTHIA MyJIbTHIHHHH

3.2 OnpenenecHue CBOUCTB MYJIbTHIHHAN

3.3 PucoBaHue NONMUIMHHAHA, COCTOAMIEH H3 OTPE3KOB MPAMBIX U IYT
3.4 PucoBaHue IyTH MO TPEM 33JaHHBIM TOUKAM

3.5 Ompeaencane HAOOPA TPAHHUI] B CTIOKHOM PHCYHKE

4. CnpaBOYHHK

4.1 Co3paHuC CTHIIS MYJIbTHIHHAH

4.2 OmpenencHUe CBOKCTB MYJIbTHIHHHH

4.3 PucoBaHUE NOMHIMHHHA, COCTOSAILCH U3 OTPE3KOB MPSAMBIX U AYT
4.4 PUCOBAHHEC IYTH 10 TPEM 3aJaHHBIM TOYKAM

4.5 OnpeaencHue HaOOpa TPAHHL B CITIOKHOM PHCYHKS

11.4 Czech
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2.5. Definovani hrani¢ni mnozZiny v komplexnim vykrese

4. Glosat

2.1.Vytvofieni stylu multi¢ary

2.2. Ur¢eni vlastnosti multi¢ary

2.3. Nakresleni kfivky slozené z ¢ar a obloukil

2.4. Nakresleni oblouku zaddnim t#{ boda

2.5. Definovani hrani¢ni mnoZziny v komplexnim vykrese




